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Diamond Cut Productions Audio Restoration Tools Overview
Product Objective: We aim to provide a comprehensive set of tools which will allow the user to 
remove extraneous noise and also enhance the sound contained on old audio sources without 
degrading the content contained on the original.    Recognizing that there is a tradeoff between the 
degree of noise removed from a source and the fidelity, transient and frequency response maintained, 
we have sought to provide the highest level of user control while maintaining ease of use over the 
variables which effect the Audio Restoration Process.    

DC-Art release 4.0, introduces a “Multi-filter” and release 4.0Live additionally introduces “Live” (feed-
through) mode into it’s feature-set.    The “Multi-filter” allows you to cascade up to 10 filters or effects.    
The “Live” (feed-through) mode allows systems with full duplex capability to bypass the system hard 
drive, and use the computer as a “Live” signal processor.    In other words, the signal is applied to your 
computer’s audio input, is processed by the DC-Art algorithms, and then is presented to its output a 
few hundred milliseconds later.    A tremendous amount of versatility and flexibility has been added, 
particularly when “Live” is used in conjunction with the “Multi-filter.” Additional new and innovative 
features that have been incorporated into both versions of DC-Art include the following:
1. 8, 16, 20 and 24 bit support at up to 48 KHz sampling rate
2. File conversions between 8, 16, 20 and 24Bits
3. Improved impulse noise filter for vinyl recordings (New HQ mode)
4. Variable spectral resolution added to the Continuous Noise Filter
5. Insert Silence feature
6. Audio Spectrum Enhancer added to the Dynamic Noise
7. Batch File Editor for running multiple files through the same filter.
8. Slot Filter for isolating sounds in Forensics applications.
9. Stereo Wavefile 180 degree phase-inversion
10. X-Y output display for plotting vector waveforms.
11. Variable resolution Spectrum analyzer with peak finder.
12. Stereo Channel Blender / Crossover Filter & Effect
13. Speed Enhanced display and zooming functions (especially on large wavefiles)
14. Markers are saved with the wavefile
15. Drop Markers while playing for locating sound events
16. Improved record screen.
17. Printable 50/60 Hz Turntable Stroboscope discs
18. Additional factory presets
19. Additional Keyboard Accelerators
20. Forensics Menu with Brick Wall and Adaptive Filters (five new forensics filters total)
21. New gain normalize with gain adjustment feature.
22. Punch and Crunch multi-band dynamic compressor or expander
23. Automatic Level Control ALC (or AGC) in the Dynamics Processor
24. 100 segment Output VU Meters in the View Menu 
25. 2A3 (retro-tube) power triode added to the Virtual Valve Amplifier (VVA)
26. Goto Next (or Previous) marker feature
27. Live Mode “Log to Disc” feature.
28. Triangle waveform generator added to the “Make Waves” feature\
29. Speed Change and Gain Normalized added to the Batch File Processor



Diamond Cut Productions, Inc. designed DC-Art primarily to be used for the restoration of olde 
phonograph recordings.    These recordings often contain priceless performances which are marred by 
the effects of age, wear, and the limitations of the media on which they were originally recorded.    DC-
Art is effective for "cleaning up" old cylinder recordings, hill and dale Edison Diamond Discs (verticals),
old 78's (laterals) (both acoustically and electrically mastered), and of course, modern vinyl LP's and 
45 rpm records. However, the program can also be used for additional sound restoration, special 
effects, or professional applications such as:

1. Single Ended noise reduction of old analog tape recordings.
2. Cleaning up old optical and magnetic movie soundtracks.
3. Improving the intelligibility of surveillance recordings.
4. Improving the intelligibility of recorded telephone conversations.
5. Applying certain special effects or equalizations to any sound recording.
6. Removing static and noise from radio broadcasts, most particularly from signals carried on the AM 

and Short Wave Bands.    
7. Providing a graphical means for analyzing the noise content of audio recordings.
8. Selective manual modification of recording waveforms.
9. Providing special audio effects for movie, radio, television or stage theatrical use.
10. General purpose audio applications in forensics laboratories.
11. Use as an instructional aid for the teaching of the applied principles of Digital Signal Processing.
12. Cleaning up and enhancing video tape soundtracks.
13. Personal enjoyment and entertainment.

This program has thus far been used on eight of Diamond Cut Productions compact disc releases of 
historical musical material.    Its performance can be auditioned on the following Diamond Cut 
Productions CD’s:

· Unreleased Edison Laterals I
· The California Ramblers - - - Edison Laterals 2
· Hot Dance of the Roaring 20's - - - Edison Laterals 3
· Eva Taylor with Clarence Williams - - - Edison Laterals 4 
· Vaughn De Leath, The Original Radio Girl, Edison Laterals 5
· B.A. Rolfe and his Lucky Strike Orchestra, Edison Laterals 6
· Hot & Rare - - - Hot Tunes from Rare Bands and Recordings
· The Marvelous Melodies of Peter Mendoza
· Edison Diamond Disc Fox Trots - - - 1920 to 1923
· Rudy Vallee and His Connecticut Yankees (1928 – 1930)    

 Other labels such as the Smithsonian Collection of Recordings have used this program to clean up
several songs on their "American Songbook Series".    And County Records used DC-Art to produce 
their release entitled "Ernest Stoneman and his Dixie Mountaineers".    It was written by two 
engineers in their spare time to facilitate the very specific needs which arose in their restoration of the 
Edison Lateral Collection of Test Pressing Recordings, which is located at the Edison National Historic 
Site in West Orange, New Jersey.    Rick Carlson and Craig Maier developed this program over a four-
year period. They have now made it available to the general public with the idea in mind that if it solved
some audio restoration problems for themselves, it might also be of use to others confronted with 
similar problems, particularly for those operating with significant budgetary constraints.

Here is a list of the functions that DC-Art can perform:
    

1. Record Audio signals onto your computer’s hard drive.



2. Playback Audio signals from your computer’s hard drive.
3. Display the Amplitude vs. time waveforms that represent your wave file.
4. Zoom-In and view details of a particular portion of your wave file.
5. Print the electrical waveform representation of your wave file.    
6. Perform the following group of non-destructive editing on your wave file including:

A. Remove Impulse Noise from a recording including    "ticks", "clicks", and "pops."    
B. Remove "Crackle" from a recording utilizing a Median Filter.
C. Remove Continuous Noise from an audio signal.
D. Display the frequency domain content of a selected portion of a wave file.
E. Perform a Low Pass Filter function with 1st, 2nd or 3rd order slopes.
F. Perform a Bandpass Filter function with a Finite Impulse Response (FIR) and an Infinite Impulse

Response (IIR) algorithm.
G. Perform a High Pass Filter function with 1st, 2nd or 3rd order slopes.
H. Perform a Dynamic Filter function to reduce "Hiss" from an audio signal.
I. Perform various file conversions such as left plus right, left minus right, etc.
J. Perform an Average filter function.
K. Attenuate Hum or Acoustical Feedback from a recording. 
L. Manually interpolate noise events out of your wavefile.
M. Frequency Equalize your recordings to create a more pleasing tonal balance with the built-in 10-

band Graphic Equalizer. 
N. Correct the pitch of a recording with the “Change Speed” Filter, with linear or non-linear time 

contours.
O. Perform fractional speed re-mastering from a 45 RPM turntable, and then convert it to normal 

speed with the “Change Speed” Filter.
P. Create a wavefile “Song-list” with Markers capable of CD data Quantization for glitchless 

indexing.
Q. Attenuate Buzz from a recording using the Harmonic Reject Filter.
R. Add “tube-warmth” or harmonic enhancer effects 
S. Modify the dynamic range of recording
T. Set up a “noise-gate” function
U. De-ess an overly sibilant recording
V. Create or reverse an RIAA equalization curve with the 10 band paragraphic equalizer.    Also, 

create various 78 RPM turnover equalization curves.

7. Perform the following group of destructive editing on your wavefile including:
A. Fade in sequence with either a linear or a logarithmic envelope vs. time.
B. Fade out sequence with either a linear or a logarithmic envelope vs. time.
C. Crossfade between two Wavefile sources with linear or logarithmic timing.
D. Mute a portion of your wavefile.    This is useful for ridding a file of stubborn "pops" or "thuds."       
E. "Gain Ride" to even out variations in the sound level of a recording in non-real time. 

Edit Wavefiles using any of the following commands:
1) Copy

2) Paste Over
3) Paste Insert
4) Cut
5) Interpolate 

F. Undo any of the destructive editing which you have performed with any number of levels of the 
undo function that you choose to define.



8. Analyze Audio signals for Amplitude and Frequency content utilizing any of three possible methods, 
including the use of a "built-in" spectrum analyzer.

9. Measure the performance of the electronic components in your audio restoration laboratory with a 
built-in Audio Signal Generator that is capable of producing Sine and Square Wave signals (tones) 
of adjustable frequency and amplitude.    It is also capable of producing white and pink noise using 
the Random function.    Also included is a burst and linear sweep generator function.

10. Real time "Preview" of all filter functions for instant evaluation of parametric settings.
11. Hear the noise being removed by two of the filters through a “Keep Residue” mode.
12. Add reverb to “dead” recordings.
13. Create a Stereo Effect on monophonic recordings.

When Diamond Cut Productions introduced its 32 bit version of the program in 1998, we not only 
added new audio restoration features, but included some audio enhancement capabiltiy as well.    
Some of the features added at that time included:

    1. A Virtual Valve Amplifier to produce “Tube Warmth.”

2. A Harmonic Exciter for synthesizing missing upper octaves.
3. A Dynamics Processor which includes an expander/gate, compressor, and de-esser.
4. A “Paragraphic” Equalizer, which is an innovative 10 band parametric equalizer with a dual-function 
graphical display.
5. A real time peak or averaging Spectrum Analyzer, and bar graph amplitude display. 
6. Instant bypass mode. 
7. Looping of Playback and Previews.
8. Filter and effects factory pre-sets.
9. On-the-fly changes between factory or user pre-sets when in preview mode.
10. A “Find and Mark Silent Passages” detector is provided, to automatically break a wavefile into 
pieces based on silent sections.
11. Built in Forward and Reverse RIAA curves, and 78 RPM turnover’s.
12. Time-Offset for correcting tape Azimuith problems, improving intelligibility, and creating a 
stereophonic effect from a monophonic source.
13. Random noise generators (white and pink noise.)
14. A normalize gain function.
15. Over 240 factory presets.
16. A play-list export feature

It is important to emphasize that DC-Art performs most of its editing in a non-destructive manner. The 
source file remains non-modified; only the destination file receives the modifications. Not all wavefile 
editing programs work in this manner, and some actually modify the source file directly on your hard 
drive.
 
It will take some experience to achieve excellent results from DC-Art, so don't be afraid to experiment. 
The preview feature will allow you to quickly hear the results of parameter setting changes before you 
commit your computer resources to the job of a complete file processing. Some PCs are not fast 
enough to run all of the algorithms in real time, so you may find yourself making use of the preview 
function often.    The minimum recommended system configuration for this version of DC-Art    is a 100 
MHz Pentium.    A 166 MHz Pentium or higher will generally run most DC-Art algorithms in real time or 
faster in preview mode, and for “Run” mode performance, faster is always better.    If you are using 
“Live” you will want the fastest computer that you can afford for maximum functionality, performance 
and versatility.
Most sound restoration jobs will take several passes with different algorithms applied to achieve the 



best results.    Since many of these algorithms are non-linear systems, the order in which some of the 
various filters are applied will matter.    You will find more on this topic in the Impulse Filter section of 
this Help file.    

Note 1: DC-Art utilizes the Microsoft Wave file format for its files. It can also convert MP3 files to wave 
files for editing and enhancement.
Note 2: All of the algorithms used in DC-Art use double precision floating point math as opposed to 
fixed precision integer math in order to minimize the possibility of introducing digital noise and artifacts 
into your wavefiles.    The tradeoff associated with using this method is the time required to process a 
file being somewhat longer compared to the fixed precision integer method.



Getting Started with DC-Art

Congratulations, you’ve just purchased another affordable yet powerful Tracer 
branded product.    You have our promise that you’ll be satisfied with our results 
without having to take a second mortgage to get them! 

Configuration
DC-Art does not require any special installation, but it does require that your sound card be installed 
and working properly. If you have more than one sound card in your system, make sure the one you 
wish to use has been selected in the Device I/O screen (use the Edit->Device I/O menu)

Check the Temp File Path under the Edit->Preferences menu. DC-Art automatically assigns temporary 
file names for files that are being processed. You should set the temporary drive path for the disk drive 
that you wish to use for audio editing. This is usually the drive with the most free disk space. Keep in 
mind that high quality (44.1kHz) stereo recording consumes 10.5MB of disk space per minute.

Basic operating mode of DC-Art
DC-Art always operates in a non-destructive manner. When a file is processed with a DC-Art filter or 
effect, DC-Art reads the source file, modifies it with the selected filter or effect, then writes it to the 
destination file. The main workspace of DC-Art always has a source and a destination file. This mode 
of operation has a few important benefits: 

1. The original source file is not modified, leaving it available for instant comparisons with the 
processed version.

2. The original material can always be recovered if the results of processing are unsatisfactory.

3. Selected sections of the file can be reprocessed using different filter parameters or different 
filters entirely (see sync mode).

Because of the non-destructive nature of the filters in DC-Art, there is no undo function for the filters. 
Instead, the original source can be copied back to the destination file if a mistake is made. This method
greatly speeds up the program because it does not have to make a copy of the data each time a filter 
is run. 

There is an undo function available for all of the single file commands such as Cut and Paste. These 
are explained later.

The following diagram illustrates the filtering process:



Sync Mode

Sync mode is the default mode of operation for DC-Art. In Sync mode, both the source and destination 
files track each other. If you zoom into a section of the source file, the destination file will zoom to the 
same section. When you process the source file using a DC-Art filter, the program reads the source 
file, processes it, and writes it to the destination file at exactly the same position as the source file. This
means that if you want to reprocess a section in the middle of a song, just highlight the section in the 
source file that needs processing and run the filter again. 

The filtered section will be written to the correct location in the destination file. This mode of operation 
is useful for changing the filter parameters for only a section of a song, or for removing noise from a 
small section of the song without having to process the entire file.

Note: Sync mode assumes that a destination file exists, and that it is the same size as the original file. 
This is usually accomplished through the application of one of DC-Art’s filters to the entire file. For 
example, the file conversion filter can be used to make the destination file into an exact copy of the 
source file.

Sync Mode Operation

Non-Sync mode of operation
In non-sync mode, the highlighted section of the source file is read and processed by the DC-Art filter. 
The processed section is then written to the destination file, starting at the beginning of the file. If a 
destination file already exists, it will be overwritten (a prompt warns you of this). This mode is useful 
when only a section of the source file needs to be extracted, or for testing a filter’s settings before 



processing an entire file.

Non-sync mode operation

Single file operations
Because of the nature of several operations, the Cut, Copy, Paste, and Fade menu items operate on 
the file that is currently selected. This means that a Cut will delete a section of the source file if it is the 
currently selected file in the workspace. Likewise, a Fade operation will modify the highlighted section 
of the selected file (Source or Destination). 

All single file operations can be undone by using the Undo menu item. The default number of undo 
levels is 10. The number of undo levels is selectable in the Preferences dialog box. The maximum 
number of “undo’s” is limited to 100. Remember that when you close DC-Art (Exit the program) all 
undo information will be lost.

Preview Mode
All the filters in DC-Art have a preview mode. Preview mode lets you hear the result of a filter before 
writing the changes to the Destination file. In Preview mode, you will hear the results of the filtered file 
as it is being processed. If your computer is fast enough to keep up with the calculations, the entire file 
can be previewed in this manner. All of the filters have live controls, which means that adjustments 
made to a filter’s slide control will be immediately heard in the preview output. 

If your computer cannot keep up with the calculations, you will hear stuttering in the preview output. 
This is because the playback is being paused while the computer calculates the next section of music. 
This stuttering can be minimized by increasing the number of ”Preview Buffers” in the Preferences 
Dialog box (Edit->Preferences). 

Restoring a Recording
While there are many ways to use DC-Art, the general steps are outlined below. Keep in mind that any 
of the filters may be skipped if the particular recording does not suffer from the kind of noise the filter is 
designed for. You should always use the least amount of processing that will get the job done. See the 
section on Filters for a brief description of each filter’s function.    The tutorial on restoring the Demo 
wave file later in this booklet describes some of these steps in detail.

1. Record the source material
The source material is recorded from an external source into a Wavefile using the Record 
function of DC-Art. 



2. De-Click
The Impulse noise filter is used to remove ticks, pops, and other transient noises from the 
recording. 

3. De-hiss
The Continuous noise filter or the Dynamic noise filter are used to remove constant background 
hiss or other wideband noise from a recording. This type of noise is the most difficult to remove 
without effecting the music.

4. Filter (HP, LP, Notch, Harmonic Reject, Equalizer)
The High Pass, Low Pass, Notch, Harmonic Reject, and Equalizer are all filters that modify the 
frequency response of the recording. 
Some examples are:    

· High Pass filter for removing rumble
· Notch or Harmonic Reject filter for removing hums, buzzes or feedback.
· Equalizer for adding bass or emphasizing the vocal range.

This step may be performed before the continuous noise filter to remove rumble or high frequency 
noise. See the help file for additional examples of which filter to use for a particular problem.

5. Trim, Fade-in/Fade-out
After the processing is done and you are satisfied with the results, you can use the Cut, Fade-in 
and Fade-out functions to remove any noise that occurs before and after the recording, such as 
the sound of the record needle being dropped on the lead-in groove. Keep in mind that the Cut 
and Fade functions operate on the selected file. This means that, unlike the filters, you can modify
the source file if you want to.

6. Transfer to final format (CD, Cassette, DAT)
After the restoration process has been completed the file should be transferred to a portable 
format such as CD, cassette or DAT. To transfer to cassette or DAT, simply set up the cassette or 
DAT machine to record from the computers sound card and play the wavefile. If you are restoring 
a entire album or want to create a master tape, use the Playlist feature. 

This allows you to create a list of wavefiles and play them back in sequence, thus eliminating the 
time consuming step of starting and stopping the recorder between each song.

CD recorders usually have special software that must be used to record the file onto the CD. DC-
Art has a CD quantization feature that lets you perform special processing to ensure glitch free 
CD masters. 

Filters and Effects
The filters are at the heart of the operation of DC-Art. The filters are used to reshape the sound from its
original form into a more pleasing and noise-free result.    The following section lists all of the filters 
available in DC-Art along with a description of the type of filtering they perform. The help file contains a
table of various sound source defects and the type of filter to use for each one (search for help on 
”Filter Applications”).
 

· Impulse Noise Filter
This filter is used to remove pops, ticks, clicks, and crackle from audio recordings.    It is also 
useful for the elimination of ”static” interference from AM or Short Wave radio broadcasts. An 



Impulse looks like a spike or fast change in the audio signal that is not related to the music. The 
filter monitors the audio signal for ticks or pops and replaces them with an approximation of the 
signal which would have occurred during the tick or pop. 

 
· Continuous Noise Filter

This filter is useful for reducing background ”Hiss” and other constant noise from a recording or 
from a noisy FM radio transmission. It is referred to as a ”Continuous” noise filter because 
unlike Impulse noise, Hiss is present at all times.    When adjusted properly, this filter can almost 
completely eliminate all residual noise from a recording.    However, it is easy to overuse this 
filter and leave the recording sounding dead and lifeless, and also introduce digital artifacts into 
the music.

To use this filter, you must first take a sample of a section of noise. This noise template will then 
be used to decide what is noise and what is music during the filtering process. It is important to 
sample a section of the wavefile that does not contain any music so that the filter does not 
remove signals that contain musical information.    

The filter graphically shows a frequency spectrum of the sampled noise. This spectrum 
represents the amount of noise at each frequency band in the recording. You can use the 
mouse to move the blue threshold line to tailor the kind of noise reduction that the filter 
performs. 

This filter should only be used on recordings that have little or no impulse noise, or on 
recordings which have already been processed through the Impulse Noise filter.

· Harmonic Reject Filter
The Harmonic Reject filter is used to remove harmonically rich noise from a recording. Noises 
such as hums and buzzes from electrical mains, or buzzes from broadcast signals are the most 
common types. A loose or bad ground connection on a turntable is a common cause of hum that
can be removed with this filter.

The filter removes the fundamental frequency along with a selectable number of harmonics. 
Harmonics are multiples of the fundamental frequency that are present in all signals that are not a
sine wave. For the US, a hum caused by a faulty ground will have a fundamental frequency of 
60Hz, (50Hz in Europe). 

· Dynamic Noise Filter
This filter is another form of the ”Continuous noise” filter, but it operates on a different principle 
than the previous filter. It is also useful for removing ”Hiss” from recordings, but unlike the 
”Continuous Noise Filter,” will not introduce any digital artifacts into the recording. It is much more 
forgiving of incorrect settings at the expense of less overall hiss reduction.    

Its operation is based on a moveable Low Pass filter. This low pass filter will attenuate the high 
frequency Hiss only when there are no high frequency signals present in the music. This filter 
should also only be used on recordings that have no impulse noise.

· Low Pass Filter
This filter is called a Low Pass filter because it only passes through signals that are lower than its 
set corner frequency. It attenuates high frequency signals above the corner frequency. 



The effect can be similar to turning down the treble control on a home stereo except that the 
Low Pass filter is much more flexible. This filter can be somewhat useful for reducing hiss in a 
recording, but care must be taken not to reduce the “presence” of a recording by eliminating too
much of the high end musical content at the same time. 

It is most useful where a recording does not contain any musical information above a certain 
frequency, and you wish to eliminate the high frequency noise that would otherwise be present.

· Band Pass Filter
Bandpass filters are essentially a combination of a low pass filter and a high pass filter. It 
attenuates both the high frequency and the low frequency portions of the audio spectrum. It is 
useful where the recording contains extraneous noise in the low frequency region such as 
rumble or thumps, and high frequency noise such as hiss.
This filter can also be very useful for improving the intelligibility of audio recordings, especially 
speech, by eliminating the unnecessary portion of the audio spectrum that is not used by 
speech frequencies to carry useful information to the listener.

· High Pass Filter
A high pass filter only passes signals that are above or ”higher” than the corner frequency. It 
reduces the level of low frequency signals that are below the corner frequency.    The effect can 
be similar to turning down the bass control on a home stereo. This filter is very useful for reducing
turntable rumble, muddiness, and any other extraneous low frequency noise in a recording. 

· Notch Filter
A notch filter attenuates signals that are near its center frequency setting.    The degree to which it
attenuates frequencies near the center frequency is determined by the bandwidth setting.    This 
filter is useful for removing 50 or 60 Hz hums from a recording. It is also useful for decreasing any
sound system acoustic feedback that may be found on some live recordings. 

· Median Filter
The Median Filter can be used to substantially reduce ”crackle” (small impulse noise) from a 
recording. Use a sample setting of 3 to 7 for this application. Also this filter is useful for 
improving the intelligibility of severely distorted signals and pulling signals out of a very poor 
signal-to-noise ratio situation (pulling signals out of the mud).    It is somewhat similar in sound 
performance to a high-order low pass filter. 

· Average Filter
This filter sounds similar to that of a low pass filter, although it is somewhat more effective than a 
low pass filter in reducing not only ”Hiss” but also ”Crackle” from a sound source.    It is most 
effective on limited bandwidth sources such as old acoustic recordings made before 1925.    This 
filter is also useful for improving the intelligibility of highly garbled voice communications 
recordings.

· Equalizer
The equalizer is a familiar filter that acts like an expanded tone control. The audio spectrum is 
broken into 10 bands, each being one octave wide. Each band’s gain (volume) can be 
independently adjusted to achieve the desired audio result. This filter is useful for tonal shaping of
the finished audio product or to enhance the bass or treble of a recording. It is also useful for 
improving the intelligibility of recordings or ”Bringing Out” a particular instrument or vocal.



· File Conversions
The file conversion filter is not really a filter at all but a way to convert mono files to stereo and 
visa-versa. It can also be used to adjust the channel balance or reverse the channels of a stereo 
recording, or convert a mono source into a stereo file. It is useful in converting stereo recordings 
made out of phase (such as old vertically recorded acoustic discs) into a stereo or mono file that 
is compatible with modern systems. A final important use of the file conversion filter is to simply 
copy parts of the source file over the destination file. This is one way to revert back to the original 
source file (undo) following a bad filter application.

· Crossfade
The crossfade filter is used to join sections of different wavefiles into a single wavefile. Rather 
than just abruptly ending one file and starting another, the crossfade filter will smoothly fade from 
one file to another. During the time that the files overlap, the destination file is gradually faded to 
silence, while the source file fades from silence to full volume. This filter is also available from the 
edit menu as a paste function.

· Change Speed
The change speed filter is used for either fractional speed mastering or for correcting the pitch of 
an off-speed recording. If your record skips when played at normal speed, consider playing it at a 
slower speed and use the change speed filter to restore the original pitch. If your recording is off-
pitch, or contains momentary pitch deviations, use the graphical pitch vs time contour graph to 
correct these deviations.

· Reverb
The reverb effect is used to add a realistic room sound to a recording. The reverb is capable of 
simulating different size rooms, with different kinds of reflective surfaces and decay times. The 
reverb filter lets you control the overall room size, decay time, early reflection level, and mix 
between the original material and reverb sound. Unlike most of the other filters in DC-Art, the 
Reverb filter is really an effect, rather than a restoration tool. 

· Virtual Valve Amplifier
The Virtual-Valve Amplifier is a computer simulation of a number of vacuum tube amplifier circuits.
(Valve is the British term for electron tube.    We call it    the “Virtual Valve Amplifier, because that 
sounds cooler than “Virtual    Tube Amplifier.”)    Its effect is to add “tube-warmth” to the sound of 
a recording.    This is sometimes desirable to apply to DDD (purely digital) recordings.    It can also
be used to add subtle harmonics to very old recordings.    A harmonic exciter is also included with 
the Virtual Valve Amplifier.    This feature allows you to choose the mixture and harmonic 
distribution to be added back into the signal path.    It is useful for enhancing vocals, and 
simulating additional bandwidth on recordings which have lost signal due to generational loss, or 
age.    It is important to note that the Virtual Valve amplifier is using real tube circuits, and real 
tube non-linear device characteristics to produce its effect.    The wide range of adjustability of this
algorithm will allow you to create an amplifier which runs the gambit in sonic performance from 
“grut-guitar” to “high-end audiophile.”

· Dynamics Processor
The dynamics processor provides you with the ability to control the dynamic signal content of the 
audio envelope of a wavefile.    Included are compression, downward expansion, noise gating, 
and de-essing. 

· Forensics Filters
Five Forensics filters are provided to improve the intelligibility of recorded phone          
conversations or “wires.”    Four FIR based filters including lowpass, highpass,                          



bandpass, and bandstop will be found under the brick wall menu item under Forensics                       
Filters.    Also, an adaptive filter is provided.



Restoring the DC-Art Demo Wavefile 
The following is a description of a ”basic” procedure that will restore the DC-Art Demo Audio Wavefile, 
including settings that will give reasonable (not optimal) results.    Its intention is to step you through an 
audio restoration process in order to familiarize you with some of DC-Art’s features.    The song 
segment you will be restoring is titled ”My Sin” (matrix # N-869G) which was performed by the 
California Ramblers for the Edison Company on 4-25-29.    It can be heard in its complete and restored 
form on a Diamond Cut Productions release entitled ”The California Ramblers - - - Edison laterals 2” 
(DCP-301D).    
NOTE: The installation CD contains the full-length versions of “My Sin” in both the raw un-restored 
form and a restored version. The files are located in the Demo directory on the CD.

It is important to note that the steps are order dependent.

1. Open the Wavefile: 
1.1 Open the DC-Art demo wave file by using the File, Open Source menu, and select the file called

Demo1.wav. This file is in the \dcart\wavefile subdirectory.

2. Remove the Ticks and Pops:
The Impulse Noise Filter will be used to remove the ticks, clicks and pops from the Demo Wavefile.

2.1 Click on the Impulse Noise Filter that can be found under the Filter Menu.      
2.2 Set the Impulse Filter Parameters to the following values:
          A. Threshold = 9900
          B. Size = 6
          C. Tracking = 1
          D. Vinyl LP mode is not checked    (in other words, this feature is not enabled)
          E. Preview Mode is not checked

2.3 Click on ”Run Filter” using the left mouse button.    The computer will start processing the file, 
and depending on the speed of your computer, will have completed the file after somewhere 
between 5 seconds to a minute. At the end of this process, you should note that the statistics 
dialog box will have indicated that roughly 350 clicks have been removed from the Source File.   
This step will have completed the De-Clicking process.    The results of this process will be the 
file found in the Destination Workspace. 

2.4 To hear the results of this process, press the play button on the toolbar (the arrow pointing 
toward the left). Note: this step is optional.

2.5 Shut down the Impulse Filter by clicking the Close button on the dialog box, using the left mouse
button. 

3.    Remove Low Frequency Rumble:
The next procedure is intended to remove low frequency ”rumble” from the Demo Wavefile.    You 

will be using the DC-Art High Pass filter.    
3.1 Click on the ”Make Destination the Source” function which will be found under the ”File Menu.”
3.2 Next, click ”OK” in the ”Save As” dialog box. DC-Art will automatically assign a Temporary File 

name to this new Source file.    It can be viewed in the newly opened ”Source Workspace.”
3.3 Click on the High Pass filter which will be found under the Filter Menu.
3.4 Set the following Parameters:



        Frequency = 55 Hz.
        Slope = 18 dB / Octave

    3.5 Click on ”Run Filter.” After the filter has completed its operation, the results will be 
found
                          in the Destination Workspace.

3.6 To hear the results of this process, once again, click on the play button.    You should hear that 
the rumble on the original recording is now gone. Your speakers must have good low frequency 
response to hear the difference.

4. Remove the Hiss and surface noise:
This procedure uses the continuous noise filter. The term ”Continuous Noise” refers to the 
constant background hiss and crackle that appears on most old recordings.

4.1 Once again, click on the ”Make Destination the Source” feature found under the File Menu.
4.2 Click on ”OK” in the ”Save As” dialog box.    The file which had just been in the Destination 

Workspace, will now be found in the newly opened ”Source Workspace.”
4.3 The purpose of the next process is to remove continuous noise from the recording.    This 

includes such noises as hiss and other random noises. You will be using the ”Continuous Noise 
Filter.”

4.4 First, you must give the filter a sample of noise to use as a template. To do this, highlight the first
½ second of the Demo Wavefile. To do this, use the left mouse button and drag it until 
approximately the first 0.5 seconds of the source wavefile is selected. The highlighted sector will
be indicated in yellow.    Use the play button to be sure that you have highlighted only lead-in 
groove noise, and no impulses from stylus drop or music.

4.5 Click on the Continuous Noise Filter, which will be found under the Filter Menu.
4.6 Click on the ”Sample Noise” button found in the filter dialog box. You will see a blue threshold 

line appear above the red signal spectrum line.    It is only necessary to understand what is 
going on here if you are an advanced user.    Otherwise just follow the directions.    If you are an 
advanced user, you will find more information on the use of this filter in other sections of the 
Help file discussing the Continuous Noise Filter. 

4.7 Set the following parameters for the Continuous Noise Filter:
          A. Attack Time = 40 mSec.
          B. Release Time = 80 msec.
          C. Attenuation = 100dB
4.8 Highlight the entire source workspace by double clicking with the left mouse button anywhere 

within the source waveform display area. It may be necessary to move the Continuous Noise 
filter dialog box out of the way before selecting the source waveform.

4.9 Click on the ”Run Filter” button. The results of the Continuous Noise Filter processing step will 
be found in the Destination Workspace, after your computer has completed running the 
algorithm.    To hear the results, click on the play button on the toolbar.

This concludes our example of a ”basic” sound restoration job.    The next advancement would be to 
adjust the filter parameters more to your own personal taste.    Furthermore, you may choose to run the
graphic equalizer, low pass filter, or some other filter after the continuous noise filter has been 
completed.    The variations in the results that you can obtain are tremendous when you consider all of 
the various permutations of filters and parameters available for you to choose from.    Proficiency in the 
use of DC-Art will develop over time as you experience the various results that can be obtained from 
the program. Refer to the help file section entitled ”Filter Applications” to help determine what type of 
filter to use for the various sound restoration problems which you are encountering. 

By using the “Save Settings” feature you can save the ranges of parametric values that have worked 
well for you for certain filters as a function of the type of materials you have restored.    But most 



importantly, become familiar with all of the filter procedures and tutorials found in this Users Guide.



Common Questions
This section lists some common questions new users have about DC-Art.

Q Why does the waveform display only show part of my file?

A Earlier versions of DC-art only reads the first few megabytes of a wavefile for the initial display. 
None of the wavefile processing operations are adversely affected by this. Portions not shown on the 
display can still be played, filtered and operated on just as if they were displayed. To set the size of the 
waveform that will be displayed, use the Preferences dialog box (under the edit menu) and increase 
the ”Display Length Limit” to the size of the file you wish to be displayed. Keep in mind that the larger 
the display size, the longer it will take to initially open a wavefile.    This release uses a separate peak 
file that dramatically speeds up display after the initial update. For users that prefer the original version,
it is still available under the Preferences menu.

Q How do I control the recording level of the audio signal?

A In Windows 95, 98 and NT, there is a speaker Icon in the lower right hand corner of the Taskbar. 
Double-click on this Icon to bring up the control panel for your sound card. There are level controls for 
the Mic or Line inputs of the sound card. Also be sure that the correct input is selected (Mic, Line, or 
Aux) for your particular recording setup. 

Q Why does preview mode sound like it is stuttering?

A    All of the filters in DC-Art require a fair amount of processing power. If your computer cannot 
complete the processing fast enough to keep up with the audio stream, then the preview mode will stop
and start in short bursts that sound like stuttering. This effect can be reduced or eliminated by 
increasing the number of ”Preview Buffers” in the Preferences dialog box. Each “Preview Buffer” adds 
about 10ms of pre-processing before preview playback starts. So increasing the Preview buffers to 50 
will give approximately 5 seconds of clean (non stuttering) audio. 

Q Will increasing the amount of RAM in my computer make DC-Art run faster?

A DC-Art does not require huge amounts of RAM. If your Win95 computer system has 16 to 32    
Mbytes of RAM, then further increases will not appreciably speed up DC-Art. DC-Art uses disk based 
processing so hard drive speed and raw processor speed will generally have a greater effect than 
increased RAM beyond a certain minimum. The minimum amount of RAM is dependent on the 
operation system. For Win98 the minimum should be more like 32Meg, and for NT the minimum should
be 64Meg.

Q Will a Pentium Processor with MMX speed up DC-Art?

A  No. While a faster clock speed is better regardless of the processor, the MMX feature of all new 
Pentiums is designed to speed up Fixed point math operations. DC-Art performs all of its processing 
using floating point calculations that are not affected by MMX. 

Q When I run the Impulse filter in Vinyl mode I only hear very distorted audio. What is wrong?



 A  The tracking level is set too low. Start with the tracking at 100, and decrease it until the clicks go 
away, but the music is not distorted.

Q     I am unable to record a wafefile using the DC Art program.    What can I do?

A    If you press the record button and the recording level meters do not move, check the following 
items:

1. Make sure that your music source (CD, tape player, DAT, etc) is connected to the correct input on 
your sound card.    This should most likely be the LINE or AUX input.
2. Go to the control panel, and click on the Multimedia Icon.    Make sure that the correct audio card is 
selected as the recording device and that the recording level is not set to zero.
3. Most sound cards place a volume control on the task bar.    Click on the volume control icon to bring 
up the level control screen.    Select the recording controls (usually a menu item.)    Make sure that the 
input is enabled.    Sometimes the LINE or AUX inputs are disabled by default.

Q How do I avoid producing dropouts during recording or playback?

A Make sure that you have reviewed all of the following:

1. Make sure that you are using the latest drivers for your sound card.    They can usually be obtained 
from the card manufacturers or Microsoft’s web site.
2. Make sure that the screen-saver and all power management functions will not kick-in during 
recording or playback.    By default, the screen saver has a 1-minute timeout, so after 1 minute of no 
keyboard or mouse activity the screen saver will kick-in.    This flurry of disc activity will put a glitch on 
the recording or playback of wavefiles.
3. Turn off all power saving features, or set their timers to a value of time greater than the longest audio
selection that you want to record or play.
4. Make sure that there is nothing in the Start-Up group.    Look in the Windows Start->Programs-
>Startup group and remove any programs that may run during your recording session.    A notorious 
culprit is Microsoft’s Fast-Find feature.    It periodically searches the hard disk.    It is installed with all 
Microsoft Office products.
5. If you are getting desperate, try disabling virtual memory in the Windows control panel.    Novice 
users should not attempt this because it can seriously effect your PC’s performance.

Q I have a vinyl LP which is very noisy, and still has too many clicks after processing.    What can I 
do?    

A Try running the impulse filter twice.    First run it with the Tracking control set to zero, and adjust the
threshold control to remove just the largest clicks.    When done, make the destination the source, and 
re-run the filter with the Threshold set back to 1, and adjust the tracking control to get the smaller 
clicks.    (Sometimes, repeating the last step with the same settings one more time provides even 
further declicking action.)    Another thing you can try is to use the file reverse feature, and then process
the vinyl recording through the impulse noise filter.    When done, re-reverse the file.



Q How do I generate a simulated stereo file from a monophonic file?

A    Start with a monophonic file that has been de-noised, and convert it to stereo using the File 
Conversion Filters.    Some stereo effect may be added here by applying a little “Time-Offset” during 
this procedure.    Next, make the destination the source, to obtain a new source file.    Run the Reverb 
effect with a Small or Medium hall, setting the decay to a low number, and the early reflections level 
nearly to zero.

Q Does the order in which I process noise out of a wavefile matter?

A Yes.    Always remove clicks and pops with the impulse noise filter before de-hissing a recording 
using either the Continuous noise filter or the dynamic noise filter.

Q My system is stuttering in preview mode.    What can I do?

A If you have a Pentium166 MHz or faster computer, almost all of the DC Art filters should run in real 
time.    (The stereo continuous noise filter is the slowest determinate algorithm, and the impulse filter 
can stutter if set to aggressively on any machine, no matter how fast.)    If you are still getting stuttering,
try setting the number of Preview Buffers to a higher number.    The Preview Buffers setting is located in
the Edit->Preferences menu.    Also, make sure that you are not running any other programs at the 
same time that you are running DC Art.    Other programs can use CPU cycles, even if they are 
seemingly idle.

Q Sometimes when I am de-clicking shellac 78’s, I am unable to remove the very smallest of clicks.  
What can be done?

A Perform a second run of the impulse filter, except in vinyl mode with a size setting around 12 and 
optimization set to accuracy mode.    Set the tracking control to the lowest level, and slowly bring down 
the threshold control from a high value until the small clicks are removed.    You may also want to try 
using HQ mode with a smaller size setting. HQ mode gives a wider range of adjustability.

 



Troubleshooting
Listed below are some common causes of problems using DC-Art:

· Exit other programs, especially during recording. While DC-Art does not put any restrictions on the 
types of programs that may be run while DC-Art is running, closing other programs will increase the 
chances of a glitch-less recording.

· Do not use a compressed drive to record digital audio. If you are using a compression utility such as 
DriveSpace, DoubleSpace, or Stacker, do not use the compressed drive for audio recording. The 
overhead of compression will slow down the recording process and cause dropouts in the recording.

· Disable any screen saver or background process during recording. When a screen saver becomes 
active, it can cause a momentary flurry of disk activity that may cause dropouts in the audio 
recording.    Some programs install a background task in the “Startup” group of Windows when they 
are installed. Make sure any program that is run, will not suddenly cause disk activity. (One such 
example is Microsoft’s Fast Find application installed with their Office Suite products)

· Make sure your computer will not enter an energy saving mode while recording. Windows 95 has a 
feature that allows the hard drives to be powered off after a certain period. Use the control panel’ 
“Power” application to check the timeout period.

· Ensure that you have a Windows 95 or 98 version of your sound card driver. Many systems that 
have been upgraded from Windows 3.1 to Windows 95 are still using the Windows 3.1 sound card 
drivers. Check the version of your sound card driver or ask the manufacturer to verify that the driver 
was written for Windows 95.    

· Update your sound and video drivers. You should be using the latest drivers that are available for 
your sound and video cards. Many problems can be resolved by updating the drivers. Drivers are 
usually available from the manufacturer via a Bulletin Board Service (BBS), CompuServe, America 
On-Line, or the World Wide Web.    Contact the manufacturer for details.

· Limit the amount of memory that Windows95 uses for its disk cache. If you have over 16MB of 
memory and you are using Windows 95, then you may want to limit the amount of memory that 
Windows can use for its disk caching. By default, Windows will use all RAM that is not used for 
programs for its disk cache. This is normally fine, but when it can cause a long delay when it is time 
to write the disk cache back to the hard drive. 



Support

For support in Europe on DC-Art, Millennium, Live, or Enhanced CD/R, please contact

Digital Broadcast Systems GmbH
Feldbergstr. 19

D-61440 Oberursel
Germany

Phone:    0049-6171-582010
Fax:              0049-6171-582012

Email:    support@diamondcut.de
Web Page: http://www.diamondcut.de

Für deutschsprachigen Support für DC-Art, Millennium, Live oder Enhanced CD/R kontaktieren Sie 
bitte

Digital Broadcast Systems GmbH
Feldbergstr. 19

D-61440 Oberursel
Deutschland

Telefon:    06171-582010
Fax:                06171-582012

Email:    support@diamondcut.de
Webseite: http://www.diamondcut.de



System Requirements

1. A Pentium 100 MHz or faster.    A higher speed Pentium is recommended. (Note: Real time or faster 
performance can be achieved on all algorithms when using platforms based on 200 MHz Intel 
Pentium processors, or better.)

2. 16 bit Stereophonic Sound Card with line level inputs.
3. 16 MBytes of RAM*
4. Windows 95 or higher
5. An Audio Source 
6. An Audio Reproduction System
7. A Hard Drive with enough space to accommodate your Wavefiles.    A formula is provided to 

calculate the space requirement under Recording Audio Signals onto your Hard Drive. (The DC-Art 
application program requires 3 MBytes by itself)

8. Mouse, Keyboard, and Color Monitor

* 32 MBytes of RAM recommended.

                            



The File Toolbar 
                                          

The main DC-Art File Toolbar resides along the top of the program window.    It contains 6 buttons that are
the most commonly used file functions of DC-Art.    The toolbar “floats” and can be dragged and dropped 
anywhere within the DC-Art window using the mouse.    Clicking on them with the left-hand mouse button 
activates its functions. Starting from the left-hand side of the screen and moving to the right, you will find 
the following keys which can be activated by the use of the left-hand mouse button:

File Open
This is the button with a file folder icon contained within its perimeter.    This button activates the File 
Open dialog box, allowing you to define the drive, directory, and the file name which you desire to play 
or edit utilizing the DC-Art program. 

Save File
This is the button with a disc icon contained within its perimeter.    This button activates the Save dialog 
box, allowing you to save the active file in the location you desire.

Delete Selected Portion
This is the button with a scissors icon contained within its perimeter.    It is used to delete a highlighted 
portion of a Source or Destination Wavefile. For more information on this feature, refer to the “Edit 
Menu” section of the Operating Manual.

Copy Selected Portion
This is the button with an icon consisting of two paper documents contained within its perimeter.    It is 
used to Copy a highlighted selection of a Wavefile from either the Source or Destination Wavefile, and 
place it onto the programs clipboard.    For more information on the use of this control, refer to the Copy
and Paste Over section of the “Edit Menu” portion of the Users Manual. 

Paste Over Portion
This is the button with an icon consisting of a clipboard contained within its perimeter.    It is used to 
paste the contents of the clipboard file over a highlighted portion of a Source or Destination Wavefile.    
For more information on the DC-Art Copy and Paste over feature, refer to the Copy section of the “Edit
Menu” portion of the Users Manual.

Context Sensitive Help
This is the button with the “?” within its perimeter.    This button will provide you with on-line context 
sensitive Help from the DC-Art Help file. For information regarding the operation of this feature, refer to
the    “How Do I use Context Sensitive Help” section of the Users Manual. 



The Play Controls Toolbar

The DC-Art    Play Controls Toolbar also resides along the top of the program window.    It contains 9 
buttons that are the most commonly used recording and zooming functions of DC-Art.    The toolbar 
“floats” and can be dragged and dropped anywhere within the DC-Art window using the mouse.    Its 
functions are activated by clicking on them with the left-hand mouse button. Starting from the left hand 
side of the screen and moving to the right, you will find the following keys which can be activated by 
the use of the left-hand mouse button:

Rewind
This is the button with the arrow which points to the left and also to a vertical bar.    This is only useful 
when zoomed in on a section of a wavefile. Pressing the rewind button will cause the beginning of the file 
to be displayed. 

Pause 
This is the button with two vertical lines contained within its perimeter.    When activated, the playback of 
the wavefile will pause at that location.    Play can be resumed by activating the play button, or depressing
the spacebar on your keyboard.

Fast Forward
This is the button with an arrow pointing to a vertical line on its right-hand side. This is only useful when
zoomed in on a section of a wavefile. Pressing the fast forward button will cause the end of the file to 
be displayed. 

Record
This is the button with the red square contained within its perimeter.    It is used to place the DC-Art 
program into record mode.    Please refer to the section entitled    “Recording Audio Signals onto your 
Hard Drive” for more detailed information on the recording process.
                                                      
Stop
This is the button with the black square with a green dot contained within its perimeter.    It is used to 
stop either a record or a playback session.
                                                                                                            
Play
This is the button with a black arrow which is pointing towards the right.    This button is used to 
commence a playback process.    The playback will begin at the leftmost portion of the yellow highlight 
area of your wavefile.    The keyboard spacebar also performs this same function. For more 
information on the DC-Art play feature, refer to the “Play File Synopsis” section of the Operating 
Manual.    
 
Looping Play      
This is the button with a square containing an arrow pointing back to itself.    This key is used to “loop” 
(repeat) the playing of a highlighted section or an entire wavefile. Pressing the key again will stop 
looping playback.

Zoom-In
This is one of the buttons with a magnifying glass icon within its perimeter.    It is used to "Zoom-In" on 
a highlight portion of either your Source or Destination workspace.    The Zoom-In process may be 



repeated any number of times for a really close and detailed look of your audio waveforms.    However, 
only the last 5 zoom levels are retained.    Please note that this function can also be accessed through 
the View command. 

Zoom-Out
This is the other button with a magnifying glass icon within its perimeter.    It is the right-most key on the
DC-Art Toolbar.    It performs the inverse function of the Zoom-In key.    It allows you to progressively 
back out of a wavefile which you had previously Zoomed-In on. As with the Zoom-In function, please 
note that this function can also be accessed through the View command.    For more information on the
Zoom feature of DC-Art, refer to the “How Do I” section of the Operating Manual under “Zooming-In & 
Zooming-Out on portions of a Wavefile.”    

MultiFilter
This icon will bring up the multifilter dialog box. If you have version 4.0 Live, then you will be able to 
perform live (real-time feed-through) mode filtering.    



The Filter Toolbar

 The DC-Art Filter Toolbar also resides near the top of the program window.    It contains 18 control 
buttons that are the most commonly used filters and effects in the DC-Art Program. This toolbar, like 
the others, “floats” and can be dragged and dropped anywhere within the DC-Art window using the 
mouse.    Clicking on them with the left-hand mouse button activates its functions. Starting from the left-
hand side of the screen and moving to the right, you will find the following buttons that can be activated
by the use of the left-hand mouse button:

Impulse Filter 
Continuous Filter 
Harmonic Noise Filter 
Dynamic Noise Filter 
Low Pass Filter 
Band Pass Filter 
High Pass Filter 
Notch Filter 
Median Filter 
Averaging Filter 
Graphic Equalizer 
File Conversions 
Change Speed Function 
Cross Fade 

Reverb 
Virtual Valve Amplifier 
Compressor 
Paragraphic Equalizer
Channel Blender 
Brick Wall Filter 
Adaptive Filter 

For details regarding the use of these filters and effects, please click on the appropriate sections.



The Source and Destination Workspace
 When you open a Wavefile in DC-Art, two workspaces will appear.    The top one, called the Source 
Workspace will display an envelope consisting of the program peaks of the wavefile just opened. The 
display will consist of a black signal on a yellow background. The Destination Workspace just below 
the Source workspace will contain no waveform information initially, and will contain a gray 
background color.    Both of these two workspaces display amplitude on the Y-Axis (vertical) and time 
on the X-Axis (horizontal).    When you initially open a file, the entire file is displayed, and is periodically
represented by a sample of the peak of the waveform envelope.      When you Zoom-in on a portion of 
the waveform, at some value of magnification, you will begin to see continuous waveforms, rather than 
a peak    representations of your wavefilel.    For more information regarding Zooming-In on a wavefile 
or Zooming-Out on a wavefile, please refer to the sections entitled “Zooming-In & Zooming-Out on 
portions of a Wavefile.”    Please note that the active workspace is always shown in yellow.      

By default DC-Art uses a separate “Peak File” for quick display operation, Older versions of DC-
art read waveform data on the fly. This option is still available under the preferences menu.
Fehler! Kein gültiger Dateiname.

At the top of the two workspaces is a Title bar which contains the name of the opened Source 
wavefile. Above each of the wavefile workspaces you will see the Sample Rate which was used to 
create the file on the right-hand side.    Next to the Sample Rate, you will find the mode in which the file
was recorded, or processed, being either Stereo or Mono.
The Sample Rate, and Stereo/Mono indication is also shown in the Status bar that appears at the 
bottom of the screen.
Please Note: As shipped from the factory, workspaces do not show the file information above the 
workspace. This option must be enabled in the Preferences Dialog Box.

After a Wavefile has been processed by one of the functions under the Filter command, the output of 
that file will be sampled just like the Source file and displayed in the Destination workspace just below
the Source workspace.    It will become highlighted in yellow just following the completion of a 
processing session.
At the top of each of the two workspaces, you will see three time displays.    Each display indicated in 
Hours:Minutes : Seconds : Milliseconds.    The time display on the right-hand side of the 
workspaces indicates the starting time of the portion of the wavefile being displayed in the particular 
workspace.    The time display on the left-hand side of the two workspaces indicates the ending time of 
the displayed portion of the highlighted wavefile.    When a file is initially opened, the display on the left 
will indicate 00:00:00:00. The left-hand display will indicate the total time duration of the opened 
wavefile.    If you use the Zoom function,    the left-hand display will now display the start time of the 
highlighted Zoom-In portion of the wavefile.    The right-hand time display will indicate the end-time of 
the highlighted Zoomed-In portion of the wavefile.    The total time duration of the Zoomed-In 
highlighted portion of the wavefile will be displayed on the status bar located below the workspaces. 
At the right hand side of each of the two workspaces, you will see two vertically oriented slider controls 
next to one another.    These are useful for viewing details in a selected portion of a waveform which 
has been Zoomed-In on.    For example, there may be a small transient that you want to see in more 
detail that is riding on top of a much larger waveform.    The control on the farthest right is the display 
gain control.    Using your mouse, you can move this control up and down in order to change the 
display gain. Moving it down will increase the gain of the display, making the waveform larger on the 
display. However, it may get so large as to move the portion of the waveform in which you are 
interested off of the top or the bottom of the display screen.    The control just to the left of the gain 
control is the offset control; this is used to move the entire portion of the waveform in which you are 
interested back into view.    You should experiment with these controls a few times to get a feel for how 
they behave, and then you will begin to understand their usefulness.    
At the bottom of each workspace, you will see the Time Axis Scroll-bar.      This control is also 
operated by the left mouse button, and is used to move the play pointer to various locations within the 
display workspace. Sometimes, there can be a few second delay when using this slider, so be patient 



as it performs the calculations to keep up with your commands.    When you are Zoomed-In on a 
portion of a file, the slider control can be used to move the display start-point within the highlighted field
using either the slider with your mouse, or by using the arrow controls which are located at each end of
the slider.    The Time Axis Scroll-bar position is always relative to the entire file length, no matter how 
zoomed-in on a particular waveform you may be. Clicking on the right hand arrow button will move the 
waveform to the left of the workspace 1 / 10 th of the overall display length and clicking on the left-hand
arrow button will do the same thing, only moving the file in the opposite direction.    If you click on the 
Scroll-bar (not the slider control itself,) the waveform will move one full frame to the left each time you 
click.    
Note 1: The Time Axis Scroll-bar is inactive when you are fully zoomed-out.
Note 2: When not using peak files for display, only the first few Megabytes of a wavefile are used for 
the initial display.    No wavefile processing operations are adversely affected by this action. Portions of 
your wavefile not shown on the display can still by played, filtered and operated on just as if they were 
displayed.    To set the size of the waveform that will be displayed, use the Preferences dialog box 
(found under the edit menu) and increase the “Display Length Limit” to the size of the file you wish to 
be displayed.    Keep in mind that the larger the display size, the longer it will take to initially open a 
wavefile. 



The DCart Status Bar
The DC-Art Status Bar resides along the bottom of the program window.    Four parameters are 
displayed therein:

1) The Program Mode is displayed in the left-hand field.    Initially, it will indicate Ready.    Clicking on 
the various toolbar buttons will show a brief description of the buttons function.
Note: Clicking on the various DC-Art menu items will also activate a one-line help text file which 
describes each menu item.

2) The field to the right of the "Program Mode" field shows the number of channels being used by the 
selected wavefile. DC-Art and will indicate either Mono or Stereo.

3) The next field moving towards the right-hand side of the display widow shows the sample rate in 
kHz.

4) The next field moving towards the right is the length of time for the highlighted portion of the 
selected Source or Destination Workspace. 

5) The right-hand field indicates the available temporary hard drive space In Mbytes.    This is useful to 
determine whether or not there is enough storage space to perform your sound job.    To perform this
calculation, refer to the section entitled Recording Audio Signals onto your Hard Drive .

6)



Menus
DC-Art provides nine menu item located across the top of the program window.    The program 
commands are all provided under these menus.    Looking from the left of the screen towards the right, 
the menu items appear as follows: 

The following menu items are described in the sections which follows:

File Menu 
Edit Menu 
Filter Menu 
Effects Menu 
Marker Menu 
CD Prep     
View Menu 
Window Menu     
Help Menu 
 
To activate a particular menu item, point to it with your mouse and click on it with the left mouse button.



CD Prep

The CD prep menu contain three features specifically aimed at preparing wavefiles for CD-R’s.    These
features include the following:

Quantize for CD Audio     
Chop File Into Pieces     
Find and Mark Silent Passages     
Gain Normalize     



Normalized Gain Scaling
Normalized Gain scaling is identical to the Normalize Gain function except that instead of automatically
adjusting the peak signal level to 0dB, it allows you to select the maximum peak level. For example if 
you set the gain to –3.0dB after the scaling operation, the maximum peak signal level in the file will be 
–3.0dB. This allows you to adjust your files to levels other than 0dB.
Be careful setting gains greater than zero. If the gain is set to +3dB, then the maximum signal level will 
be clipped at some point in the file. 

NOTE: Gain Normalize and Normalized Gain Scaling will always search the entire file for the Peak 
Signal Level, but will only change the gain on the selected section of the wavefile.



Quantize for CD Audio
This feature moves a marker to a multiple of 2352 Bytes to provide compatibility with CD Red Book 
Audio data grouping so that glitchless indexing can occur. This feature is particularly useful when 
chopping a large (continuous concert type) wavefile into pieces for transfer to CD-R (recordable CD’s). 
The “Disk-At-Once” write mode must be used in order to benefit from the file size quantization. 



Chop File Into Pieces
 This command breaks a long wavefile into smaller wavefiles as defined by the locations of your 
various markers.    You have the choice of retaining the original file or deleting it as the operation 
completes. You may need to delete the original file because of disk space limitations. At the completion
of the operation a screen will appear with the assigned names of the new wavefiles. At this point you 
have the option of creating a playlist that is made up of the new files.



Find and Mark Silent Passages

DC-Art includes a feature, which will automatically find and mark the silent passages of your wavefile.   
This is particularly useful when you desire to process an entire Vinyl record album in one shot through 
the various DC-Art algorithms, and then break them up into separate wavefiles at the end of the 
process.    You have the ability to select the threshold of silence, and the time duration of the silence.    
After you have invoked this feature, you will see all of the markers moved to the silences between cuts.
You can move the markers manually, if you are not satisfied with the separations which were 
automatically determined by the program.    After this has been completed, you can chop the file into 
pieces, and separate wavefiles will be created.



Normalize Gain

The DC-Art Normalize Gain feature searches an entire wavefile, looking for the peak signal level.    
Then, it adjusts the gain applied to the file so that the overall level is below that value.    This will 
provide the best signal to noise ratio and a reasonable volume balance for each “cut” on your final 
master.    Normalize Gain should be applied before burning a CD-ROM or making your final tape.



Edit Menu

The Edit Menu allows you access to the various commands related to the setup of DC-Art and also a 
few of the program features associated with direct hard-disc Wavefile editing.    The following 
commands are available in the Edit Menu.

Copy     
Cut  
Device I / O  
Fade-In 
Fade-Out  
Make Waves     
Mute 
Paste Insert     
Paste Interpolate 
Paste Over  
Pause File  
Play File  
Preferences 
Record File  
Stop File 
Undo     
 



Copy and Paste Over
"Copy" works in conjunction with "Paste Over" and allows you to move segments of a wavefile around 
within itself or to other Wavefiles.    This feature is analogous to the same feature found in programs 
such as word processors, with the only difference that in DC-Art, you are working with Wavefiles rather
than text.    The Copy command takes the selected (highlighted) portion of a Wavefile, and places it in a
temporary file location.



Cut
The Cut feature is the cousin to the "Mute" function.    The difference is that the "Mute" function silences
the highlighted Wavefile sector, whereas the "Cut" feature completely extracts the segment.    This 
feature may be found useful when it is necessary to reduce the musical portion of a segment for a 
competitive event in which the total length of the program is governed, and you do not want to 
eliminate either the beginning or the end of the song to achieve that end.    Please note that this feature
is only "undo-able" once.
For more information on the "Cut" command, refer to the “Splicing Out a Sector of a Wavefile” found in
the “How Do I” section of this manual.



Device I/O Selection
This feature allows you to define the input and output device that the DC-Art program will utilize. This 
will generally consist of some sort of sound card, either analog to digital, or digital to digital.    Please 
note that the input device can be different from the output device.    The Device I / O selection will be 
saved for use in subsequent DC-Art sessions, and need not be defined each time the program is run.



Fade-In
Fade-in does what the name implies when applied to the beginning of a wavefile.    You can choose 
between linear or logarithmic envelopes, and you can also choose the time period for the fade-in by 
selecting the portion of the wavefile over which you desire fade-in to occur.    Lastly, you can choose the
"start level" for fade-in as well as the "stop level."    ("Level" is the start and stop loudness for the Fade-
In)
For a procedure describing the use of the Fade-In feature, refer to the “How Do I” section.



Fade-Out
Fade-out also does what the name implies. It contains all of the features outlined in the "Fade In" 
description.
For a procedure describing the use of the Fade-Out feature, refer to the “How Do I” section 



Gain Change
DC-Art provides a gain change feature that is useful for correcting loudness deficiencies on 
recordings, or to provide the additional headroom required before running the graphic equalizer filter.    
Gain change can be very creatively applied using the contour graphical interface.    It can also be 
utilized globally on a file, or selectively to bring out a weak vocal, etc. 

The following is a summary of the control parameters and the range of adjustment provided for the 
Gain Change algorithm:

A. Type (Fade In / Fade Out / Gain Change)
B.    Slope (Linear / Logarithmic / Curve)
C. Gain Ranges:
          1. +20 / -100 dB
          2. + / -20 dB
          3. +/- 10 dB
          4. +/- 3 dB
D. Start Level (dB)
E. End Level (dB)
F. Shape (Gain vs. Time): Straight Line (2 Green Cursors) (start and end gain values)

Curved Line    (4 Green Cursors) (curvilinear inflection point controls)

The Graph shows how you have programmed the gain to change as a function of the selected wavefile
time axis.    You can use the mouse to drag the two green cursors to establish the time relationship that 
you desire.    Often, a flat line is appropriate, however, sometimes the loudness of old 78’s decreased 
towards the end of the recording by a few dB.    This can be corrected by a gain correction starting at 0 
dB and ending with perhaps 3 dB (depending on the severity of the problem). The reason this occurred
is that the early cutting lathes did not provide automatic gain (or frequency response) compensation 
controls.    When the curve shape is selected, two additional green cursors appear. The two additional 
green cursors can be moved both vertically and horizontally allowing you to create numerous 
curvilinear gain vs. time relationships.    

Important Warning: Digital systems, like analog systems, can be overdriven to the point of “clipping” 
the signal.    This will produce unwanted distortion (except on rock n’ roll).    Before applying a gain 
increase to a wavefile, study the amplitude of the signal and be sure that you are not adding so much 
gain as to exceed the dynamic range of the system which is 2^16 LSB’s.    If you do, signals will appear
to flatten out horizontally at their peaks on the Source or Destination Workplace displays.        



Make Waves
This feature provides you with the capabilities of a programmable audio signal generator.    It can 
produce Sine or Square waveforms of adjustable frequency and amplitude.    It is also capable of 
producing Random waveforms of the white noise variety.    “Make Waves” is useful for calibrating and 
verifying the performance of the audio equipment used in your sound restoration laboratory.    It will 
also be useful to help you better understand the functionality of some of the filters provided in the DC-
Art application.    The sweep and Random generator is especially useful for characterizing the 
frequency response of electrical and acoustical systems.    The following controls with their adjustment 
range are provided:

1. Start Frequency: 1 to 44,000 Hz.
2. Stop Frequency: 1 to 44,000 Hz.
3. Length: (Duration of the tone burst) 1 Millisecond to 5 Minutes. 
        (Data entry is in seconds.)
4. Amplitude: 0 dB to -96 dB 
5. Linear Sweep check box (on or off)
6. Sine, Square, Triangle or Random (white noise) Wave selector
7. Stereo or Mono checkbox
8. Sample Rate: 11.025, 22.05, 44.1, 48.0, 96.0 KHz.
For a procedure describing the use of the Audio Signal Generator, refer to the “How Do I” section of 
this manual.

Note: The “Make Waves” generator creates 16 bit wavefiles.    To create other values of resolution (bit 
depth) from the make waves generator, use the    “resolution” function found under the “Save As” 
command which can be found under the File menu.



Mute
This feature uses direct hard disc editing to allow you to mute a selected portion of your wavefile.    If 
you find a stubborn "pop" on a recording that is not removed and replaced with a new signal by the 
Impulse Noise filter, you can zoom-in on the pop, highlight it, and mute it.    When "mute" is applied for 
a small period of time, the fact that there is silence during the mute period will not necessarily be 
noticeable in playback. Even if it is slightly noticeable, sometimes a "mute" is more desirable than a 
loud "pop" or "thud" during playback.    Another method for manually "de-popping" a recording involves 
the use of the DC-Art Copy and Paste Over feature.    This method, although a bit more complicated to 
use, produces a better result compared to the Mute feature.    The Mute feature is also useful for getting
rid of noise at the beginning or the end of a recording.    The Mute feature is accessible from either the 
Edit Menu or the right hand mouse button. 
For a procedure describing the use of the Muting Feature, refer to the “How Do I” section of this 
manual.
Note:    Do not mute the beginning or the ending of a wavefile before operating the impulse noise filter.  
Doing so will cause it to function at an extremely slow rate of speed during the muted section, because 
it will have a very difficult time calculating a signal to noise ratio on a signal containing all zero’s.    
Perform the wavefile muting function after all other filter operations have been completed.



Gain Riding using Fade-In and Fade-Out
The Fade-In function in conjunction with the Fade-Out function can be used to adjust the gain on a 
selected portion of your wavefile.    This is useful if you have a portion of a wavefile which needs a 
boost in gain such as a weak vocal, or you have a portion of a wavefile which "blasts."    You can 
increase the gain on a selected portion of the wavefile up to 6 dB, or you can attenuate a portion up to 
around 96 dB.    When using a gain increase, please be aware that it is possible to overload (clip) the 
signal.    This can add unpleasant distortion products to your wavefile.          
For a procedure describing the Gain Riding process, refer to the “How Do I” section of this manual.



Paste as New File
This will create a new wavefile from the current contents of the copy buffer.
This feature provides a convenient means to chop a large file into smaller pieces, and assign new 
wavefile names to these subset files.    It is useful for creating a number of wavefiles which could be 
listed and quantized for CD-R indexing from a single large file such as that which you might have from 
transferring a Vinyl LP or a concert tape recording to DC-Art.    A popup window will appear in which 
you can re-define a file name for each “chopped” file subset.      



Paste Crossfade
“Paste Crossfade” is the cousin of the Paste Mix feature.    It operates in a similar manner with the 
difference that there is a time varying function applied to the gain settings so that a “crossfade” effect 
can be produced.    This feature is useful when you want to fade one song (or file) into another, with no 
“dead-air” in between.    When you run Paste Crossfade, you will be able to adjust the File-1 
(clipboard) Start and Stop Gain settings as well as those for the target file (File-2).    You have available
four gain controls in total.    You will also be able to control the dynamics of the crossfade by selecting 
Linear In, Log In, or Log Out. This feature is undo-able when executed under the Edit Menu. The 
“Paste Crossfade” feature is also available under the Filter Menu. However, when it is run from the 
Filter Menu, it is not undo-able. 

 



Paste Insert
"Paste Insert" is a cousin to the "Paste Over" command.    The difference is that "Paste Insert" does not
wipe out the sector of the Wavefile in which you desire to place the contents of the "Copy" temporary 
file.    Instead, it appends the "Copy" temporary file to the desired Wavefile.    Please note that this 
feature is only "undo-able" once.



Paste Interpolate
Paste Interpolate allows you to manualy correct a recording impulse noise defect such as a tick, pop, 
click or thud.    To use this function, merely highlight the area in the source file in which you are 
observing a noise event.    Next, click on the Edit Menu, and scroll down to “Paste”.    Lastly, click on 
the Interpolate feature and the event will be replaced with a new waveform.    This new waveform is 
calculated by a high order modeling algorithm utilizing up to a maximum of up to 4096 samples of data.
A more convenient method to access this feature is through the use of the “I” key on your computer 
keyboard.    
The maximum amount of time that can be selected for Interpolation is approximately 10msec for a 
44.1kHz sampled wavefile.



Paste Mix
“Paste Mix” allows you to add or “mix” one file (or a portion thereof) to a second file.    This feature is 
useful for creating “voice-overs,” or inserting special effects on top of a previously created sound track.
This feature works in conjunction with the Copy function. In many cases it will require that two files be 
opened, one in the Source Workspace, and a second in the Destination Workspace.    But this is not 
mandatory in that you can “paste mix” a portion of a file back onto itself if desired. The file which you 
open in the Source Workspace can be the file onto which you will be mixing.    The File which you will 
be establishing as the “voice over” or special effect, might be the one opened in your Destination 
Workspace.    In other words, you can mix the Destination file into the Source File. The process can 
also be performed in reverse, wherein you can mix a portion of the Source file into the Destination File. 
These processes are undo-able, so that you can experiment until you are satisfied with the result.    To 
use this feature, you will be highlighting the portion of the Destination File which you want to mix into 
the Source file.    You will then use the Copy command to place it on a clipboard.    Then you will 
highlight the Source file location in which you want the voice-over mixed in.    When you run Paste Mix, 
you will be able to adjust the Source and Destination gain settings over a range of from +12 dB to - 100
dB. 



Paste Over
"Paste Over" is the Siamese twin of the "Copy" command.    It allows you to insert the portion of the 
Wavefile located in the Copy temporary file location over the top of a different location in your Wavefile 
or to other Wavefiles. (This operation will delete the portion of the Wavefile which previously had been 
in the particular location, installing the temporary file in that position instead.)    The "Copy and Paste 
Over" feature in DC-Art can be used to manually "de-click" or "de-pop" a sound source, create special 
effects, or to modify the context of a spoken word    (for laughs only, of course.)
Note:    Both "Copy" and "Paste Over" can also be accessed by way of the right mouse button.    
For a procedure describing the use of the Copy or Paste Over features, refer to the “How Do I” 
section. The topic describing    “Manual de-clicking Process” may also be of interest.



Pause File
This command temporarily stops or resumes the playback or record process.    It "toggles" between 
"Pause" and "Play" or "Record."    Its functionality is identical to the Pause button found on the DC-Art 
Toolbar. When the system is in "Pause" mode, you will see a check mark to the left of the command.
For more information regarding the "Pause" button, refer to the DC-Art Toolbar section of this manual.



Play File
This command is used to commence a playback process.    The playback will begin at the leftmost 
portion of the yellow highlighted area of your wavefile.    The keyboard spacebar, the "Play" key on the 
DC-Art toolbar or the right mouse button can also be used to perform this function.    
For more information regarding the "Play" button, refer to the DC-Art Toolbar section of this manual.



Preferences
This feature allows you to define the following parameters:

1. Drive and directory for temporary wave files. 
This file path sets the location for all of DC-Arts temporary wave files. DC-Art creates temporary 
wave files for most operations so the temp drive should have plenty of free space.

2. Preview Buffers
This parameter applies to preview mode only.    It allows you to choose how much of the file is 
calculated before playback begins. You can select between 1 to 50    buffers.    1 buffer = 4096 
samples. Some systems require a larger number of buffers for stutter-free playback. good default is 
7.

3. Undo Levels
This parameter allows you to choose the number of undo levels of destructive editing which DC-Art 
will maintain as stored files on your hard drive. The default value for this parameter is 10. All undo 
buffers are deleted when the file is closed.

4. Nudge Size
This parameter defines the resolution of the left and right arrow keys on your keyboard as they apply
to the Wavefile highlighting feature of DC-Art.  This parameter is defined in terms of samples.    After
highlighting a portion of a Wavefile, you can fine tune or "nudge" the highlighted area using the left 
and right arrow keys, and the Shift key.    The resolution of each click on an arrow key is defined by 
the value of "nudge size."    

5. Display Colors
This set of parameters allows you to choose the Source and Destination Workspace background 
and Highlighted colors.    When you click on either parameter, a color palate will appear, and you can
click on the color combinations which suits your vision the best.

6. Loop Preview
This feature, when checked, will cause a “previewed” section of wavefile repeat itself endlessly or 
until the filter or effect is canceled or the preview button is clicked a second time.    It is a useful 
feature when trying to fix a relatively small section of a wavefile.    It saves a lot of keyboard steps.

7. Clean Display
Selecting this option will hide the file name and file type information that appears directly above the 
source and destination waveform. 

8. Sync Mode Scroll Tracking
When selected, any movement of the scroll bar and arrow keys in either source or destination 
workspace will cause both the source and destination files to track in time. 

9. Reaction Time
Reaction time is used when dropping a marker while a file is playing (using the M key). This values 
determines the amount of time the marker will be moved backward in time to compensate for human
reaction time and display cursor update rate. This value should be adjusted so that the markers 
appear in the proper place in the file. 

10. AutoSave Filter presets
When checked, all parameters of the filter will be saved in the default preset when the dialog box is 
closed. This is so that when the filter is re-opened, the last parameters will be automatically recalled.
If it is not checked, then you must manually save the Default preset to change the initial filter 
parameters. Previous versions of DC-art would automatically save the default preset. 

11. Don’t Use Peak Files for Display
By Default, DC-art uses a separate file called a Peak File to save the image of the waveform. This 
greatly speeds up file zooming and panning especially on large files. The peak files are created the 
first time a file is opened and saved for future use. In addition, all marker settings are stored in the 
peak file. If this box is checked, then DC-art will revert to its previous mode of operation where the 
wavefile is re-read for each zoom operation. In this mode, the Display length limit parameter is used 
to stop reading the file after a preset size is read. The portion of the file that is not read will be 
displayed as a flat line. If you work on many files, only once and do not do a lot of panning and 
zooming,    then selecting this option may actually speed up file operations for you.



Record File
This feature allows you to perform hard disc recording.    It behaves in the same manner as the record 
button on the toolbar.    For details on recording, please refer to the section entitled Recording Audio 
Signals onto your hard drive .
 



Stop File
This command is used to stop either a record or a playback session.    Its functionality is replicated by 
one of the buttons found on the DC-Art Toolbar. 
For more information regarding the "Stop" button, refer to the DC-Art Toolbar section of this manual.



Undo
This feature allows you to return to a previous version of a destructively edited file after using such 
features as Mute, Fade-In, Fade Out, Cut and Copy / Paste / Insert. The number of undo levels is only 
limited by the amount of space available on your hard drive, and is configurable under the 
"preferences" command set of the Edit Menu.    After an “undo” is performed, it is removed from the 
“undo” listing.
For more information on the operation of the undo feature, refer to the “ How Do I”   section of this   
manual. 



Effects Menu
The Effects menu for the DC-Art program contains the algorithms that are normally used to enhance a 
audio recording and are not strictly used for restoration. The available effects are Reverb, Virtual Valve 
Amplifier, Dynamics Processor, Punch and Crunch, and Reverse File.



Reverb 
The reverb effect allows you to impose the acoustical interaction of a real room on a recording.    This 
can be useful when dealing with recordings that are completely “dead” as originally mastered.    As with
the various DC-Art filters, the reverb effect can be applied globally or selectively (using sync mode) to 
a wavefile.    The reverb effect can also be used to convert a monophonic recording to a simulated 
stereophonic recording.    The following controls are provided on the DC-Art reverb:

1. Room Size: (check box) 
a) Small (Club)
b) Medium (Auditorium)
c) Large    (Concert Hall)
d) Very Large    (Stadium)

2. Reflections: (check box)
a) Bright: (Simulation of a very “hard” acoustical environment, as in a stone building)
b) Warm:    (Simulation of a typical auditorium or theater)
c) Dark:    (Simulation of a heavily draped auditorium)

3. Decay: Control Range 1 to 99 in relative units.
The decay control effects the dampening effect of the algorithm on the reverberated signal.    The 
higher this control is set, the longer the reverberation “dwell-time.”    The lower that this control is set, 
the quicker will be the decay of the reverberated waveforms.

4. Output Mix: (Slider Control)    Control Range: 0 to 100 in      percentage units
The Output mix determines the amount of the reverb effect which is fed into the system output.    
When the control is set to zero (dry), there will be no reverb effect.    When the control is set to 99, 
there will only be the reverb effect, with the source signal bypassed.    Useful ranges of control are 
usually in the 5 to 25 range, but if you are looking for extreme effects, you can get them if desired. 

5.    Reverb Presets:
The DC-Art reverb is equipped with a number of descriptive presets.    This is a good place to start 
from when using the reverb effect.    Choose the desired acoustical environment (which can be 
selected and previewed “on-the-fly”).    After you have found something close to the sound you 
desire, revert to the various controls to “tweak’” the reverb for the exact sound you are looking for.



Virtual Valve Amplifier
            The DC-Art Virtual Valve Amplifier (VVA) produces a variety of sounds associated with valve 
(electron tube) based amplifiers.    The effects run the range from a subtle “tube warmth” sound to 
extreme effects like “guitar amplifier overload” or “fuzz box.”    Also included, is a valve based 
harmonic-exciter effect. The DC-Art VVA accomplishes these effects through the use of actual electron
tube circuits, which are simulated by your computer.    The electronic models of the various tube 
amplifier circuits have been derived from the “large-signal” transfer functions of the various tubes and 
output transformers. This data has been derived from extensive bench measurements of tube amplifier 
circuits under varying operating conditions.    As such, the effects will sound literally as would be heard 
if you were to process a signal through a physical electron tube amplifier.    However, with the DC-Art 
VVA, you have a great deal more control over the various sounds which can be produced, since 
controls, which are not normally found on electron tube equipment, have been provided.    Parameters 
such as “Operating Point” (sometimes referred to as “Q” point by engineers) are usually fixed by the 
amplifier manufacturer.    “Drive” is determined by how loud you play a “physical” amplifier, but with the
VVA, the output level remains constant independent of drive due to an internal gain compensation 
algorithm.    The following is a listing of the controls that are provided on the DC-Art VVA:

1. Drive Slider: 1 to 100    
This control effects the degree of modulation applied to a given tube amplifier circuit and centered 

about the operating point.    The higher the drive level setting, the greater the production of 
predominantly even order harmonics due to the circuits non-linearity.    As a result, there will be more 
“effect” as this control is increased.    Also, the “depth” of the effect is determined in part by the degree 
of drive applied.

2. Operating Point (or Harmonic Control) Slider: -100 to zero (in the middle) to +100 
 

 VVA Mode:

                            The operating point control performs two different functions, depending on the Tube 
Type / Configuration selected.    When a triode or class A amplifier is chosen, it sets the operating 
point for that particular tube or amplifier configuration.    Operating point is also referred to in 
engineering terms as “Q” (quiescent) point, and determines the devices bias value at zero signal input.
The distributions of harmonics, which are introduced into the output of the amplifier, are determined to 
a large degree by the location of the operating point.    When the control is set to + 100, (all the way up)
the devices are operating close to “saturation,” and when the control is set to – 100 (down), the 
devices are operating close to “cutoff.”    The non-linearity distribution is different near cutoff as 
compared to operation near saturation.    You can use the control to achieve variations in the desired 
“tube effect.”    Most audio preamplifier tubes such as the 12AX7 are the most linear in the middle of 
their dynamic operating curve (control set to the middle position.)

Harmonic Exciter Mode:
                
                        When the system is placed into harmonic “Exciter” mode, the operating point control 
reverts to a “Harmonics Control” which varies the distribution of harmonics that are produced by the 
VVA.    The Harmonic Exciter is designed to provide the following audio enhancements:

A. Synthesize the upper register harmonics that may have become lost through “generation 
loss” or due to the poor frequency response of the master recording.

B. Add “presence” to a vocal recording.



C. Create a more “up-front” sound on any modern recording.

                      When the control is set to +100, both even and odd harmonics are produced.    When the 
control is set to –100, only the first 3 to 4 even harmonics of the fundamental are produced.    Settings 
in between will produce varying combinations of the two extreme settings.    The system is placed into 
harmonic Exciter mode by checking the “Exciter” box listed under Tube Type / Configuration, located 
at the bottom of the VVA window.    The magnitude of the inserted Exciter effect is controlled by the 
“Mix” control. 

3. Operating Point Indicator: Vertical undulations are graphically presented proportional to signal level, 
drive, and operating point. The Operating point indicator will have a black background in standby 
modes of operation and a blue background with vertical undulations appearing in any of the operational
modes of the VVA.    A yellow horizontal line during operation indicates the operating point center value.
Also, a fixed white line on the indicator indicates the dynamic operating mid-point reference. The 
magnitude of the drive level to the amplifier is indicated by yellow undulations plus and minus about the
operation point.    So both the effects of the drive and the operating point slider are indicated on the 
same display, for convenience.

4. Detail: 0 to 100
                    The detail control allows you to control the sensitivity of the VVA to the more delicate 
nuances of the musical material presented and processed.    The higher the setting, the greater will be 
the effect that this control will have on the material.

5. Mix: 1 to 100
                  The Mix control effects the degree of VVA signal, which is re-inserted into the signal path.    At 
it’s maximum setting of 100 (wet), the dominant signal pathway is exclusively through the VVA, and 
when the control is set to 0 (dry), only the non-processed signal is fed through the system.    You can 
choose any level in between which appeals to your taste

6. Range Checkbox:        -Sweet          -Warm          -Full Range
                    The Range control effects the spectral distribution of the harmonic by-products, which are 
passed through to the systems output.    Its most desirable setting is very much a function of the 
musical material, which is being processed, and the desired tube sound.    

7. Advanced Controls Checkbox: On/Off
                    This enables the more advanced controls of the VVA, if desired.    If this control is not 
checked, defaults values will be chosen for some of the control settings, tube types, amplifier 
configuration, operating point and detail controls.    Although all of those settings are preset, you will still
have control over the VVA Drive and Mix settings.

8. Bypass: On/Off
                    This control allow you to quickly compare the effects of the processed signal produced by the
VVA to the unprocessed signal, while the program is in “Preview” mode.

9. Settings:    Listing
                    The VVA has a list of pre-sets, which will be a valuable starting point from which to fine tweak
the adjustment controls to your desired taste.    These presets are somewhat descriptive to help you in 
making a choice.    The choices can be changed in real-time while running the program in Preview 
mode, so that you may compare the various presets.

10. Tube Type Checkbox: Checkboxes for the following Valves (tubes) or circuit configurations:



    A. Triode (12AX7)    - This configuration incorporates a high-mu dual triode into a typical RC coupled
class A audio pre-amplifier configuration.    This tube was chosen, because it had been and still is the 
industry standard pre-amplifier valve.    It has a relatively flat linear operating region in the middle of its 
dynamic operating range, producing relatively lower levels of distortion compared to some of the other 
devices offered in the VVA.    But, by moving the Operating Point to either the saturation or cutoff 
extreme, more “tube-warmth” effect can be produced by this device.    This is the same device as the 
European ECC83.

B.    Triode (12AT7)    - This amplifier configuration utilizes the same type of RC coupled pre-
amplifier circuit described above, only using a 12AT7 high-mu dual triode.    The primary difference is 
that the 12AT7 was designed primarily for RF mixing applications.    As a result, it has a large degree of 
non-linearity throughout its entire dynamic operating range, including the middle.    As a result, you will 
be able to obtain a higher level of even harmonic distortion (the pleasing distortion) in which to add 
back into the signal path of the VVA.    This is the same device as the European ECC81.

C.    Triode (12AU7)    - This amplifier configuration is simulating the driver / phase inverter 
stage of a push-pull power amplifier.    It utilizes the 12AU7 medium-mu dual triode, and, like the 
previously described circuits, is biased class A and is RC coupled.    This device also has a significant 
non-linearity in the middle of its dynamic operating curve. (In power amplifiers, some of this non-
linearity is removed via the use of negative feedback, and decreasing the mix control level on the VVA 
simulates this phenomenon). 

D. Pentode (6EJ7)    - This single stage, high-gain microphone amplifier configuration utilizes a 
sharp-cutoff pentode.    It can produce a very pleasant “tube-warmth” effect when the operating point is
properly set.    This device is the same as the European EF183.

E. 2 Stage Class A    - This is an 8 Watt class A power amplifier, consisting of a 12AU7 medium-
mu triode driving a single 6L6GC beam power pentode audio output valve.    Its effects are distinctive 
due to the non-linearities of the triode interacting with those of the pentode, with both devices operating
in class A mode.    The 6L6GC is similar in performance to the industrial 5881, and also the European 
KT-66.

F.    2 Stage Class AB    - This is a 25 Watt class AB1 power amplifier, consisting of a 12AU7 
phase inverter / driver, pushing a pair of 6L6GC beam power pentodes.    Because the circuit is push 
pull, the output devices produce a more symmetrical and reduced even-order distortion characteristic 
distribution.    The operating point is fixed at the factory, and can not be adjusted for this amplifier 
configuration.

G. 2A3 Push-Pull    -    The 2A3 is what some people refer to as a “retro – triode.”    It was 
invented in the 1930’s, had a directly heated cathode, and produced a high power output at its time of 
development. It was often found used in theatrical applications and public address systems. The 
“Push-Pull 2A3” VVA setting uses the 2A3 triode implemented in a “push-pull” class AB1 power 
amplifier circuit designed to produce 15 Watts of output power.    This configuration exhibits a more 
linear output transfer characteristic compared to its Pentode push-pull counterpart. We have included 
the 2A3 tube in this particular configuration in the Diamondcut VVA because a musician friend of ours 
(Les Paul) recommended that we do so because of its unique characteristics.    He explained to us that 
he used a push-pull pair of these devices as the power amplifier to “cut” all of the records that he 
released from his own home studios.    The reason that he used these was the extremely clean sound 
that they produced.    The particular devices that we used to create the 2A3 VVA models were of the 
“dual – plate” variety.    The devices used were taken from new (unused) but old stock and were 
manufactured for the military by RCA Victor in 1953.



H. 2A3 Single-Ended -    This is a single ended class A power amplifier implemented using the 
2A3 power triode.    It exhibits reasonably good linearity and about 4 watts of audio in a “single-ended” 
class A configuration.    It’s dominant distortion products are “evens.” This is the only power triode in 
the Diamondcut VVA suite of tubes.

I.    Exciter    - This check-box enables the Harmonic Exciter feature of the DC-Art VVA. For 
more details on its performance, please refer to the Harmonic Exciter description under the Operating 
Point Control description.

11. Just like the other DC-Art filters and Effects, the VVA is equipped with a set of descriptive presets.   
This is always a good place to start from when using the VVA.    After you have found the preset that 
most closely resembles the sound you are looking to achieve, you can go back and fine-tune the 
control more precisely.    After you have found a group of settings that you would like to keep, use the 
“Save Settings” feature to give it a name so that you can recall it in the future.



Dynamics Processor
The DC-Art Dynamics Processor provides you with three functions related to the control of the 
dynamic range of an audio signal.    The functions are as follows:

Expander
This system is a downward expander.    When the signal is below the threshold setting, the dynamic 
range of the signal is increased depending on the value of the ratio setting.    In other words, the 
incremental attenuation of the wavefile signal is proportional to the ratio setting below the threshold 
value.    The higher the value of this ratio, the greater the degree of downward expansion.    Signals 
above the threshold value are passed through the system with no processing applied.    When the ratio 
control is set to its maximum value (control set all the way up), the system will behave like a Noise 
Gate.    When more modest values of the ratio control are used, the system can produce some 
improvement in dynamic range and signal to noise ratio on a wavefile.    The Expander has the 
following controls available:

1. Expander/Gate Checkbox: On/Off
Checking this box will enable or disable the expander/gate function of the Dynamics Processor.

2. Threshold:    -50 dB (control down) to 0.00 dB (control up)
This control establishes the signal level below which the expander performs its process on the 
wavefile signal.

3. Ratio: 1.00 (control down) to 29.99 (control up)
This control determines the degree of downward expansion applied to the wavefile for signals which 
are below the threshold value setting.    The higher the number which is chosen, the larger will be the
effect.

4. Expander bargraph: Horizontal meter indicating from 0 to            –40 dB.
This meter indicates the actual value of downward compression in dB which is being applied to the 
wavefile signal.

5. Attack: 199.9 mSec to 0.1 mSec
This control is used for both the expander and the compressor functions of the dynamics processor.  
It determines the time constant associated with the onset (delay) of any of the dynamic processor 
effects.    

6. Release:    4.0 Seconds to 0.05 Seconds
This control is also used for both the expander and the compressor function of the dynamics 
processor.    Its setting determines the delay time associated with the decay of the particular process
chosen.

7. ALC:    This places the system into Automatic Level Control mode of operation.    It is useful for 
leveling the loudness of audio signals by minimizing their dynamic range.    When in this mode, 
signals below the threshold line are upwardly expanded while signals above the threshold line are 
downwardly compressed.

Compressor

This system is an upward compressor.    When a wavefile signal is above the threshold setting, the 
dynamic range of the signal is decreased, the degree of which depends on the value of the ratio 
setting.    In other words, the incremental attenuation of the signal is proportional to the ratio setting 
when it is above the threshold value.    The higher the value of this ratio, the greater the degree of 
compression.      Signals below the threshold value are passed through the system with no processing 
applied.    When the ratio control is set to its maximum value (control set all the way up), the system will
produce the largest degree of compression. The Expander has the following controls available:



1. Threshold: -50 dB (control down) to 0.00 dB (control up)
This control is similar to the threshold control for the expander, but establishes the signal level above
which the compressor performs its process on the wavefile signal.

2. Ratio: 1.00 (control down) to 29.99 (control up)
This control determines the degree of compression, which is applied to the wavefile for signals 
which are below the threshold value setting.    The higher the number which is chosen, the larger will
be the effect.

3. Expander bar-graph: Horizontal meter indicating from 
0 to    +40 dB.

This meter indicates the actual value of compression in dB which is being applied to the wavefile 
signal.

4. Attack: 199.9 mSec to 0.1 mSec
This control is used for both the expander and the compressor functions of the dynamics processor.    It
determines the time constant associated with the onset (delay) of any of the dynamic processor effects.
5. Release:    4.0 Seconds to 0.05 Seconds
This control is also used for both the expander and the compressor function of the dynamics processor.
Its setting determines the delay time associated with the decay of the particular process chosen.

De-Esser

A de-esser is a form of compressor, which is only reactive to the frequencies associated with the 
pronunciation of the letter “s” (ess.)    It is necessary to perform this function on overmodulated signals 
in the “s”    frequency range.    This occurs due to poor mic technique, a poor initial mix, improper mike 
channel equalization, or insufficient “padding” of the mic input circuit during the recording session. 
When the frequencies in the sensitive band are detected and are above the threshold setting, 
compression will be applied to the degree determined by the compressor ratio control.    The attack and
release controls are not active when the compressor is in “De-esser” mode.    To place the compressor 
in the De-esser mode, click on the box by the same name.

The de-esser can also be used to reduce the high frequency intermodulation distortion which may be 
found on some audio sources.
                              -                    -                    -                  -                    -                  -                -
One global control is provided in addition to all of those mentioned above.    The output gain allows you 
to correct for overall effects (attenuation or gain) which any of the dynamic processor functions may 
have on the overall output signal level.    Presets have also been provided to get you started with 
reasonable setup parameters for the various dynamic processor functions.

Automatic Level Control (ALC or AGC)

The Dynamics Processor includes an automatic level control feature (ALC).    Sometimes, these 
algorithms or systems are referred to as automatic gain controls or AGC’s.    This feature provides 
upward expansion of signals below the threshold line and downward compression of signals above the 
same threshold.    This feature is useful in forensics applications where there is a large variation in 
signal levels between several different parties which may be communicating with one another.    It is 
also useful for the broadcast of Live sporting events (if you have the LIVE version of the product) in 
which the crowd reaction is of interest when the announcer is not speaking.    This feature is activated 
by simply clicking on the ALC box in the Dynamics Processor.    The threshold, attack, and release 
controls are still active when this function in invoked.    





Automatic Level Control (ALC or AGC)

The Dynamics Processor includes an automatic level control feature (ALC).    Sometimes, these 
algorithms or systems are referred to as automatic gain controls or AGC’s.    This feature provides 
upward expansion of signals below the threshold line and downward compression of signals above the 
same threshold.    This feature is useful in forensics applications where there is a large variation in 
signal levels between several different parties which may be communicating with one another.    It is 
also useful for the broadcast of Live sporting events (if you have the LIVE version of the product) in 
which the crowd reaction is of interest when the announcer is not speaking.    This feature is activated 
by simply clicking on the ALC box in the Dynamics Processor.    The threshold, attack, and release 
controls are still active when this function in invoked.    



Reverse File

The Reverse File command is found under the effect menu.    It creates a file in which the last signal is 
played first, and the first signal is played last.    It is a useful enhancement to the impulse noise filter.    
Some records which are particularly stubborn should be de-clicked in the standard manner first, and 
then reversed with this feature.    Next, after reversing and making the destination the source, the 
impulse filter should be re-run using the same parameters as originally.    In some instances, more 
clicks and pops will be removed from the file in reverse.    Lastly, you will have to re-reverse the file 
when you have completed this process.    
The reverse file feature is also entertaining for those of us who used to play our Beatles and Led 
Zeppelin records backwards to try to hear such stuff like “turn me on dead man” and “Paul is dead.”    
Do not forget to try to play Stairway to Heaven backwards!    Using the DC-Art reverse file feature, you 
can do so without spinning your records backwards, ruining the records and stylus.    (What a great 
ploy by the record companies to force you to destroy your records.)



Channel Blender
DC-Art provides a unique effect called the Channel Blender.    It serves four purposes.
1. In the early days of stereo, channel separation was the rage.    Sound engineers often literally 
segregated the recording artists into separate recording studios in order to maximize the channel 
separation.    This later became know as the “Ping-Pong” effect.    In other words, with stereo 
separation, if a little was good, and more was better, than too much was thought to be just enough.    
The Channel Blender can be used to reduce the extreme stereo separation found on some of these 
early stereophonic recordings, restoring them to a more natural sound.
2. Rumble on Vinyl recordings is dominated by the vertical displacement component of the master 
recording and playback stylus.    Since bass is acoustically non-directional below about a hundred 
Hertz, this rumble can be reduced by summing the signals and then adding them back into the main 
stereophonic channels below a certain crossover frequency.    The Blend to Mono feature performs this 
function when it and the “below”function are checked. This can add clarity and improved bass 
definition to vinyl recordings, which sound muddy due to excessive rumble.    And keep in mind that 
rumble is not just a product of the turntable from which you are playing a record, but also involves the 
system which mastered it in the first place.    So, even though you may have a very expensive 
turntable, you will still encounter recordings which are laden with rumble. The recommended frequency
for this feature is around 125 Hertz with the “below” box checked.    But experiment to determine the 
best results for the material that you are dealing with. 
3. FM stereo multi-path distortion, when it occurs, is dominent in the last two octaves of the audio 
spectrum.    By placing the channel blender in Blend to Mono above the corner frequency setting, you 
can reduce this distortion with a tradeoff of channel seperation at the upper end of the audio spectrum. 
Try corner frequency settings starting at around 5 KHz with the “above” box checked. 
4. Lastly, ambience can be enhanced on a stereo recording by phase inverting one of the channels 
summing by the L-R rather than the L+R information back into the main signal path. This is 
accomplished by phase inverting one of the two channels.    

The Channel Blender has the following unique controls:
1. Left and Right Channel Blend controls: These two controls take the summed or differenced signal 
and adds it back into the respective left and / or right channels.    When these controls are set to 0, 
there is no blending effect.    At a setting of 100, the blending is maximized.
2. Two check boxes are located in the Left and Right blend control panels.    This produces a 180-
degree phase inversion of either of the channels before the summation takes place.    Therefore, you 
can blend in L+R (with the phase inversion boxes not checked) or you can blend in the L-R signal (with
ONE of the two Invert Phase boxes checked.)    The L-R signal contains the ambience information on 
most stereophonic recordings.    If both Invert Phase boxes are checked, the signal reverts back to 
L+R, so if ambience enhancement is desired, only check one box.      
3. Blend to Mono Checkbox: This checkbox sums the signal to monophonic above or below the 
indicated frequency. You can select a crossover frequency anywhere between 10 and 10,000 Hertz. 
        A. Above: This blends to mono all frequencies above the corner frequency setting. This is used to 
reduce multi-path distortion from FM broadcasts.
        B. Below: This blends to mono all frequencies below the corner frequency setting.    This is used to 
reduce rumble and muddy bass on vinyl stereophonic recordings. 
      



Punch and Crunch
Punch and Crunch is a four band dynamic expander (punch) and compressor (crunch).    It is useful for 
a number of applications such as the following:

1.    Adding dynamic range or “Punch” back into severely compressed radio broadcast or vinyl 
recordings.
2.    Adding “dial presence” or “Crunch” (compression) to radio broadcasts, without suffereing the 
“pumping” effect found in conventional wide-band dynamic compressors.
3.    Decreasing the dynamic range of classical music so that it can be more “listenable” in restaurant 
or automotive environments by applying the compressor function.
4.    Improving the signal-to-noise ratio and dynamic range of old 78 RPM recordings.
5.    Improving the intelligibility of forensics recordings.
6.    Special Effects creation.
7.    etc.

It works by breaking the audio spectrum into four separate bands.    Each band is independently 
expanded or compressed when its signal exceeds the graphical display of its particular threshold line.   
The degree to which the bands are expanded or compressed is modified by using the ratio control.    
The actual compression or expansion of any particular band is shown by horizontal bar graphs for each
band which are calibrated in dB.    The bands are broken into the following “buckets”:

Band 1: 0 to 125 Hz
Band 2: 125 to 900 Hz
Band 3: 900 to 4000 Hz
Band 4: 4000 to 20,000 Hz

The following controls are provided on Punch and Crunch:
1.    Graphical Display of the four bands.    Each band is represented on this graph and the incomming 
signal present on each band will modulate the vertical displacement of each band.    Theshold for each 
band can be dragged with the left mouse button to the desired position.    When the threshold is dragged
all the way to the top, that band will have no dynamic compression or expansion effect.    When a band is
dragged all the way to the bottom, it will have a maximum compression or expansion effect.
2. Graphical Display of the Expansion or Compression of each band.    This graph is horizontally 
modulated and located beneath each of the four bands.    It is calibrated in dB.    It will tell you the 
amount of compression or expansion being applied to its associated band.
3. Ratio:    This controls the degree of compression or expansion applied to the system.    When the 
system is operating in compression mode, you can choose up to 30:1 compression.    When the system 
is operating in expansion mode, you can choose up to 15:1 expansion.
4. Attack:    This determines the time constant associated with the onset of this effect and is calibrated in 
mSec.
5. Release: This determines the time constant associated with the decay time for this effect and is 
calibrated in Seconds.
6. Output Level:    This allows you to adjust the output level of the system.    Use this in association with 
the Overload indicator to minimize clipping distortion.
7. Mode:    This allows you to choose either Expansion (Punch) or Compression (Crunch) modes of 
operation.

 





File Menu
The File menu contains all of the commands related to managing wavefiles.

Open Source 
Close Source 
Open Destination 
Open Playlist 
Save Destination As 
Close Destination 
Delete File 
Make Destination The Source 
Exit 



Open Source
This command opens the desired Wavefile on which you will perform any or many of the DC-Art 
processes.    It displays a periodic sampling of the file's peak amplitude envelope vs. time in the source 
graphical workspace.    Please note that DC-Art only supports files in the .wav format at this time.



Close Source
This command closes a previously opened Source and Destination Wavefile.



Open Destination
This command allows you to define the name and desired storage location of the processed version of 
the Wavefile which you are about to create through the use of the various signal processing tools of the
DC-Art program.    The use of this command is optional since DC-Art creates temp files automatically.   



Open Playlist
This feature allows you to create a playlist of wavefiles for reproduction at a later time.    It allows a 
sequence of wavefiles to be transferred to an audio medium without having to manually cue up each 
wavefile.    For more information, please refer to the section of the users guide entitled “Playlist 
Feature.”



Save Destination As
Since DC-Art does not require the Destination workspace file name to be defined before your audio 
processing session, this command is used to define a Filename and directory location for your 
Destination file following the completion of an audio processing session, should you desire to save it.



Close Destination 
This command allows you to close a file that has just been processed from the source file.    The 
working destination file will have been stored on a temporary basis in a temp.wav file.    When you 
attempt to close the destination file, you will be prompted to indicate whether or not you want to save it.
If you do, then you will be prompted to define a path and a name.wav for your processed file to be 
saved in.



Delete File
This feature allows DC-Art to delete files from a Hard Drive. Multiple files may be selected by holding 
down the Shift or Ctrl Keys while selecting a file. Since .wav files tend to be huge, this command will be
used often.  DC-Art  will prompt you to be sure that you want to delete the selected file before doing 
so. Remember that every minute of stereo audio sampled at 44.1 KHz consumes 10.584 MBytes of 
disc space, which is useful to know when it comes time to clear up some disc space in order to get 
ready for your next sound restoration job. 



Make Destination the Source
This command takes the file that has just been processed, and makes it the source file in a new 
workspace window.    This is a useful feature, since most sound jobs require several passes utilizing 
several different signal-processing techniques to affect a complete audio restoration.    When using this 
command, the program will prompt you to name the file.    You can choose to do so, or leave it as a 
temporary wavefile. 
Note: Be aware that all Temp Files are deleted at the end of your DC-Art session.
          
                                                            



Exit
Res Ipse Loquitur
Note: Exiting will also clean up all temp files.    It will ask you if you want to save any un-saved files with
Temp names before you can exit. 



File Listings
The four most recently opened files are displayed at the bottom of the File Menu command listing.    
The most recently opened file is shown at the top of the listing and is labeled number 1. Up to three 
more files will be shown (provided that they had ever been opened in the past) below file number 1, 
and are labeled 2 through 4.    You can directly open any of these files by clicking the left mouse button 
on the one that you desire.    



Filter Applications

The following Sound Restoration jobs typically benefit from the application of the following DC-Art filter 
types.    

Sound 
Restoration Type  

Sound 
Defect

Filter Type                      

Early Acoustic 
Cylinders 

"Pops" Impulse Noise 

& "Crackle" Average or Median
Acoustical Discs "Distortion" Low Pass Filter

"Hiss" Dynamic Noise Filter
or Continuous Noise

"Rumble" Highpass or 
Continuous Noise 
Filter

"Thin" Graphic Equalizer
"Reverse 
Skip"

Cut

"Forward 
Skip"

Copy and Paste 
Insert

Skip / Miss-
tracking

Speed Change 
Filter / Fractional 
Speed Mastering.

LP's & 45 RPM 
Records

"Ticks" Impulse Noise

"Pops" Impulse Noise
"Distortion" Low Pass Filter
"Rumble" High Pass Filter
"Shrill" Graphic Equalizer
"Reverse 
Skip"

Cut

"Forward 
Skip"

Copy & Paste Insert

Noise 
between 
Cuts

Dynamics Processor 
– Expander / Gate

Magnetic Tape 
Recording

"Hiss" Dynamic Noise Filter
or Continuous Noise 
Filter

AM Radio or Short 
Wave Radio

"Static" Dynamic Noise Filter
or Continuous Noise 
Filter

AM Broadcast "Whistle" Notch Filter (Europe 
- 9 KHz)
(US - 10 KHz)



Live Recording "Feedback" Notch Filter
"Hum" Notch Filter
"Mic 'P' Pop" Highpass Filter
"Dead" Dynamic Noise Filter

(enhancement 
mode)

‘Digital 
Sound”

Virtual Valve 
Amplifier / Tube 
Warmth

Telephone 
Conversation

"Intelligibility" Bandpass Filter 

"Noisy" Continuous Noise 
Filter

"Muffled or 
Garbled"

Median Filter (large 
sample size)

Variation in 
loudness 
between 
parties (near
party/ far 
party gain 
compensatio
n)

Dynamics 
processor / 
Compressor

“Intelligibility
”

Brick Wall Bandpass 
Filter or Adaptive 
Filter

Surveillance 
Recording

Cancellation 
of Radio / or 
TV using a 
reference 
track

File Conversions 
(Left – Right) or 
Adaptive Filter with 
reference channel 
input

“Whistles” Adaptive Filter with 
“Keep Residue” 
turned on

Optical Movie 
Sountrack

"Pops" Impulse Noise

"Crackle" Median
"Thuds" Highpass Filter

"Hollow" Graphic Equalizer

Any Sound Source Mike “P” 
Pop

Highpass Filter 
selectively applied

Clipping 
Distortion

Lowpass Filter 
selectively applied

De-Ess 
(excessive 
sibilance of 
the 
pronunciatio
n of the letter

Lowpass Filter 
selectively applied ot
Dynamic Processor/ 
De-esser



“S.”
Pitch 
incorrect

Change Speed Filter

Line 
Frequency 
“Buzz”

Harmonic Reject 
Filter

Too much 
dynamic 
range

Dynamic Processor

Top Octave 
missing

Virtual Valve 
Amplifier / Harmonic 
Exciter

Recording 
lacks 
“warmth”

Virtual Valve 
Amplifier

Too much 
Reverb

Continuous noise 
filter

Weak Vocal Gain Change 
selectively applied

Filter Menu
The following is a listing of DC-Art filters that are available through the Filter Menu or from the Filter 
toolbar.    This section of the DC-Art operating manual provides tutorials for each filter.    Procedures for
the use of each filter will be found in the “How do I” section of the manual.
Average Filter 
Bandpass Filter 
Continuous Noise Filter 
Dynamic Noise Filter 
File Conversions 
Graphic Equalizer 
High Pass Filter 
Harmonic Reject Filter     
Impulse Noise 
Low Pass Filter 
Median Filter 
Multifilter 
Notch Filter     
Paragraphic Equalizer 
Brick Wall Filter 
Adaptive Filter 
 



Filters Overview

The filters are the commands that are at the heart of the DC-Art program.    This is the group of 
commands that you will be using to perform the audio restoration of a wave file.    Although DC-Art 
provides you with a large variety of filter types, often only one or two are required to accomplish an 
adequate sound restoration job on a particular Wavefile. The most important (and also the most 
complex) filters are the Impulse Filter and the Continuous Noise filter.      Which filter is required 
depends on the type of audio degradation you are attempting to correct.    A table showing which filter 
should be used to correct a particular sound restoration problem can be found in the section entitled 
Filter Applications.    A brief synopsis (tutorial) for each filter's function is listed at the bottom of this 
section of the Helpfile.    Click on the item which you are interested in.    Please do not panic by all of 
this technical gobbledygook; it is here for the technocrat, but it is not necessary to understand in order 
to use the program.    The functionality of all of these filters will be reduced to practice with some very 
simple and practical examples which makes the use of these filters much more intuitive found in 
another portion of the Operating Manual entitled    “Restoring an Olde 78 RPM Recording." 

The use of the DC-Art filters is a serial process.    You will choose one filter, and then run it creating a 
Destination File.    If you desire further processing with another filter, you will make the Destination file 
into a Source file and repeat the process for each filter which you want to run.    Some sound 
restoration jobs will require only the application of one filter, and will therefore be completed in one 
pass.    However, some sound restoration jobs may require the application of as many as 3 or 4 filters, 
depending on the condition of the raw source material.

Each filter will have several parameters which can be adjusted or characteristics which can be 
selected.    Numeric values can be adjusted utilizing the left mouse button in conjunction with the slider 
control provided by DC-Art.    The values are varied by pointing the mouse to the slider, and then 
holding down the left mouse button as you drag the slider up or down.    The parametric value is 
indicated in the numeric display window at the top of each slider control. Direct numeric entry of a 
value is possible if you desire to achieve a finer degree of resolution on a particular parameter 
compared to that which is obtainable with the slider control.    This is accomplished by using the mouse 
to place the cursor on the number you desire to edit.    Click on the left mouse button.    Then, use the 
keyboard to enter the desired value, remembering to delete the previous value.    When you are 
running a filter in “Preview Mode” the slider controls will be “live.”    In other words, you will be able to 
hear the effect of any changes that you make to a slider control setting almost immediately.    

Most of the parameter settings for any of these filters will vary considerably depending on the content 
of your particular Wavefile and your own personal taste.    Therefore, it is very difficult for DC-Art to 
provide a deterministic set of values to use for different audio sources which will be adequate for 
solving a particular sound restoration problem.    You will have to experiment to determine the values 
most to your own particular liking.    However, we have in some cases, provided suggested settings to 
start with for some of the examples in the DC-Art Helpfile.    These settings assume that the Wavefile 
which you are working with was sampled at 44.1 KHz.    If you are using Wavefiles recorded at a 
different sampling rate, the provided values will not necessarily be effective. 
The maximum bandwidth of your processing system will be determined by our chosen sampling rate, 
and is dictated by sampling theorem.    The "top-end" performance of some filters will, therefore, also 
be limited by your chosen sample rate.    For example, if you choose to sample at 22.05 KHz, the 
maximum system bandwidth will be around 10 KHz.    As a result, the 16 KHz graphic equalizer control 
will do nothing to the signal.    The same will apply for any filter set to any value higher than 10 KHz.    
The restriction becomes even greater when you sample at 11.025 KHz.    The maximum bandwidth will 
become only around 5 KHz, and filters set to any value higher than this will not be effective. 
    
The processing time requirement for any of these filters will be extremely variable and will depend on 
the following variables:



          
1. The clock speed of your computer.
2. The sample rate for your Wavefile.    96.0 KHz stereo / 24 bit will require the most time and 11.025 

KHz monopnonic / 8 bit will require the least amount of time to process.
3. The parameters which you choose for any particular filter.    For example, choosing a 6 dB / Octave 

slope will take less time than what will be required if you choose 12 dB / Octave or (even more 
demanding) 18 dB / Octave.

4. Non-Linear filters such as the Impulse Noise filter and the Continuous Noise Filter require more time
with poorer source audio material.    The processing time for these depends on the number of 
"events" which are measured by the algorithm, and must be enacted upon by DC-Art to correct 
them.

5. The length of the Source Wavefile.
6. The type of Source Wavefile, either Stereo or Mono, with Stereo taking about twice as long to 

process compared to Mono.

Each of the filters is provided with the following controls which they share in common:

A. Preview Mode:    This feature allows you to be able to hear the effects of the parametric changes 
in real time    “Preview” is a button located on each filter’s dialog box.    To hear the filters settings, 
merely click on the Preview button.    

B. Run: This control button will start the processing effect of the filter.    In preview mode, you will hear
the results.    In non-preview mode, the results of the processing will be deposited in the 
Destination Workspace at the completion of the process.

C. Close: This button shuts down the particular filter.
D. Save Settings: This will save the parametric settings you have chosen for the filter under a name 

that you can define. This feature facilitates quick recall of commonly used filter settings.    This 
feature works in conjunction with the “Save As” and the “Delete” buttons. 

E. Bypass: This feature allows you to hear the effect of the filter immediately as compared to the 
original unfiltered wavefile.

F. Save and Delete Settings: This feature allows you to save commonly used parameters associated 
with any of the DC-Art filters or effects.    A scrollbar is provided for ease of selection.    You can 
switch live between presets while in preview mode.

G. Presets:    Each of the DC-Art filters and effects comes with a grouping of factory pre-sets. These 
presets are a useful starting point for the use of any of the algorithms.    Click on the one which 
best describes the process that you want to achieve.    Then fine “tweak” the controls for the most 
desirable results.

Important Note: 
For optimal speed, it is important to close all other running programs and turn off your screen saver 
whenever running any of the filter functions. Otherwise, these algorithms will run more slowly than they
should due to their mathematically intensive nature.    A description of the method for turning off your 
screen saver can be found in the section on “turning screen saver off .”



Average Filter Tutorial
This is another filter which has no analog equivalent.    Its audio performance sounds somewhat similar 
to that of a low pass filter, although it is somewhat more effective than a low pass filter in reducing not 
only "Hiss" but also "Crackle" from a sound source.    It is most effective on limited bandwidth sources 
such as old acoustic recordings made before 1925.    Its interface to the operator is similar to the 
Median Filter, with the difference being that instead of calculating the median value of a sample 
window to pass into the Destination workspace, the average value of a group of samples is passed 
through. You select the number of samples on which the average value is calculated with a slider 
control in its dialog box.    The greater the number of samples, the higher the degree of smoothing 
effect on the waveform. The higher the degree of smoothing, the greater the loss in the higher end of 
the frequency spectrum. This filter is most useful for improving the intelligibility of highly garbled voice 
communications recordings.

The following is a summary of the control parameters and the range of adjustment provided for the 
Average Filter:

A. Samples: 2 - 100

B. Preview Mode Button: On / Off (The slider control can be adjusted “live” when preview mode is 
on.)

For more information regarding the operation of the Average Filter, refer to the “How Do I” section of 
the Operating Manual. 



Bandpass Filter Tutorial
This is a digital simulation of a conventional analog bandpass filter having a Butterworth response. 
Bandpass filters are passive to frequencies within the bandpass region, but they attenuate frequencies 
above and below the two corner frequencies.    Bandpass filters have both an upper and a lower corner
frequency, and like the low pass and the high pass filter, the corner frequencies are defined as the 
frequencies at which the signals either above the upper corner or below the lower corner are 
attenuated by 3 dB.    Three slopes are provided for the Bandpass Filter, just like the Low Pass and 
the High Pass.    They are 6 dB / Octave, 12 dB / Octave, and 18 dB / Octave. This filter can be very 
useful for improving the intelligibility of audio recordings, especially speech by eliminating the 
unnecessary portion of the audio spectrum which is not used by speech frequencies to carry useful 
information to the listener.
Note: The higher order (12 and 18 dB / Octave) bandpass filters are of the Butterworth type.
Special effects can be produced with the bandpass filter.    These special effects can be useful when 
producing movies or stage plays or shows and a particular sound producing device and its 
environment needs to be accurately reproduced through the "House" P. A. System.    Here are a few 
examples:

 
Simulati
on

Low 
Frequ
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Contr
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High 
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ency 
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Slop
e

1930's Vintage Table Top 
Radio:      

830 
Hz        

2000 
Hz    

18 
dB / 
Octa
ve

Modern cheap Table Top 
Radio:        

265 
Hz        

6100 
Hz      

18 
dB / 
Octa
ve

Loud "Walkman" personal    
stereo as heard by person 
nearby:      

3650 
Hz 

9800 
Hz 

18 
dB / 
Octa
ve

Modern Stereo System as 
heard from the next room: 

95 Hz  4100 
Hz        

12 
dB / 
Octa
ve 

1950's Vintage Juke Box:      30 Hz  2700 
Hz        

12 
dB / 
Octa
ve

AM Transistor Pocket    
Radio:      

1395 
Hz        

2110 
Hz        

18 
dB / 
Octa
ve    

Telephone Receiver sound 
from "off the hook":

2700 
Hz        

2895 
Hz        

18 
dB / 
Octa
ve 

Night Club Band as heard 
from Parking Lot:        

85 Hz  240    
Hz        

12 
dB / 



Octa
ve 

Olde Acoustic Phonograph:  870 
Hz      

2390 
Hz        

18 
dB / 
Octa
ve 

Public Address System at 
Outdoor Event:    

300 
Hz

3000 
Hz

12 
dB / 
Octa
ve

Modern High End Audio    
System:

15 Hz 19,999
Hz    

6 dB
/ 
Octa
ve

Bandpass Filter Response 
Limits:

5 Hz 19,999
Hz 

You can create your own simulations of sound devices and acoustic environments through 
experimentation with the bandpass filter parameters.    Using the above simulations, in conjuction with 
the DC-Art reverb, can further enhance various accoustica environments.    Once you discover the 
appropriate values, write them down for future reference.    
The Bandpass filter can also be used as a tool to determine if any useful audio information exists in a 
particular portion of the audio spectrum; it becomes sort of an audible wave analyzer when used in this
manner.    For more information on this mode of operation, refer to the “Using DC-Art as an Audio 
Waveform Analyzer” portion of the “How Do I” section of this manual.
The following is a summary of the control parameters and range of adjustment provided for the 
Bandpass Filter:
A. Low Frequency: 5 - 19,999 Hz.
B. High Frequency: 5 - 19,999 Hz.
C. Filter Slope: 6, 12, 18 dB / Octave.
D. Preview Mode Button: On / Off (The slider controls can be adjusted “live” when preview mode is 

on.)

Note:  The frequency range of adjustment up to 19,999 Hz is only effective when utilizing a 44.1 KHz 
sampling rate.    At a 22.05 KHz sampling rate, the maximum effective frequency setting will be 10 KHz,
and at an 11.025 KHz sampling rate, this value will drop to 5 KHz.
For more information regarding the operation of the band-pass filter, refer to the Band Pass Filter 
Operating Procedure section of the “How Do I” section of this manual.



Continuous Noise Filter Tutorial
This is one of two different types of non-linear filters that can be used to reduce noise from a signal 
source.    Like the Dynamic Noise Filter, it is useful for reducing "Hiss" from a recording or from a noisy 
FM radio transmission.    However, unlike the Dynamic Noise Filter, it will also reduce lower frequency 
noise.    When adjusted carefully, it can almost completely eliminate all residual noise from a recording. 
However, when compared to the Dynamic Noise Filter, this filter is a bit trickier to adjust so as to avoid 
the introduction of digital noise artifacts into the Destination Wavefile.    It also can have some 
detrimental effects on the "presence" and the musical transient content of a Wavefile when not properly
adjusted.      
This filter takes a sampling of your file and converts it into the frequency domain utilizing a Fast Fourier
transform.    Next it marches along to the next time interval and performs another Fourier transform.    It 
keeps repeating this process until the entire wavefile is converted into samples which are no longer 
representing the time domain, but strictly represented in the frequency domain, with the appropriate 
voltage, phase and frequency co-efficient for each window contained in memory.    The entire audio 
spectrum is divided in 1000 bands by a 2000 point fast Fourier transform (FFT) algorithm. When a 
signal in a particular band exceeds a threshold which you can define graphically, then that particular 
band is allowed to pass from the input of the algorithm to the output of the algorithm.    Lastly, the entire
file is then re-converted back into the time domain via an inverse fast Fourier transform.    So effectively
the only time during which bandwidth is provided at any of the 1000 frequency buckets is when there is
a useful signal present in that particular bucket.    Otherwise, the various frequency bands are 
substantially attenuated.

The following is a summary of the control parameters functionality and range of adjustment provided 
for the Continuous Noise Filter:

Attack Time
This is the time required for any of the filters to "open up" on the leading edge of a signal which 
exceeds the threshold line on the spectral graph.    This represents the time constant normalized value 
at 1 KHz. The time constant for filter frequencies operating above 1 KHz will be shorter than the 
setting, and the time constant for filter frequencies operating below 1 KHz will be longer. 
(The Attack time constant value is weighted with a -1 slope across the audio spectrum.)    A good value 
to start with for the Attack Time parameter is around 25 Milliseconds. The total range of adjustment for 
Attack time is 10 to 200 milliseconds.

Release Time
This is the time allowed for any of the filters to "close down" or "decay" following a signal which falls 
below the threshold line on the spectral graph.    All remaining characteristics of the Release time 
Constant are the same in nature as the Attack time Constant. A good value to start with for the Release
Time parameter is around 50 to 100 Milliseconds.    If there is too much filter "breathing", lengthen this 
time until you are satisfied. The total range of adjustment for Release time is 10 to 500 Milliseconds.

Attenuation
This control sets the degree of attenuation for signals which are present and below the threshold line.    
The greater the Attenuation, the greater the noise reduction.    However, the greater the noise 
reduction, the greater the loss of the sense of "Ambiance".    So you must make a careful judgment as 
the correct tradeoff between noise reduction and ambiance for the material you are dealing with.    A 
good value for the Attenuation parameter is around 10 dB to start with.    If there is too much lose in 
signal ambiance, decrease this value.    If you desire more noise reduction, increase this value.    If you 
increase the attenuation too much, you will begin to introduce some digital aliasing artifacts into the 
Destination Wavefile.    The total range of adjustment for Attenuation is 0 to 100 dB.



Graphical Threshold Line
This feature controls the threshold value above which a signal at a particular frequency must exceed 
before it is passed through to the output of the algorithm without attenuation. It works in conjunction 
with the “sample noise” button.      Although the DC-Art continuous noise filter has 1000 discrete 
frequency bands, it would be inconvenient to have to set each of them.    DC-Art provides 10 inflection 
points (shown as blue dots connected by blue lines on the graph of amplitude vs. frequency) which can
be moved along both the frequency and the amplitude axis.  DC-Art will place these inflection points 
automatically at approximately 10 dB above the noise floor after you perform the "sample noise" 
function.    Try these settings first to find out if the results are acceptable.    Thereafter, if there seems to 
be some noise which needs more attenuation at a particular frequency, adjust the threshold upwards 
utilizing the left mouse button at the frequency of interest until you are satisfied with the results.    The 
graphical threshold line is adjustable “live” when preview mode is enabled.

Threshold Control Grouping
a) Up & Down “Shift Threshold” Control -    This feature allows you to globally shift the entire 

threshold line up or down independent of frequency.    The feature consists of an up and down arrow 
box. It is operated via the left mouse button. The amplitude resolution of the control is 4 dB / click. 
After clicking on either of the arrows, you will see the entire threshold line shift in the direction of the 
chosen arrow. 

b) “Reset” Control - This feature will restore all of the threshold line inflection points to their original 
default settings. 

Keep Residue Function
When enabled, the “Keep Residue” function will allow you to “preview” (hear) or process to the 
Destination Workspace the algebraic difference between the Source File and the Filters Output.    In 
essence, you will be listening to the noise which would have been removed from the Source File had 
this function not been enabled.    It is sometimes useful via this function to be able to hear just how much
of the real audio signal along with the noise components which you are removing from the source signal.
However, it is only fair to warn the user not to make final adjustments using this feature, as that 
technique can be quite deceptive.    It is always best to optimize your parametric settings for the best 
results while listening to the actual processed filter output signal (ie. “Keep Residue” function off).      

FFT Size 
This controls the size of the Fast Fourier Transform (FFT) that is used to perform the filtering. The size 
indicates the number of bands that the audio spectrum will be broken up into. Larger numbers of bands
will improve the frequency resolution of the filter resulting in more discrimination between signal and 
noise. The tradeoff (isn’t there always a tradeoff) is that the filter cannot track the audio level variations 
as quickly with larger FFT sizes thereby compromising transient response.    In some cases better 
overall results can be achieved using the filter twice with two different filter sizes.
 

Warning:  If the parameters for the Continuous Noise filter are set incorrectly, it has the propensity to 
produce extremely strange sounds (digital artifacts), some of them quite comical.    If you hear the 
"birdies", back down on the attenuation setting and / or some of the graph inflection points, and they 
should disappear. 

For more information regarding the operation of the Continuous Noise Filter, refer to the “How Do I” 
section of this manual.    





Dynamic Noise Filter Tutorial 
(Analog Noise Filter) 
This is a digital simulation of a dynamic analog filter.    It is useful for dynamically attenuating "Hiss" 
from old record recordings or from old magnetic tape recordings.    It performs better than a fixed low 
pass filter because it only attenuates high frequencies when there is no high frequency information 
present above the setting of its "threshold" adjustment. Sometimes this technique is referred to as 
"single-ended noise reduction". The dynamic noise filters lowpass corner frequency is frequency 
modulated by a rectified envelope signal which represents the amplitude of the signal content above a 
particular low-pass corner. So, normally, the bandwidth of this filter is limited until some high frequency 
content is measured by its high frequency detector.    When this occurs, the bandwidth of the filter is 
opened up to allow the frequency of interest to pass through.    When the signal diminishes again below
a threshold value, the filter closes back down to a smaller bandwidth.    The user has the ability to 
adjust a number of parameters with this filter, including noise threshold, filter frequency, attack time (the
time constant associated with the signal whose job it is to increase the low pass filter frequency 
corner), release time (the time constant associated with the signal whose job it is to decrease the low 
pass filter frequency corner after a high frequency event has ceased) gain    and    filter slope (either 6 
dB or 12 dB).    This filter should only be used on recordings which contain little or no impulse noise, or 
on recordings which have already been processed through the Impulse Noise filter first.    Additionally, 
this filter can be used to reverse some types of double-ended noise reduction schemes.    

The Dynamic Noise Filter provides the following slider controls:

A. Noise Threshold
The value of rectified and averaged high pass signal voltage above which the output    of the Dynamic 
Noise Filter starts to raise its corner frequency.    Moving the noise threshold slider control vertically, 
raises its value.    This control must be adjusted so that when there are no highs present in the source 
material, background "Hiss" is attenuated, but when "highs" (such as cymbal crashes or the 
pronunciation of the letter "S") the filter "opens up".

B. Filter Frequency
The 1st order high pass corner filter frequency which drives the Dynamic Noise Filter Detector / 
Rectifier / Attack & Release Time Constant circuitry.    For modern reel to reel tapes, this parameter will 
be operated generally up in the 4 to 6 KHz range.    For early 78's, it will be operated in the 1 to 3 KHz 
range.    The Filter Frequency parameter range is from 200 Hz to 19.99 KHz.        Experimentation will 
be required to determine the best settings. 
Note:  The frequency range of adjustment up to 19,999 Hz is only effective when utilizing a 44.1 KHz 
sampling rate.    At a 22.05 KHz sampling rate, the maximum effective frequency setting will be 10 KHz,
and at an 11.025 KHz sampling rate, this value will drop to 5 KHz.

 C. Attack Time
The Attack Time slider adjusts the time constant (in milliseconds) associated with the rising edge of a 
high pass signal envelope.    Fast music will require smaller values of attack time compared to slow 
music.    The range of adjustment for the Attack Time parameter is 1 to 300 milliseconds.

D. Release Time
The Release Time slider adjusts the time constant (in milliseconds) associated with the falling edge of 
a high pass signal envelope.    This parameter will also require smaller values for fast music compared 
to the requirements of slow music.    Also, the release time will almost always be set to a period of time 
greater than the Attack time for the algorithm to sound natural.    The range of adjustment for the 
Release Time parameter is 1 to 500 milliseconds.



E. Gain
Gain controls the amount of dynamic high pass filter signal which is summed back into the output of 
the filter.    This allows you to obtain upward or downward expansion of the high frequency portion of 
the audio spectrum.    The "neutral" setting for this would be 0 dB which represents no expansion or 
compression.    Setting this value greater than 0 dB will be produce a "Spectral Enhancer" function 
when the “Enhancer Mode” is checked.    Values of 0 dB and lower produce a Single Ended Noise 
Reduction function used to de-Hiss a sound source.    This control is calibrated in dB.

F. Enhancer Mode

This feature produces an upward expansion of all signals above the threshold line and above the 
variable high pass filter corner frequency.    It is a very useful effect for enhancing dull recordings 
without adding excess hiss as would occur by simply applying a graphic equalizer to the top end of the 
audio spectrum. 

Note: The controls can be adjusted “live” when the preview mode button is clicked.                  
 
For more information regarding the operation of the Dynamic Noise Filter, refer to the “How Do I” 
section of this manual.
      



File Conversions Tutorial
This is usually the first step that you will perform when restoring a mono recording.    This feature 
provides a number of file conversion options that can provide a certain degree of noise reduction in 
and of themselves. Gain adjustments can also be performed during the file conversion process.    A 
time offset between the two stereo channels can be added to achieve special effects. 

NOTE: The time offset should be left at 0 for all normal file conversion operations.

The following File Conversion options are available:
    
From Stereo to -
1. Mono (L + R): This option adds the Wavefile Left Channel Input to its Right Channel Input before 

feeding it into the Destination workspace.
2. Mono (Left Only) & Mono (Right Only): These options choose only one of the two Wavefile inputs 

to be used in the file conversion processing step.
3. Mono (L - R): This option subtracts the Right Wavefile signal from the Left signal before feeding it 

into the Destination workspace.
4. Stereo: This option maintains the Wavefile in stereo through the file conversion processing step.    It 

can be used to adjust the gains of the two signals if they are incorrect while maintaining their 
independence.

5. Stereo Reverse: This option will reverse the left and right channels during the Wavefile conversion 
processing step.    It can also be used to adjust the gains of the two signals at the same time, if they 
are incorrect. 

6. L=L+R    R=L-R:    This option provides monophonic mix to the left channel, and provides the 
ambient signal from a stereo recording to the right channel.

From Mono to -
1. Mono:    This option merely provides a clone of the original wavefile.
2. Stereo: This option converts a monophonic single track file into two single track monophonic files.    

Below is a more detailed tutorial on the various DC-Art File conversion options and their specific 
application:

A. Mono (L + R)
This is generally used to convert a lateral cut record (like a typical 78, or a monophonic LP) which is 
monophonic to start with, but which has been transferred to the hard drive with a stereo cartridge, and 
convert these two signals into one signal on which you will perform further processing.    The advantage
of this simple conversion is that some of the noise content of the record will cancel out during this 
process, in particular, low end rumble, and even some higher frequency surface noise.    This process 
alone can provide up to 6 dB of signal-to-noise improvement (depending on the condition of your 
source) compared to the use of only one of the lateral groove walls (i.e. using the left only or the right 
only signal.)
Important Note: It is advisable to set both gain controls to - 6 dB to avoid overloading of the 
Destination channel during this mixing process, unless your recording is extremely under-recorded to 
start with. Minus 6 dB is the default value for the two gain settings in the Mono (L + R) File Conversion 
feature.          

B. Mono (Left Only) & Mono (Right Only)
Sometimes, 78 rpm laterals are worn unevenly due to years of improper tracking of the tone arm which
played the particular record.    Therefore, it is sometimes useful to compare the Left Only groove wall 



with the Right Only groove wall to hear if that is the case.    If you hear a significant difference between
one of the two groove walls, you should then compare the quietest of the two with the Mono (L + R) 
signal for comparison.    Choose the quietest of the three possibilities for your Destination file.

C.    Mono (L - R)
This feature takes the algebraic difference between the left channel and the right channel audio signals
and feeds it into the destination file.    It has three applications:
 

1. If you have transferred vertical cut records such as cylinders or Edison Diamond Discs utilizing a 
stereophonic cartridge, and haven't previously extracted the vertical signal component from that 
signal, this feature will enable you to do so.    Just as you would have done with the laterals, it is 
useful to listen to the Left Only signal and compare it with the Right Only signal to make sure that 
no significant tracking damage has been done to the record over the years.    Choose the quietest of 
the two for subsequent comparison to the Mono (L - R) signal.    Generally you will find that the 
Mono (L - R) signal has the best signal- to-noise ratio for vertical (hill and dale) recordings.    Pathe 
(groove width modulated 78’s) recordings should also be converted to monophonic utilizing the 
Mono (L - R) feature. 

2. This feature can also be used to compensate for gain imbalances between the left channel and the 
right channel of the analog equipment used to make the transfers into your computer system.    
When listening to a lateral monophonic recording in Mono (L - R), you can adjust the gain control 
sliders until you hear a maximization of the noise and garble on the recording, and a minimization 
of the useful information content of the recording.    This will provide the best setting of the gain 
controls when you finally make the file transfer utilizing the Mono (A    + B) file conversion feature.     

3. It can be used to “cancel” a television or radio broadcast out of a surveillance recording.      The 
surveillance recording would have had to have been recorded in stereo, with the surveillance signal 
on one track and also with a “reference” track containing the broadcast.    This technique will not 
completely cancel out the source radio or television source, but will attenuate it somewhat. Use the 
gain controls and preview to obtain the most effective degree of cancellation.

D. Stereo
This algorithm preserves a truly stereophonic wave file in stereo through the sound editing and sound 
restoration process.    It allows you to adjust the channel levels to bring them more into balance if they 
are not balanced to begin with.

E.    Stereo Reverse
This algorithm transposes the left and right channels from the source file before it is transferred into the
destination file. This algorithm also allows you to, while reversing the channels, adjust the channel 
levels to bring them more into balance if they are not balanced to begin with.

F: Time Offset 

Note: The gain controls can be adjusted “live” when the preview mode button is clicked.



Time Offset Feature

The DC-Art file conversion routine includes a “Time Offset” feature.    It is located horizontally on the 
file conversion control panel.    For normal file conversion operations, this control MUST be set to 
zero.    The time-offset algorithm provides you with the ability to retard or advance the timing between 
two stereo tracks.    This will work with a stereo to stereo conversion or a mono to stereo conversion.    
The range of adjustment is + / - 20 milliseconds; when the control is set to its center (zero), the time 
offset between the two stereo channels will be zero milliseconds.

This feature has three applications:

1. Analog Magnetic tape recording azimuth correction:

          When analog magnetic tapes are recorded or reproduced, the gap of the respective head 
(recording or playback) should ideally be perfectly normal (perpendicular) to the direction of the tape 
movement.    If, in either of these two processes, the respective head gap is off-normal (off-azimuth,) 
two types of signal degradation will occur.    The first phenomenon results in the loss of the high-end of 
the audio spectrum frequency response. The second effect produces a phase shift of one channel with 
respect to another thereby “smearing” a stereophonic image.    If you are reproducing a 
monophonically recorded cassette tape via a stereophonic playback machine, the effect of azimuth 
mis-alignmemt on high frequency loss can be somewhat improved by compensating using the “Time 
Offset” feature (the same applies when a monophonic half-track reel-to-reel tape is reproduced on a 
quarter track machine.)    To compensate for the effect of azimuth mis-alignment, adjust the “Time 
Offset” control until the best high frequency response is heard with your stereo system placed in 
monophonic playback mode while previewing.    If you are dealing with stereophonic source materials, 
it is hard to determine the correct phasing by merely adjusting the “Time Offset” for the best image.    
But, if you place your stereo system in monophonic mode with a stereo tape source, and follow the 
same procedure just described (use the “Time Offset” feature to adjust for the optimal high frequency 
response), this will also correspond to proper left channel to right channel phasing, and will therefore 
produce the best stereo image.    Of course, you must place the system back in stereo mode after the 
file conversion has been completed in order to appreciate the results.

2.    Improving the Intelligibility of Forensics recordings:

          It has been shown that audio signals, which are very difficult to discern, can be made more 
intelligible when the brain is presented with the same signal twice with a short time interval in-between. 
The human brain processes the information that arrives at each ear independently by the left and right 
brain.    The information is then shared and compared between the left and right hemispheres. 
Comprehension of the information results from the interaction of both hemispheres communicating with
one another.    When a delay is injected between the information heard by the left ear and the right ear, 
the intelligibility factor is improved.    This phenomenon was discovered by one of the British 
intelligence agencies (MI-5) in the late 1950’s. The technique involves the use of stereophonic 
headphones (so that each ear is acoustically isolated from the other,) and an adjustable delay inserted 
between the two reproducers.    The DC-Art    “Time Offset” feature can be used for this application.    
First, use the standard techniques for cleaning up the forensics recording.    Then apply the 
monophonic signal to the file conversion algorithm using the “Time Offset” in preview mode with 
headsets to adjust for the best intelligibility.    This may improve your ability to transcribe conversations, 
which would otherwise be impossible to discern.    This technique does not work with loudspeaker 
reproduction.

3. Stereo Simulation



          The “Time Offset” feature is one of several methods provided by DC-Art which will produce a 
stereophonic effect.    Merely start with a monophonic file, and convert it to a stereophonic file with 
some value of “Time Offset” applied.    Adjust the “Time Offset” control to produce the spatial effect that
you desire while using preview.          



Graphic Equalizer Tutorial 

 
The DCart Graphical Equalizer is the digital equivalent to the analog Graphical Equalizer found in 
many sound systems.    It is found under the Filter Menu and is entitled "Equalizer."    It's primary 
advantage is that it can be applied to a Wavefile without having to resort to adding an analog step in 
your sound restoration process.    This results in decreased noise and distortion on your final product.    
The equalizer has ten bands containing the following center frequencies:
31 Hz, 62 Hz, 125 Hz, 250 Hz, 500 Hz, 1,000 Hz, 2,000 Hz, 4,000 Hz, 8,000 Hz, 16000 Hz
The amplification and attenuation range for each band is + / - 12 dB.    An additional feature is provided 
to allow a shelve function (this is a "pull out" in the frequency response curve, sometimes referred to as
the adding of a "zero" in order to form a pole-zero pair) below 31 Hz and above 16000 Hz.    A "Reset 
Levels" feature is provided.    Clicking on "Reset Levels" will return all of the Graphical Equalizer slider 
controls to their 0 dB position.    Since the graphic equalizer adds gain to your signal, a latching 
overload indicator is provided.    If, at any time during the processing of a file through the graphic 
equalizer, the output signal exceeds the dynamic range of the system, the indicator will turn red and 
latch until the filter is re-run.
    
Note 1:  The top equalizer band of 16,000 Hz is only effective when using a sample rate of 44.1 KHz; it
becomes ineffective at sampling rates of 22.05 KHz and 11.025 KHz.    The 8,000 Hz band will also be 
rendered ineffective when using a sampling rate of only 11.025 KHz.
Note 2: The graphic equalizer controls can be adjusted “live” when the preview mode button is 
clicked.
Note 3: Since the graphic equalizer can actually increase the gain of the system, it is possible to 
produce clipping which will result in unpleasant distortion products to appear in the Destination 
Workspace.    This usually occurs when excessively boosting the bass portion of the spectrum.    The 
overload indicator will change from green to red, and latch in that condition if there has been an 
overload. The latch will be reset, following a re-run of the algorithm, provided that the overload 
condition has been cleared. 
For more information regarding the operation of the Graphic Equalizer, refer to the “How Do I” section 
of this manual.



Highpass Filter Tutorial
This is a digital simulation of a conventional analog high pass filter having a Butterworth response.    
Frequencies below the highpass corner frequency are attenuated by this filter.    Just like the Bandpass 
and the Lowpass filter, this filter has three slopes available.    They are 6 db / Octave, 12 dB / Octave, 
and 18 dB / Octave. This filter is very useful for reducing the effects of turntable rumble, or microphone 
seismic effects from creating "muddiness" on an audio recording.    To reduce turntable rumble, start 
with a setting of 60 Hz and 18 dB / Octave, and then adjust the parameters until you are satisfied.    
This filter is also useful when selectively applied for reducing microphone "P" popping effects on the 
vocal track of multi-track recordings wherein an adequate wind screen had not been utilized in the 
session. Effective settings typically are 120 Hz with a slope of 18 dB / Octave (selectively applied to the
event). 
Note: The higher order (12 and 18 dB / Octave) highpass filters are of the Butterworth type.

The following is a summary of the control parameters and range of adjustment provided for the 
Highpass Filter:
A. Frequency:    5 - 19,999 Hz.
B. Slope:    6, 12, 18 dB / Octave
C. Preview Mode Button: On / Off (The slider controls can be adjusted “live” when preview mode 

button is activated.)
Note:  The frequency range of adjustment up to 19,999 Hz is only effective when utilizing a 44.1 KHz 
sampling rate.    At a 22.05 KHz sampling rate, the maximum effective frequency setting will be 10 KHz,
and at an 11.025 KHz sampling rate, this value will drop to 5 KHz.
For more information regarding the operation of the high-pass filter, refer to the “How Do I” section of 
this manual. 



Impulse Noise Filter Tutorial
This filter is a non-linear algorithm which is used to eliminate pops, ticks, clicks, and crackle from audio
recordings.    It is also useful for the elimination of "static" interference from AM or Short Wave radio 
broadcasts.      These signals generally look like impulses (although sometimes referred to as "spikes"), 
and therefore the name impulse filter.    The algorithm essentially monitors for fast events (high dv/dt's),
and when their value exceeds a threshold value, the algorithm blanks out the portion of the file wherein
the fast event occurred, and re-inserts a waveform which is an approximation of the signal which would
have occurred during the event.    The phase of the inserted signal is aligned to match the point in time 
in the signal so that there is no discontinuity, and therefore almost no artifact injected into the wavefile. 
The following is a summary of the control parameter functionality and range which can be adjusted on 
the Impulse Noise Filter:

A. Threshold
This is the voltage derivative signal level above which the program decides that an impulse noise event
has occurred.    It has a range of adjustment from 1 to 12,000 (in DAC counts).    A good starting point 
for the threshold value is 1/3rd of the full scale value of the envelope of your wavefile.    For example, if 
the wavefile is almost full scale in amplitude (+/- 32,000 counts) set the threshold at around 10,000.    
For 78 RPM records, start with a Threshold value of 1000, and adjust up or down depending on the 
results obtained.    Lower values of Threshold will produce a higher degree of de-clicking.    If it is set 
too low, however, you will produce distortion on your recording. If you do not want to start at 1000, use 
the 1/3rd of full scale rule for your initial setting. 
Note: Threshold should be set to its lowest value (slider down) for Vinyl LP applications.    Adjustments 
should be make using the Tracking adjustment for these applications.

 B. Size
This is the number of samples during which the "click" or "pop" event must remain to be defined as an 
impulse noise event.    It has a range of adjustment from 2 to 25 samples.    Short "clicks" require a 
smaller setting compared to longer "pops."    A good range of values to start with for Vinyl LP 
applications is in the 10 to 15 range.    A good range of values to use for non-Vinyl (like 78 RPM 
records) is between 3 to 7 samples.

C. Tracking
This is the value of rectified output voltage from a high pass filter which is used to modulate the 
threshold voltage of the filter.    When there is a lot of high frequency information present on the 
recording, like the crashing of cymbals, it is desirable to move the threshold higher in value so that the 
transients contained in such sounds are not mistaken to be impulse noise events.    Tracking has a 
range of adjustment from 1 to 100 (in relative units.)    Tracking is most useful on "high fidelity" 
recordings which contain a lot of "real" high frequency information such as loud dynamic cymbal 
crashes, or exaggerated sibilant sounds, which may be interpreted by the Impulse Filter as impulse 
transients.
Most 78's de-click best with the tracking turned all the way down (to a setting of 1).    For LP's, start with
a setting of around 25 to 30, and adjust the value upwards if distortion is heard on high frequency 
passages or sibilant sounds, until the distortion disappears.    However, if the tracking is set too high, 
adequate de-clicking may not be obtained.
Note: Tracking should be set to its lowest value (slider down) for non-Vinyl LP applications.    
Adjustments should be made using the Threshold adjustment in these applications.    If the threshold 
control is set too high, the Impulse filter will not completely de-click your recording.    If it is set too low, 
the filter will create distortion on your recording, especially on the higher registers of the audio scale. 

D. Preview Mode
When enabled, this allows you to hear quickly the results of your chosen settings.    If your computer is 



a slower model, the system may "stutter" when this is enabled, however, the feature can still be quite 
useful for finding the best settings, since the "stutter" will not appear on the final product.    The slider 
controls can be adjusted “live” when the preview mode is enabled.    Preview mode is invoked merely 
by clicking on the “Preview” button on the filter dialog box.

E. Vinyl LP Mode
When this is enabled, a different type of detector algorithm is utilized which is more optimized for the 
wider bandwidth and narrower clicks and pops encountered with Vinyl LP's.    Vinyl mode works most 
effectively on Wavefiles which are sampled at 44.1 KHz.    When this mode is turned off, the detector is 
more optimized for slower and wider impulse noise.    Unlike most of the other DC-Art controls, you can
not switch Vinyl LP mode on or off “live” when preview mode is invoked.    Use the following table for 
determining the correct mode for this selector based on the type of material you are working with:

Sound Source            
Vinyl LP Mode

-----------------------------
---

----------------------------
--

Vinyl LP (Stereo or 
Mono)        

"On"

45 RPM "On"

FM Impulse Noise "On"
FM Stereo Impulse 
Noise

"On"

Acoustical 78's "Off"

Electrical 78's "Off"
Cylinders "Off"
Hill and Dales "Off"
Movie Soundtrack 
"Pops"

"Off"

AM or Short-wave Static "Off"

Note:    When you run the Impulse Filter, a dialog box will appear which indicates the Clicks / Second 
and the Total Clicks Processed.    The Clicks / Second statistic is relative to the timing of your Wavefile, 
and not the time frame in which your computer is processing the data.    This feature is provided to help
you determine if you are "trashing" (creating distortion)    your Wavefile due to Thresholds or Tracking 
values which are set too low.    When the algorithm's parameters are set too aggressively, the Clicks / 
Second number will become extremely high, which could be an indication of impending distortion of 
your Wavefile (although it depends largely on the condition of your Source material). 

F.    Optimization Mode 
DC-Art provides you with two alternative replacement algorithms.    One choice is “Speed” and 
provides the fastest processing of your file, but will not necessarily put back the most accurate 
representation of the signal which should have been in the location of an impulse event in the first 
place.    The second is “Accuracy” which utilizes a high order modeling algorithm for the replacement 



waveform.    This choice will take your computer longer to process a file, but produces better sounding 
and more comprehensive results. 

G. Hind Quaternion Mode (HQ Mode)
DC-Art Millenium and Live versions have included an enhancement to the Impulse filter called HQ 
mode (a name related to this new method used in the click detector portion of the impulse filter).    This 
mode can be used with 78’s, vinyl, or any source containing impulsive type noise or clipping distortion. 
Its operation couples several related variables in this new detector algorithm together in a logical ratio-
metric relationship allowing you to vary them with one control.    The Size slider controls these new 
variables.    The other controls on the impulse filter still perform their previously defined functions.    In 
HQ mode, you will find that you have a much larger degree of control of the detector algorithm, 
especially through the use of the Size control.    Small fast rise time clicks will be detected optimally 
with small values of Size while larger and slower events will be best detected with larger settings.    The
advantage of this new mode is an improvement in the ability of the detector to reject musical transients 
while still maintaining good click sensitivity.

 

For more information regarding the operation of the Impulse Noise Filter, refer to the “How Do I” 
section of this manual.



Low Pass Filter Tutorial
This is a digital simulation of a conventional low pass filter.    It is created using an Infinite Impulse 
Response (IIR) algorithm having a Butterworth characteristic. Frequencies below the "corner 
frequency" are passed through to the output, and frequencies above the corner are attenuated. The 
degree to which higher frequencies are attenuated is determined by the slope (order) of the filter.    
Three slopes are provided.    They are 6dB / Octave, 12 dB / Octave, and 18 dB / Octave.    The higher 
the slope, the more attenuation will occur to frequencies above the corner frequency. The corner 
frequency is the frequency which you choose, and it is defined as the frequency at which the signal has
been attenuated by 3 dB.    This filter can be somewhat useful for reducing hiss in a recording, but care 
must be taken not to reduce the presence of a recording by eliminating too much of the high end 
musical content at the same time. When used selectively, this filter can also be used either to “De-Ess”
an overly sibilant vocal, or reduce harsh harmonic distortion products which may have resulted from 
occasional master recording overloading (clipping).
Note: The higher order (12 and 18 dB / Octave) lowpass filters are of the Butterworth type.

The following is a summary of the control parameters and range of adjustment provided for the Low 
Pass Filter:
A. Frequency: 5 - 19,999 Hz
B. Filter Slope: 6, 12, & 18 dB / Octave
C. Preview Mode Button: On / Off (The slider control can be adjusted “live” when preview mode is 

on.)
Note:  The frequency range of adjustment up to 19,999 Hz is only effective when utilizing a 44.1 KHz 
sampling rate.    At a 22.05 KHz sampling rate, the maximum effective frequency setting will be 10 KHz,
and at an 11.025 KHz sampling rate, this value will drop to 5 KHz.

For more information regarding the operation of the low-pass filter, refer to the “How Do I” section of 
this manual.
                                                                                                  



Median Filter Tutorial
The Median Filter can be used to substantially reduce "crackle" (small impulse noise) from a recording. 
There is no analog equivalent to the Median Filter.    This filter defines a window of samples, and for 
that window, determines which sample is the median value within the grouping (median meaning 
middle value). That value is the one which is passed along to the destination file, and then the window 
moves over 1 sample and re-evaluates the median, again passing the new median value to the 
destination file.    This filter is useful for improving the intelligibility of severely distorted signals and it is 
also useful for pulling signals out of a very poor signal-to-noise ratios situation (pulling signals out of 
the mud).    It is somewhat similar in sound performance to a high-order low pass filter.    (The median 
value of a string of sorted numbers is the one in the middle of the string.    In other words, if you have 
seven sorted numbers, the fourth number will be the median value).    The DC-Art Median Filter allows 
you to choose the number of samples over which the median value is determined by the algorithm.    
The range is from 3 to 20 samples.    The higher this value, the higher the attenuation of high frequency
signal and/or noise.    Also, the higher the setting, the longer the processing time which will be required 
for the filter.    The most useful settings will generally be found to be from 3 to 7 samples.    Outside of 
that range, you may hear a significant degradation of the top end of your recording, depending on its 
bandwidth.    Even at 7 samples, you will notice some "fuzziness" intermodulating with the upper end of
the spectrum on some recordings. So always start with 3 to 5 samples when using the Median filter, 
and choose the smallest value which produces an effective de-crackling result.    It is also important to 
note that the higher the number of samples chosen, the longer it will take your computer to calculate 
the Median values to process your Wavefile.    At some point, your system will likely process non "real-
time."    
The following is a summary of the control parameters and range of adjustment provided for the Median
Filter:
A. Samples: 3 - 20 
B. Preview Mode Button: On / Off    (The slider control can be adjusted “live” when preview mode is 

on.)
For more information regarding the operation of the Median Filter, refer to the “How Do I” section of 
this manual.
Note: De-Crackling will generally be best accomplished with a “Samples” setting around 3.    
Intelligibility improvement of extremely distorted or garbled voice recordings will generally be 
accomplished with “Samples” settings anywhere between 5 through 17.    You will have to experiment 
to determine the best settings for solving a particular problem.



Harmonic Reject Filter Tutorial
The Harmonic Reject filter, which is sometimes referred to as a “comb” or “multiple notch” filter is used
to attenuate periodic noises which contain harmonics.    It is capable of attenuating either the odd or 
even harmonics of the selected fundamental frequency.    This filter is very effective for attenuating a 
form of hum (line frequency related) noise which is rich in harmonics.    This type of noise is sometimes 
referred to as “Buzz.”    Noise, such as this can be introduced into an audio recording from sources 
such as light dimmers or switch mode computer power supplies.    “Buzz” can contain odd harmonics 
of the power line frequency, all the way through the entire audio spectrum.    A 60 Hertz square wave is,
by definition, the fundamental component of the waveform plus all the odd harmonics of that frequency 
up to infinity.      The many band rejects (tines) of the Harmonic Reject filter will attenuate all of the 
harmonics contained within the audio spectrum.    Should you encounter wide-band line frequency 
related noise which is asymetrical, it can produce some even harmonics.    An example of noise 
containing even harmonics would be that produced by an unsymetrical trapezoidal or square 
waveform.    The Harmonic Reject filter can be placed in a mode in which it will attenuate the “evens” 
rather than the “odds” if you should encounter such noise.    
The following is a summary of the control parameters and range of adjustment provided for the Notch 
Filter:
A. Frequency (Fundamental): 5 – 5,000 Hz
B. Attenuation: 0 to 100 dB
C. Filter Harmonics: 

1. Odd Only
2. Even Only

D. Maximum Harmonic Number: 1 to 500 
This filter incorporates the “Keep Residue” feature.    This allows you to hear or keep only the noise 
component of the original signal.    This feature is useful for “tuning” the filter to the maximum level of 
noise, so that when you actually run the filter with the “Keep Residue” feature turned off, the noise left 
behind will be minimized.    



Notch Filter Tutorial
This is a digital simulation of a second order notch filter.    It attenuates all frequencies near its center 
frequency setting.    The degree to which it attenuates frequencies adjacent to the center frequency is 
determined by the bandwidth setting.    This filter is useful for removing 50 or 60 Hz hum from a 
recording (or harmonics thereof).    It is also useful for decreasing any sound system acoustic feedback 
which may be found on some live recordings.    It can be used to attenuate the heterodyning "whistle" 
which is sometimes heard on AM broadcast radio reception.    Some audio restoration engineers also 
use this filter to remove some "Hiss" from recordings.    For this application, the filters center frequency 
is set somewhere in the 8 to 12 KHz range, with a bandwidth of 0.25 Octave or less.    Experimentation 
is the only way to determine its effectiveness in minimizing "Hiss" from your particular source material.  
Also, it is important to note that this method is not the most effective for "Hiss" removal.    Instead, 
consider using either the Continuous Noise filter or the Dynamic Noise filter. 

The following is a summary of the control parameters and range of adjustment provided for the Notch 
Filter:
A. Center Frequency: 5 - 19,999 Hz 
B. Bandwidth: 0.01 Octaves to 2.00 Octaves
C. Preview Mode Button: On / Off    (The slider controls can be adjusted “live” when preview mode is 

on.)
D. Slot Filter Mode (Narrow Bandpass Filter for Forensics applications)

Note:  The frequency range of adjustment up to 19,999 Hz is only effective when utilizing a 44.1 KHz 
sampling rate.    At a 22.05 KHz sampling rate, the maximum effective frequency setting will be 10 KHz,
and at an 11.025 KHz sampling rate, this value will drop to 5 KHz.

For more information regarding the operating procedure for the Notch Filter, refer to the “How Do I” 
section.



Paragraphic Equalizer Tutorial
The Paragraphic Equalizer is a unique form of a parametric equalizer.    It combines the graphical 
representation of its transfer function (frequency response curve) with the versatility of a parametric 
equalizer.    Additionally, it provides you with up to 10 bands of equalization.    It differs from the graphic 
equalizer in that three parameters are adjustable for each band:
1. Frequency: (Hertz    - 10 to 20 KHz_
2. Amplitude: (attenuation or gain - +/- 20 db)

    3. Octaves: (Q or bandwidth - 0.05 to 3.0)

The following additional controls and displays are provided:

1. Number of filters: (1 to 10)

2. Output Gain: (+ / - 20 dB)

3. Reset Levels: (Resets Paragraphic to zero dB and factory default frequencies)

4. Overload indicator: (Illuminates when full scale output {clipping} occurs.

The DC-Art Parametric Equalizer displays its frequency domain transfer characteristic graphically. 
Therefore, it is referred to as the DC-Art “Paragraphic” equalizer.    It can be modified using your 
mouse by dragging the inflection point dots, and modifying the bandwidth using the octave control. You
simply draw the shape of the response, which you desire, and the algorithm adjusts the parameters to 
match the response curve.    Each band is represented by a single square “dot” on the graph.    The 
“active” dot will be the larger one displayed.    That is the dot for which the parameters are being 
displayed numerically on the control panel.    You can use the mouse to drag any of the dots, which 
actually represents a frequency inflection point, wherever you wish.    If you want to sharpen or widen 
the response of any inflection point, use the octave control to achieve the desired curve for a 
highlighted dot.    It is often very useful to use the DC-Art spectrum analyzer, found under the View 
menu, in conjunction with the Paragraphic Equalizer.    You will then be able to see the exact effect that 
you are imposing on the wavefile signal.
Under the settings menu, you will find a number of useful audio restoration functions, including the 
RIAA and inverse RIAA curves.    Also, various inverse RIAA curves with a variety of turnover 
frequencies are available.    These features enables you to use a standard RIAA pre-amplifier to 
transfer acoustical and electrically recorded 78 RPM records to your hard drive, and re-compensate at 
another point in time, without having to purchase specialized hardware.
Note: As with all of the DC-Art filters, sample theorem dictates useful bandwidth for the algorithms.    
The paragraphic equalizer will only have useful bandwidth up to about 10 KHz with a 22.05 KHz 
sample rate, and about 5 KHz at 11.025 KHz. 



Speed Change Filter Tutorial
The Change Speed Filter is designed for use in several applications:

1. It can be used to correct the pitch of a recording.
2. It can be used for fractional speed mastering.    This feature is important in any of the following three 

instances: 
A. You have available a 45 RPM turntable but do not own a 78 or an 80 RPM turntable.    
B. You want to play 80 RPM records, but only have a 78.2 RPM turntable
C. Your turntable will play all speeds, but the record you are attempting to transfer is so warped that 

the stylus skips off the record due to the vertical undulations.
3. It can make speech transcription easier by slowing it down to the rate at which you can transcribe it.
4. It can be used to produce interesting special effects. 

The following is a summary of the control parameters and the range of adjustment provided for the 
Change Speed filter:

A. Starting Pitch Control: -50% to +100%
B. Ending Pitch Control:    -50% to +100%
C. Display Pitch Range (3 ranges): +/-1%
                                                                                                              +/-10%
                                                                                                              +100 / -50%
D. Shape (Pitch vs. Time): Straight Line (2 Green Cursors)
                                                                                      Curved Line    (4 Green Cursors)
E. Graphical linear or curvilinear Pitch inflection points (green square cursors on graph)

The Graph shows you how you have programmed the speed to change as a function of the selected 
wavefile time axis.    You can use the mouse to drag the two green cursors to establish the time 
relationship which you desire.    Often, a flat line is appropriate, however, sometimes the speed of the 
cutting lathe would slow down towards the end of the recording. The reason this occurred is that some 
of the early recording lathes used wind up mechanical motors with governors rather than electrical 
hysteresis synchronous motors.    To correct this defect, a pitch decrease (negative pitch slope) is 
necessary towards the end of the recording. When the curve shape is selected, two additional green 
cursors appear. The new green cursors can be moved both vertically and horizontally allowing you to 
create numerous curvilinear pitch vs. time relationships.    

Example: To correct the speed of a recording that was transferred at 78.2 RPM but is actually an 80 
RPM recording, increase the speed of the recording with the speed change filter by (80 / 78.2) = +1.02 
%    



Help Menu

The DC-Art program contains an extensive Help file.    The following types of information are available:
· DC-Art program Overview
· Tutorial Information on each filter

· Step by Step procedures for utilizing each filter and editing feature
· Audio Restoration process procedures
· Practical Hints on recording procedures
· Extensive Glossary with definitions, tables of values, and appendix information.
· Licensing Agreement, Warranty, and program History information

The DC-Art Helpfile is context sensitive. For more information on the use of this feature, refer to the 
“How Do I” section of this manual.
Important Note: Features which have not been implemented in this particular version of DC-Art but 
which may be provided in future releases of the program will be described in italics.



Marker Menu 
DC-Art provides you with movable red timing markers that can be placed within the Source and 
Destination workspaces. They are the Wavefile equivalents to bookmarks.    You will find them to be 
useful tools when utilizing such editing features as the Copy, Cut, Mute, etc. features of DC-Art.    The 
marker menu is also complimentary to the CD Prep menu. It is very useful when you need to take a 
very long Wavefile and Chop it up into smaller files manually for indexing onto a CD-R (recordable CD 
ROM). The following commands are provided under the Marker Menu, all of which are controlled by 
the left mouse button:

1. Add a Marker: This feature adds up to 100 markers to the desired Workspace.
2. Clear All Markers: This feature erases all existing markers.
3. Highlight Marked Area: This feature highlights in Yellow the area of a Wavefile located between two 

previously defined red markers.
Note: The right mouse button can also be used to implement the following two marker functions:

                 A. Add a Marker
                  B. Delete a Specific Marker
4. Drop a marker at the play cursor position. 

Adding Markers:
1. Using the left mouse button and the mouse drag process, highlight the approximate area of the 

Wavefile which you are interested in.
2. Click on the "Marker" menu.
3. Click on "Add Marker" and you will see a red vertical marker appear at the start of the highlighted 

section. 
4. To add a marker at a specific location in a file without affecting the highlighted area; Click with the 

left mouse button in the desired location. You will see a blinking play cursor appear at the location. 
Right click on the cursor and select “Add Marker” from the popup menu.

5. To Drop a marker at a specific location: Press the M key on the keyboard while a file is being played.
This will place a marker at the spot in the file that was playing when the key was pressed. 

Moving Markers:
1. To move a marker, point the mouse over the marker and you will see the cursor change to a double 

headed arrow, click down on the left mouse button and drag the marker to the desired location.

Deleting Markers:
1. To erase all markers, click on the "Marker" menu.    Next click on the "Clear Markers" feature.
2. To erase an individual marker, click on the marker with the right mouse button and select “Delete 

Marker” from the popup menu.

GOTO Next or GOTO Previous Marker:
1. Under the Marker menu, click on GOTO Next marker to advance the cursor to that position      on 

the display.    You can also use the keyboard accelerator “N” to accomplish this function.
2. Under the Marker menu, click on GOTO Previous Marker to retard the cursor to that position on the

display.    You can also use the keyboard accelerator “Shift N” to accomplish this function.



Multi-filter

DC-Art provides the capability of cascading up to10 filters together and running them as if they were a 
single filter.    The elements of the string of cascaded filters can all be unique, or repetitions of the same
filter or a combination thereof.    This allows you the flexibility to construct your own favorite sequence 
of filters, along with their presets, and be able to save the cascade along with all of the filter 
parameters under one single preset name. 
The filter combination thereby created can by previewed or run like any other single filter.    If you have 
version 4.0L (Live) you can also run all of the filters in the chain through a full duplex sound card, using
the computer as a digital signal processor.    For details on this mode of operation, please refer to the 
section on Live mode.
The best way to envision the Multi-filter is to merely view it as another DC-Art filter which can be 
customized and sequenced. To create a customized sequence of filters, merely click on the Multi-filter 
icon, and the multi-filter dialog box will pop up.    On the left, you will see the source input to the system.
On the right of the screen, you will see the output.    The input is that wavefile which is present in the 
source window, (or in the case of version 4.0L, it can be the sound card input signal) as is the case 
with any other filter.    The output of the filter can be previewed or run just like any other filter.    If you 
have the DC Art 4.0L version, it can be run in “Live” (feed-through) mode as well. 
The Multi-filter can be activated by either of two methods.    It can be found under the Edit Menu, or it 
can be found as an icon on the DC-Art toolbar.    The icon located just to the right of the Zoom-Out icon
is the Multi-filter.

To create your filter sequence, merely drag and drop the desired filters from the filter selection into the 
signal pathway in your prescribed order.      If you want to change the order of the filters in the cascaded
chain, merely click on the filter in the pathway, and drag it to a new location.    To get rid of a filter, 
simply drag it away from the signal pathway with the left mouse button releasing the button when the 
filter is away from the signal stream. 
To view the parameters of any given filters in the multi-filter, double click on the filter icon in the 
cascaded chain and the particular filter dialog box will pop-up.    Adjust the parameters to the values 
which you desire, and they shall be saved as part of the sequence of filters which you have just 
constructed.    As with all of the DC-Art filters, the parameters may be previewed while adjusting the 
parameters.    Be aware that when long chains of filters have been created, there will be a delay in time
before the controls react to your changes.    If you desire to delete a filter, drag the filter out of the chain
and release the mouse button.
After you have developed a chain which you find to be particularly effective for a certain type of task, 
you can save it’s settings under a descriptive name just like any other DC-Art filter for ease of recall 
later. 
It is important to note that improved audio performance will be achieved using the multi-filter as 
opposed to a sequence of wave file processing.    The reason is that there will not be the quantization 
error buildup since the multifilter will maintain the highest possible resolution for the signal throughout 
the process from the first filter to the last one in the sequence.    Single filing processing must always 
convert back to wavefile as the intermediate step between filter operations, producing a buildup of 
quantization errors.    



Live (Feed-through) mode

Live (feed-through) mode allows you to by-pass the hard disc recording process, making your 
computer into a feed-through digital signal processor.    Signals are fed into your sound card, processed
through the filter or filters chosen, and then fed back out of the output of the sound card for use "live.”   
This feature is only available on Version 4.0L.    
Live mode is intended for professional applications such as broadcasting, or surveillance work where a
signal needs to be processed in real-time without the intervening process of hard drive recording.
This feature requires a full-duplex sound card and a fast computer.    We recommend the fastest 
computer that you can afford, since the faster that your computer can perform the mathematical 
functions, the more filters which you can cascade in "Live" mode. System “stuttering” is an indication 
that you have exceeded your computers ability to keep up with the data processing in real-time.      
Also, latency (the time delay for processing) is reduced as the speed of your computer is increased.    
For professional applications, we recommend a 450 MHz Pentium 2 or higher for “Live” mode when 
used in conjunction with the DC-Art    multi-filter feature, although slower computers will run with 
increased latency and smaller numbers of cascaded filters. 
Live mode is accessed through the Multi-filter feature found under the Edit menu, or which can be 
accessed by the Multi-filter Icon.    To adjust the input parameters for your sound card, double click on 
the input icon (the turntable) and a dialog box will pop-up. The following input parameters are 
adjustable: 

· Mono or Stereo
· Sampling Rate (up to 48 KHz)
· Resolution (8 bit to 24 bit)
· Input level indicators are also provided

Adjust the parameters appropriately.    Keep in mind that stereo signals will consume about twice the 
computer resources compared to monophonic signals.    So, if you do not need stereo, do not use the 
Live mode in stereo, else you will be adding extra latency to the signal and reduce the number of filters
which can be run without stuttering.    
Drag and drop the filters of interest into the signal path.    Adjust their parameters by double clicking on 
each filter, producing its dialog box.    
To run the “Live” mode, merely click on the “Live Preview” button, and the signal will be processed 
through the filters in the signal path.    To adjust the output level, double click on the output device (the 
loudspeaker icon) and a dialog box will appear to facilitate this function.    You can also make waves in 
real time using the Live mode.    This feature is also contained in the output device dialog box.    
Note 1: When using “Live” mode, it is not advisable to connect the soundcard I/O in an effects loop on 
a mixing console.    Doing so can produce echo effects due to the latency of the computational process.
Instead, connect the soundcard directly in the signal pathway, which you desire to process.
Note 2: You can “Log to Disc” (to your hard drive) the output content of the signal path being used in 
Live mode.    This can be useful if it is necessary to create an archive recording of a surveillance or a 
broadcast session.    To perform this function, merely click on the “Log to Disk” toggle button on the 
Live screen.    Thereafter, whenever you click on the “Live” button whatever signal is being processed 
will be logged to the disk under the Filename indicated below the “Log to Disk” toggle button.    



Log to Disk in Live Mode
You can “Log to Disc” (to your hard drive) the output content of the signal path being used in Live mode.   
This can be useful if it is necessary to create an archive recording of a surveillance or a broadcast 
session.    To perform this function, merely click on the “Log to Disk” toggle button on the Live screen.    
Thereafter, whenever you click on the “Live” button, whatever signal is being processed will be logged to 
the disk under the Filename indicated below the “Log to Disk” toggle button.



Forensics Menu

Surveillance, two-way radio, and noisy telephone communications place special burdens on noise 
reduction software.    The “Live” version of DC-Art comes complete with a special set of filters aimed at
forensics applications which can be found under the Forensics Menu.    Besides being useful in 
forensics applications, these filters can also be used to clean-up live broadcasts of telephone call-ins 
on talk radio stations

A comprehensive discussion of the topic of forensics audio noise reduction is well beyond the scope of 
this manual.    There are one-week courses available on forensics audio for those who are interested.    
Contact our distributor or Diamond Cut Productions, Inc. for more details.    However, for the purposes 
of this manual, we shall keep things fairly simple. Noise encountered in forensics applications can be 
categorized into several basic groups.

1. Out of band noise
This type of noise is rejected with the brick-wall band-pass filter

2. In band repetitive noise at a level lower than the target signal
This type of noise is rejected with the brick-wall band-stop filter

3. In band random noise at a level lower than the target signal
 This type of noise is rejected by the standard DC Art continuous noise filter found under the filter 
menu.
4. In band repetitive noise at a level equal to the target signal

This type of noise can be attenuated by the adaptive filter set up for coherent mode of operation.
5. In band random noise at a level equal to the target signal

This type of noise can be reduced by using the adaptive filter set up for random mode of operation.

Four unique filters are provided under two sub-categories of the Forensics Menu to help attack the 
above-mentioned noise situations. All of these filters are based on Finite Impulse Response (FIR) 
algorithms.    The first filter is called the   “  brick-wall  ”   filter set   . Included are some filters found elsewhere
in the DC-Art toolbox, except these filters exhibit extremely sharp slopes outside of their pass-bands.    
Additionally, an adaptive filter is provided which uses a mathematical model of the time domain 
waveform in order to reject noises which are either coherent or random depending on its setting.    

Note -      It is important to note that these Forensics filters are not optimized for “high fidelity” but more 
for improving intelligibility of speech or the discernment of subtle sounds. 



Brick Wall Filters

The Brick Wall Filters include the following choices of filter shapes:

1. Low-pass:    Only allows signals below the corner frequency to be fed to its output.
2. High-pass: Only allows signals above its corner frequency to be passed to its output. 
3. Band-pass:    Allows only the signal at its chosen frequency and within its bandwidth limit setting to 
be passed    to its output.
4. Band-stop:    Rejects all signals at its chosen frequency and within its bandwidth limit setting.

Several controls are provided:

A. Frequency (Hertz)
B. Length (Samples) – The larger the value of this parameter, the greater the degree of rejection past 
the 
          filters corner frequency setting. 
C. Bandwidth* (Hertz)    Controlled by adjusting the upper and lower corner frequencies.

*Note – Only applies to the Band-pass and the Band-stop filter.



Adaptive Filter

The adaptive filter adjusts itself to remove a modeled signal representing the unwanted time domain 
waveform while preserving the target signal. It works best with a reference signal containing only the 
noise to be rejected. This can be obtained from a second surveilance track with its mike located near 
the noise source in the room such as a Juke box or a television set.      However, it can also use it’s 
own signal as a reference in conjunction with a time delay function.      Additionally, it provides a 
processed signal and keep residue mode of operation for rejecting different types of noises.    The 
following controls are included with the adaptive filter:

A. Convergence (Adaptation Speed)
B. Filter Length (Samples) – The larger that this number is set for the more signal inflection points can 
be modeled in the time domain signal in order to be rejected or maintained.
C. Reference Signal –

a. Right Channel
b. Left Channel
c. Time Delay

D. Time Delay (Samples) for use in time delay reference mode only 
E. Adapt / Freeze button
F. Keep Residue Mode – This feature eliminates whistles, continuous tones, heterodynes, squeals, 
feedback and other similar noises from forensics recordings.



Batch File Editor

The Batch file editor allows you to run a single filter on multiple files. The filter can be run over the 
entire file or a portion of it. 

This is useful for automating long operations on multiple files such as de-clicking, de-hissing or 
harmonic noise removal.    

To use the batch file editor, follow these steps:

1. Add the files that you wish to process to the file list using the Add files button1.
2. Select a filter to run from the filter menu. 
3. Select a preset for that filter. To preview the preset, double click on the filter list to bring up the filter

dialog.
4. Select the portion of the file to process. 
5. Save the Batch file for future use
6. Run the batch file.
7. After the process has completed, you will have each file in the batch list open on the screen. The 

destination file will contain the processed file, and the file name will be set to the base filename 
plus a number. For example Testfile.wave would become Testfile1.wav.

8. If you desire a different path for the destination wavefile, you can define it to be whatever you 
prefer.



View Menu
The View menu allows you to access commands which effect the manner in which files, controls, and 
parametric displays are presented to the DC-Art user. To activate a particular feature, click on it with 
the left mouse button.    Once it has been activated, a check mark will appear next to the command.
Spectrum Analyzer 
X-Y Vector Display 
Time Display 
File Toolbar 
Status Bar 
Filter Toolbar 
Output VU Meters 
Play Controls 
Zoom-In 
Zoom-Out 
Zoom to Markers 
Sync Files 
File Information 



Time Display

The Time display windows displays information about the play cursor position and the selected area 
times. There are four rows of numbers in the window: 

The following times are displayed (from top to bottom):
Cursor Position: This is the location of the flashing play cursor. This cursor tracks the audio while 
playing a file. The cursor may not always be visible.
Start: This is the start time of the highlighted area
Stop: This is the stop time of the selected area

Span : This is the amount of time contained within the selected area.



File Toolbar
Show or Hide the File Toolbar. This toolbar contains the all of the menu items that are used for 
opening, closing, deleting and renaming files.



Status Bar
This is the set of indicators at the bottom of the DC-Art window.    It is used to display alpha and 
numeric data regarding the performance of the program. Four sets of parameters are displayed here.    
For details, refer to the section entitled Status Bar .    It can be enabled or disabled by clicking on 
"Status Bar" with your mouse.    A check mark next to the command indicates that the feature is 
enabled.
This is the second row of buttons under the toolbar. Each button represents a filter in the filter menu. 
The order of the buttons is the same as the toolbar. The last Icon corresponds to the Reverb filter 
which is in the Effects menu. Selecting this menu item will display or hide the filter toolbar.



Play Controls
This command hides or displays the record and play controls. It contains controls for playing, recording
and zooming on a wave file.



Spectrum Analyzer
This command brings up the DC-Art floating spectrum analyzer.    This Analyzer can be used with any 
of the DC-Art filters or effects.    It is connected to the output of the filter or effect, so that you can see, 
in the frequency domain, how you have effected the file.    If you want to compare the output of the filter
or effect to the input, use the bypass function on the filter or effect window.    Since the DC-Art 
spectrum analyzer utilizes constant Hertz per frequency band, it will display white noise as a flat, 
horizontal line.    This is unlike octave weighted real time audio analyzers in which white noise produces
a diagonal, positive sloped line, and pink noise produces a flat horizontal line.    Conversely, pink noise 
displayed on the DC-Art spectrum analyzer will be displayed as a negative sloped diagonal line.    
Keep in mind that the use of the spectrum analyzer will slow your system down slightly. Therefore, 
when you are done using it, shut down the spectrum analyzer in order to maximize processing speed.   
The following displays are provided on the DC-Art spectrum analyzer:

1. A frequency vs. amplitude graph of the signal is presented.    The vertical axis indicates 0 dB at the 
top and ranges down to –100 dB at the bottom.    The horizontal axis indicates frequencies from 10 Hz 
(left) to a little over 20 KHz (right.)
2. Two digital readouts indicate the frequency and amplitude of signals feeding the spectrum analyzer.  
One signal is the peak value and the other is user defined.

The following controls are provided:
1. Display Mode:
· Fast:    Shows the spectrum in almost real time.
· Slow:    Shows the spectrum with slower ballistics.
· Averaging: On / Off:    This allows the system to provide you with the average signal spectrum 

rather than a real time display.    The averaging interval will be as long as the analyzer is left in 
operation.    

2. Frequency Bands: 3 selections (1024, 2048, or 4096 bands)
          This selection determines the frequency resolution of the spectrum analyzer.    The higher the 
number selected, the better will be the frequency resolution of the display. 
3. Range: This scales the vertical axis to 100 dB, 50 dB, or 20 dB full scale.    This feature along with 
the offset control allows you to hone in on a particular signal.

    4.    Hold Button:    This is a “toggle” function and will allow you to freeze or un-freeze the spectral 
display update.
    5. Show Peak Button:    This feature will automatically find the peak amplitude signal and display its 
Frequency and Relative Amplitude value in the upper right hand corner of the Spectrum Display screen. 
The marker and display for this feature are red in color.
    6. User Controlled Marker:    You can place a marker anywhere you want on the spectral display by 
clicking the left mouse button on the peak that you are interested in measuring.    To accomplish this, 
merely point the mouse cursor to the peak of interest and click the left mouse button.    A green marker 
will appear at that location and a yellow digital display of the frequency and relative amplitude of the 
signal that you pointed to will appear in the upper left hand corner of the spectral display.    To read 
another value, merely click the mouse again, pointing to a new spectral line.    The marker and the 
display will then be updated.
    7. Frequency Resolution:    The spectrum analyzer has the ability to display frequencies with the 
following values of resolution:
· 10.77 Hz
· 2.69 Hz
· 1.35 Hz
· 0.67 Hz
You can choose any value you desire by selecting the appropriate setting.



    8. Offset Slider Control:    This allows you to move the centering of the spectral display up or down.    It 
is of particular value when the “Range” control is set to a high sensitivity value such as 50 dB or 20 dB, 
and the signal appears to be off of the screen.    By using the Range control and the “Offset Slider” 
control, you can zoom-in on a signal of interest.
    9. Ultra High resolution forensics mode:    If you click on 0.67 Hz, the system will re-scale the 
horizontal (X) axis of the spectral graph to indicate 500 Hz full scale rather than 20 KHz.    To augment 
this capability, use the Range control setting at 20 dB and the Offset control to zoom in on the signals of 
interest.    This combination of features are particularly useful when trying to determine if a forensics 
recording is a “dubb” of the original by looking for two discrete “hum” frequencies on the spectrum.    
Two separate “hum” signals indicates the presence of a “dubb.”    



Zoom-In 
Zoom-In allows you the ability to magnify the time axis of either the Source or Destination wavefile. 
Highlight the desired area on which you would like to zoom-in, and click on Zoom-In. The time scale 
will be expanded. This feature can also be accessed via the Zoom-In icon on the toolbar.    DC-Art will 
remember the last 5 zoom-in levels that you have used. 



Zoom-Out
Zoom-Out reverses a Zoom-In process.    This feature, like Zoom-In, can also be accessed via a 
toolbar icon.    



Zoom to Markers
When any area between two markers have been highlighted, this command will zoom directly into that 
portion of the wavefile that is between the closest two markers. This is useful for checking that markers
are positions exactly where you want them.    



Sync Files

Sync Mode                                                                                                                    
This feature, when enabled, mutually synchronizes the Filter and other commands such as Zoom-In 
and Zoom-Out between the Source and the Destination wavefiles.    This feature is useful for selective
filtering or viewing of a portion of a Wavefile.    For example, if you run a particular filter, and then find a 
sector (or sectors) which needs further filtering, you can highlight only the portion which needs the 
additional processing, and the highlighted portion will be acted upon by the particular algorithm. Sync 
mode will also accommodate different filters being applied to different sectors.    Also, when enabled, 
highlighting and Zooming-In on a particular area of a source file will correspondingly Zoom-In on the 
same timing co-ordinates in the Destination file.    The converse is also true such that Zooming-In on 
particular set of co-ordinates in a Destination file will also cause the Source file to contain the same 
Zoom-In co-ordinates.    This feature is of particular use when you want to visualize how a particular 
filter may have modified a waveform from your Source file.    This feature is enabled by clicking on it 
with your mouse.    When it is active, a check mark will appear to the left of it.    
To use Sync Mode to apply selective filtering to a Wavefile, it is first necessary to create a Destination 
file from your Source file.    This can be done through the normal processing procedure of any of the 
DC-Art filters, or it can be accomplished with one of the file conversion options such as Mono to Mono 
or Stereo to Stereo.    Thereafter, merely highlight the portion of the Source file which needs filtering, 
click on the appropriate filter, select the appropriate filter values and run the filter.    Only the highlighted
sector of the two files will be enacted upon by the filter, with the results appearing in the Destination 
file.    If another filter (or the same filter which you had just been working with) is then required to be 
applied to another portion of the wavefile, just repeat the outlined process. 
For a detailed step-by-step procedure for performing "Selective Filtering" utilizing the "Sync Mode," 
refer to the “How Do I” section entitled “Selective Filtering with Sync Mode.”

Non-Sync mode of operation
In non-sync mode, the highlighted section of the source file is read and processed by the DC-Art filter.  
The processed section is then written to the destination file starting at the beginning of the file.    If a 
destination file already exists, it will be overwritten (a prompt warns you of this).    This mode is useful 
when only a section of the source file needs to be extracted, or for testing a filter’s settings before 
processing an entire file. 



File Information
The following information will be displayed regarding the current highlighted wavefile when “File 
Information” is clicked:
          1. File Name
          2. File Path
          3. File Size (Bytes)
          4. Length (Time)
          5. Channels (Mono/Stereo, etc.)
          6. Sample Rate (KHz)
         7. Bits Per Sample
         8. Last Modified (Date)        



X-Y Vector Display
DC-Art provides a useful X-Y vector display under the View Menu.    This feature is primarily used to 
align the azimuth of analog tape deck recording and playback heads.    To do so, a known pre-recorded
azimuth alignment tape is required containing a fixed frequency tone.    The X-Y Vector display in 
conjunction with your azimuth tape and the DC-Art Time Offset feature can be used to fine tune a 
recorders azimuth alignment without the necessity of having to take a screw driver to your tape decks 
head alignment adjustment screws.    The goal here is to correct the azimuth of the wavefile using the 
File Conversions Filter with the Time Offset slider control.    Preview the wavefile with the X-Y Vector 
Display showing, and adjust the Time Offset slider control until a 45 degree positive sloped (up and to 
the right) straight line is seen on the display.    That will be the optimum value of azimuth correction.

The following features will be found on the X-Y Vector display:

1. X-Axis displacement (Horizontal) which corresponds to the Left Channel Input
2. Y-Axis displacement (Vertical) which corresponds to the Right Channel Input
3. X-Axis gain control slider (Horizontal in position)
4. Y-Axis gain control slider (Vertical in position)

Here is a listing of some vector displacements, which can be observed on the X-Y Vector Display.    
They have the following meaning and are sometimes referred to as Lissajous figures:

1. Straight line at 45 degrees with a positive (up and to the right) slope = Signals are in phase and are 
        Monophonic.
2. Straight line at 45 degrees with a negative (down and to the left) slope = Signals are 180 degrees 
out-of-
        phase
3. Circle = Signals are 90 degrees phase shifted
4. Frozen figure “8” = Signals are frequency phased locked to one another but 2:1 in frequency ratio.*
5. Moving figure “8” = Signals are not frequency locked, but are abut 2:1 in frequency ratio.*
6. Random pattern of squiggly lines on the screen = Stereophonic audio signal
7. etc.

*Note: In these examples, the right channel would be twice the frequency of the left input.    If the figure 
8 were lying on its side, then the left channel would be twice the frequency of the right input. 



Time Display Window

Both LIVE and Millennium have a new feature which displays all of the time related parameters 
associated with a source or destination workspace.    To activate this feature, click on “Time Display”, 
which can be found under the View Menu.    A display window will appear containing four sets of timing 
numbers.    This window can be dragged and placed anyplace on your workspace.    The following time 
related parameters are displayed:

1. Cursor Location (the largest numerals)
2. Start Location of a highlighted area (small numerals)
3. Stop Location of a highlighted area (small numerals)
4. Span – this represents the total time of a highlighted area (small numerals).



Output VU Meters

Two 100 segment VU meters can be displayed which will indicate the output of any filter multiple filters 
that are being used by LIVE or Millennium.    These meters indicate the level of      the left and right 
channels and have both average and peak reading ballistics.    They are calibrated to indicated values 
from –50 dB to 0 dB, with 0 dB being full scale output.    Any signal above that level will be clipped by 
the system.    These meters can be activated or de-activated under the View Menu.    Also, they can be 
“dragged and dropped” anywhere on your desktop workspace using your left mouse button.    



Window Menu
The Window Menu contains all of the commands that effect the manner in which the files are displayed
to the DC-Art user.    The following commands are available:

New Window
The "New Window" command allows you to open up another view of the file which you had been 
working with.    To do so, click utilizing the left mouse button on the "Window" Menu, and then click on 
"New Window", and a replicate window will appear on your display.

Cascade
The "Cascade" command arranges all of the open Windows so that they appear on the display one 
behind the other.    The most recently opened Window will appear closest to you, with the remainder 
arranged in the order in which they were opened.    

Tile
The "Tile" command arranges all of the open Windows so that they appear on the display in a matrix 
configuration (in the same plane) on your display.    This feature is used when you need to see all of the
workspaces concurrently.

Arrange Icons
The "Arrange Icons" command allows you to use the left mouse button to arrange the "iconized" 
windows in the pattern in which you would like to see them.

Window File listing
 A listing of all of the open files is provided at the bottom of the Window Menu.    The file which is active 
will have a check mark indicated to the left of the file name. 



Preview Mode
Preview Mode is designed to allow you to quickly hear the effect of a particular filter’s setup 
parameters on your Source wavefile.    Instead of having to process the entire file in order to hear the 
effect of your chosen settings, you can simply highlight with your mouse a representative portion.    
When you bring up any of the filters, you will see in its dialog box a button to click on called "Preview." 
Set your filter parameters to your first guess as to the correct settings, and then click on " Preview."    
You will hear, after a small delay time, the results of the filter and its settings on your Source file.    
While the filter is being previewed, you can adjust the filters’s slider controls to change any parameter 
and hear the results in the preview. This allows you to quickly find the proper setting for a filter’s 
paramater. (Note: Do not type values from the keyboard into the filters edit controls, these values will 
not be used, only slider movements are recognized.)
The sound may "stutter" depending on the speed of your computer, the complexity of the filter which 
you have chosen, and the particular parametric settings you have chosen.    This "stuttering" effect is 
due to your computer’s inability to keep up with the mathematical calculations of the filter algorithm in 
"real time."    If you are using either a fast computer, or a simple algorithm, the computer will not 
"stutter."    In either case, do not be concerned about this effect ending up in your final product! The 
stuttering can be eliminated, or at least delayed by increasing the number of "Preview Buffers” (located
in the Preferences dialog box). This causes the program to pre-calculate more audio before starting 
playback. 
 When you finally decide to perform the complete processing of your source wavefile, you will need to 
highlight the entire Source wavefile, and click on the “Run Filter” button in the filter dialog box. It is 
not necessary for your computer to be able to perform the final processing in real time, so no stuttering 
will remain behind.      But despite the "stuttering" in preview mode, once you get used to its 
idiosyncrasies, you will find it a valuable tool for establishing the desired settings for all of the DC-Art 
filter parameters.    Computer platforms that use a Pentium 200 MHz processor or better will run all of 
the DC-Art algorithms in real-time or faster.    



How Do I? (DC-Art Procedures)
The general process for utilizing the DC-Art program involves three basic steps.    First, you must 
transfer your audio material onto your computer hard drive, whether it is in the Analog or the Digital 
format to begin with.    Next, you will be processing the Wavefile utilizing the DC-Art program utilizing 
its various features, creating "Destination" files from the "Source" file.    Lastly, you will transfer the final 
"Destination" file back out of your computer to some other usable audio format.    This format could take
the shape of a DAT or an analog reel-to-reel master tape, or it could take the form of a write-once CD-
ROM located in your computer.    Below is a listing of the detailed procedures provided in the DC-Art 
helpfile which may provide you with important details on the use of the various DC-Art features which 
you may use for your sound restoration process. 



Average Filter Operating Procedure
Note:    The Average Filter and the Median Filter both use similar procedures.

1. Highlight the portion of your Wavefile on which you desire to apply the Average Filter.    (You may 
choose to highlight the entire file, or any portion thereof.)

2. Click on the Filter Menu with the left mouse button.
3. Click on "Average."
4. Choose the number of Samples over which you desire the moving average calculation to be 

performed.    The higher the number of samples chosen, the greater will be the attenuation of the 
higher frequency portion of the audio spectrum.    You can choose any integer value from 2 to 100 
samples.    The higher the number of samples chosen, the longer will be the processing time 
requirement for the algorithm. This is accomplished utilizing the slider control.

5. If you desire to hear the results of your filter settings before creating a new "Destination" file, click 
on "preview."

6. You will hear the effect of the averaging over the chosen value of "samples."
7. While the filter is running in either preview mode or normal mode (Destination File Mode), you will 

see a dialog box which indicates the "% Done" of the filter algorithm on the selected portion of the 
Source Wavefile.    Also, at the top of the Dialog box you will see indicated the "Total Samples to 
Process:"

8. Keep adjusting the number of samples until you achieve your desired effect.
9. When you are satisfied with a setting, you will no longer use the Preview Mode button.
10. Click on Run, and the filter will process your source Wavefile through the filter algorithm, and create 

a Destination Wavefile containing the output of the filter.
11. When this process is complete, you will see the Destination File become highlighted in Yellow, at

the same time that the Source File becomes un-highlighted.
12. Click on "Close".    
For more information on the Average Filter, refer to the Average Filter Tutorial.



Band Pass Filter Operating Procedure
Note:    The Band Pass, Low Pass, and High Pass Filters all use similar (although not identical) 
procedures.

1. Highlight the portion of your Wavefile on which you desire to apply the Band Pass filter.    (You may 
choose to highlight the entire file, or any portion thereof.)

2. Click on the Filter Menu with the left mouse button.
3. Click on "Band Pass."
4. Make an initial determination of what band of frequencies you desire to pass through the Band 

Pass filter.    
5. Utilizing the right mouse button in conjunction with the Low Frequency slider control, select the 

lower corner frequency of the range which you have chosen.    (The range for this control is 5 Hz to
19.999 KHz) 

6. Utilizing the right mouse button in conjunction with the High Frequency slider control, select the 
upper corner frequency of the range which you have chosen.    (The range for this control is 5 Hz 
to 19.999 KHz)    Note: If you desire finer frequency resolution for either the lower or the upper 
corner frequency, you may use direct numeric entry, instead of the slider controls.

7. Choose the Filter "Slope" which you desire.    This slope will symmetrically effect both the upper 
and lower corner rolloff rates.    Click on either 6 dB / Octave, 12 dB / Octave, or 18 dB / Octave.    
The steeper the slope, the higher will be the degree of attenuation of all frequencies outside of the 
selected pass band range.

8. If you desire to hear the results of your filter settings before creating a new "Destination" file, click 
on "preview."

9. You will hear the effect of the settings which you have chosen, after a short delay.    (The system 
may repeat [stutter] if your computer is too slow to keep up in real time with the algorithm.    This 
repeating pattern will not appear in the final Destination processing of the filter.)

10. While the filter is running in either preview mode or normal mode (Destination File Mode), you will 
see a dialog box which indicates the "% Done" of the filter algorithm on the selected portion of the 
Source Wavefile.    Also, at the top of the Dialog box you will see indicated the "Total Samples to 
Process:".

11. Keep adjusting the Low Frequency and High Frequency sliders as well as the Slope parameters 
until you achieve the effect you desire and are satisfied with the results.      

12. When you are satisfied with a group of settings, you will no longer need to invoke the Preview 
function.

13. Click on Run, and the filter will process your Source Wavefile through the Bandpass Filter algorithm,
and create a Destination Wavefile containing the output of the filter.

14. When this process is complete, you will see the Destination File become highlighted in Yellow, at
the same time that the Source File becomes un-highlighted.

15. Click on "Close."
Note: If the low frequency control is set to a higher frequency than the high frequency control setting, a
“no pass” filter will be created.    This is of little useful value, but is allowable by DC-Art.
For more information on the Band Pass Filter, refer to the Bandpass Filter Tutorial.



CD-R Preparation from a Commercial Cassette Tape Source

1. Record side one of your cassette tape, creating one continuous wavefile at a 44.1 KHz sample rate.
2. Record side two of your cassette tape, creating a second continuous wavefile at a 44.1 KHz sample 
rate.
3. Using the Mute and/or Cut function found under the Edit menu, eliminate excess lead in from the two
wavefiles.    Do the same thing at the end of the wavefiles to eliminate excess “dead-time.” 
4. Run the Continuous noise filter to remove wideband noise such as hiss and rumble.
5. Enhance the recording by running any of the DC-Art audio enhancement tools such as either of the 
equalizers, dynamics processor, reverb, or Virtual Valve amplifier.
6. Click on the CD Prep Menu. 
7. Click on Find and Mark Silent Passages.
8. Check to be sure that the markers have located themselves correctly between “cuts.”    Adjust them 
if necessary.
9. Click on “Quantize for CD Audio.”
10 Click on “Chop File into Pieces.”
11. Repeat the above process for side two of your Cassette tape.
12. Using your CD-R software, create a recording list from the wavefiles, which you have just created.



CD-R Preparation from a Vinyl Record Source

1. Record side one of your record, creating one continuous wavefile at a 44.1 KHz sample rate.
2. Record side two of your record, creating a second continuous wavefile at a 44.1 KHz sample rate.
3. Using the Mute and/or Cut function found under the Edit menu, eliminate excess lead in time and the
“needle-drop” from the two wavefiles.    Do the same thing at the end of the files in order to eliminate 
the “needle-lift” and excess “dead-time.”
4. Run the Impulse noise filter using vinyl mode on each file in order to remove ticks and clicks.
5. Run the Continuous noise filter to remove wideband noise such as surface noise.
6. Enhance the recording by running any of the DC-Art audio enhancement tools such as either of the 
equalizers, dynamics processor, reverb, or Virtual Valve amplifier.
7. Click on the CD Prep Menu. 
8. Click on Find and Mark Silent Passages.
9. Check to be sure that the markers have located themselves correctly between “cuts.”    Adjust them 
if necessary.
10. Click on “Quantize for CD Audio.”
11 Click on “Chop File into Pieces.”
12. Repeat the above process for side two of your vinyl record.
13. Using your CD-R software, create a recording list from the individual wavefiles which you have just 
created and then “burn that ROM” (make your CD.)



Context Sensitive Help

Method #1
1. Point the mouse pointer to the portion of the DC-Art program display about which you would like 

some Helpfile information.
2. Depress the special function key F1.
3. Helpfile information will appear in a window.    This information is usually only summary procedural 

information on the particular topic.    For more detailed information, refer to the actual Helpfile, and 
look for tutorial information on the topic of interest.

4. When done, click on the    -    button at the top left-hand side of the Help window. 

Method #2
1. Using the left mouse button, click on the button with the ? contained within its perimeter on the DC-

Art toolbar. 
2. A black, mouse controlled ? will appear next to the mouse pointer.
3. Move the pointer to the area of the DC-Art program display about which you would like some 

Helpfile information.
4. Click on the left mouse button.
5. Helpfile information will appear in a window.    This information is usually only summary procedural 

information on the particular topic.    For more detailed information, refer to the actual Helpfile, and 
look for tutorial information on the topic of interest.

6. When done, click on the    -  button located at the top left-hand side of the Help window.
Note:    Under some circumstances, Method #2 will not activate the context sensitive Helpfile.    When 
this occurs, use method #1. 



Continuous Noise Filter Operating Procedure
This filter is the most mathematically complex of all of the DC-Art algorithms.    It will, therefore, take 
the longest amount of processing time to complete its calculations.    This algorithm will benefit the most
from the use of a high clock rate computer.    This filter is also the most difficult filter in DC-Art to use 
correctly.    Aliasing Artifacts can be produced when the settings are not correct for the particular 
Wavefile you are attempting to "de-noise."    The first time you use it, it will be worthwhile to spend 
about an hour playing around with it in order to become familiar with its behavior. 

1. Highlight a quiet portion of the Source Wavefile.    Often, this sector will be found at the beginning or 
at the end of the file, as with the lead-in or the exit groove of a record or the lead in of a tape 
recording.    The idea here is to capture a section of noise only, but no signal.    This will become the 
noise floor baseline for the subsequent operation of the Continuous Noise Filter.      

2. With the left mouse button, click on "Filter." 
3. Next, click on "Continuous Noise."
4. When the Continuous Noise Dialog Box appears, click on "Sample Noise."
5. Some calculations will be made in the ensuing moments.    When they are complete, a graph will 

appear showing the Amplitude (in dB) versus the Frequency of the Wavefile noise floor.    
6. The measured sample noise spectrum is shown in red.    The noise threshold value versus 

frequency is shown in blue.    The blue graph threshold value can be set by you, although DC-Art will
automatically choose some settings for the threshold limit line which is a good place to start with.    

7. If you choose to change the graphical threshold contour, follow the procedure outlined in steps 7 
through 10.    Using your mouse, place the pointer on the left-most blue threshold marker on the 
graph (one of ten blue dots). 

8. Depress the left mouse button and move the dot either up or down so that is remains somewhere 
above the red line graph at the bottom end    of the spectrum. The higher this line is from the red line,
the greater will be the degree of noise reduction at frequencies near this particular dot.    If the dot is 
placed below the red graphical line, no noise reduction will be applied to these frequencies.    This is 
sometimes the preferable setting for the blue threshold line near the bottom end of the audio 
spectrum (below a few hundred Hertz).

9. Next, move the next blue threshold marker just to the right of the first one, and using the mouse, set 
it somewhere above that particular frequency on the spectrum graph.

10. Repeat this process until all ten threshold markers are located somewhere above the "noise floor" 
graphical representation of your wavefile.    Now the blue line should be located above the red line at
all frequency locations.    Note that the best contour can only be achieved by not only moving the 
markers along the vertical axis, but along the horizontal (frequency) axis as well.

11. Set the "Attack" time initially to 25 milliseconds.
12. Set the "Release" time initially to 50 or 100 milliseconds.    (The "Release" time constant should 

always be set longer than the "Attack" time constant for a realistic sounding operation of the filter.) 
13. Set the "Attenuation" control initially to 10 dB.    (Higher numbers results in higher levels of noise 

reduction.)    Too much noise reduction will produce digital artifacts and detract from the "ambiance" 
of the recording.

14. Highlight the portion of your Wavefile on which you desire to apply the Dynamic Noise Filter.    (You 
may choose to highlight the entire file, or any portion thereof.)

15. Run the Filter.
16. Play the section which you have just processed, and determine which parameters need 

modification.    If there is a "lagging" response to audio signals, decrease the "Attack" time.    If there 
is a "swell" of noise following an audio crescendo, decrease the    "Release" time.    If portion of the 
audio spectrum is sounding dull, lower the "threshold" line at the frequency of interest.    If a portion 
of the audio spectrum is sounding noisier compared to the rest then raise the "threshold" at the 
frequency range of interest. 

17. When you are satisfied with the results, re-run the Wavefile (in its entirety) to achieve the final 
processed results in the "Destination" workspace.      



Important Note: The threshold line inflection points can be adjusted “live” when you are running the 
filter in “Preview Mode.”    You will be able to hear the effects of modification which you make to the 
threshold line almost immediately.
For more information on the Continuous Noise Filter, refer to the Continuous Noise Filter Tutorial.



Converting a Destination File into a Source File
1. This operation assumes that you have already processed a Source File, thereby having created a 

Destination File.    This would have been accomplished by utilizing one of the Filter commands.    
This command is a convenience providing a simple method for performing many serial operations 
on your original sound source with a minimum number of computer manipulations.    

2. Click on File.
3. Click on Make Destination the Source . . .
4. If a "Save As" Dialog Box appears, click on SAVE. provided that the Destination still has a 

temporary name. 
5. A new DC-Art window will be opened, with the previous Destination File appearing in the new 

Window's Source workspace.



Converting MP3 Files into Wavefiles

DC-Art Live and DC-Art Millenium both have the capability to convert MP3 files into Wavefiles.    The 
process is extremely simple:

1. Click on the File menu with the left mouse button
2. Click on “Open Source.”
3. Under the “Files of Type” selector box, find    .mp3 and click on it.
4. Click on “Open.”
5. The file conversion will begin.    
6. After a period of time a waveform will appear in the Source Workspace.    This is a 16 bit,    converted
wavefile representation of the MP3 file. The original MP3 file determines the sample rate and number 
of channels.
7. It will have the same name as the    .mp3 file had except it will have the    .wav extension
8. If there is already an existing    .wav with the same name as the    .mp3, a number will be added to 
the end of the name to distinguish it.
NOTE:. DC-Art an DC-Live do not edit the MP3 file directly. All editing is performed on the converted 
WAV file. 



Converting White Noise into Pink Noise

1. Under the Edit menu, click on “make waves” using the
        left mouse button.
2. Select “Random” noise, with the amplitude set to –10 dB, 
        and the length set to 5 or 10 seconds.
3. Click “OK”, and a random white noise file will be created 
        in the Source window.
4. Click on the “Filter” menu, using the left mouse button.
5. Click on the Paragraphic Equalizer.
6. In the preset menu at the bottom of the Equalizer, find
 and click on the “White to Pink noise Converter.”
7. Run the filter.
8. Pink noise will now be found in the Destination window.



Copy and Paste Procedure
1. Determine the section of the wavefile which you desire to copy for the "copy and paste" operation.

Note:    You may use the Zoom-In feature if you desire to copy a very small portion of the wavefile.
2. At the beginning of the sector of the wavefile which you desire to copy, click down on the left mouse 

button and keep holding it down as you drag the timing bar (with the mouse) towards the right of the 
workspace.    

3. Stop dragging the mouse at the end of the desired "copy" sector of the wavefile.
4. Release the left mouse button.    You will notice that the sector between the two timing bars will 

remain highlighted in yellow.    This will be the "copy" sector.
5. Click the right mouse button anywhere in the workspace area, and a pop-up window will appear, 

providing you with three choices.
6. Click the right mouse button on "copy" and the highlighted sector will be transferred to a temporary

storage location on your hard drive. 
7. After the transfer is complete, highlight the area in your wavefile where you desire to "paste over" 

the previously copied segment using the previously mentioned mouse drag procedure outlined in 
steps # 2 through 4.

8. Click the right mouse button again anywhere in the workspace area.
9. This time, click on "Paste Over."
10. The "Copy and Paste Over" operation will be completed shortly thereafter.
11. If you are not satisfied with the results of this procedure, you may undo the operation with the 

command of the same name.    For more information, click here on "Undo."
Important Note:
          The timing rules used by "Copy and Paste Over" are as follows:
A. Copy and Paste Over operations always begin at the leftmost timing marker of the Highlighted 

area of the workspace.
B. If the "Copy" sector is shorter than the "Paste Over" sector, the length of insertion is determined by

the length of the "Copy" sector of the Wavefile.
C. If the Copy sector is longer than the "Paste Over" sector, the length of insertion is determined by 

the length of the "Paste Over" sector of the Wavefile.



Crossfade Procedures
Method # 1: Using the Edit Menu Crossfader - 
Important Note: This method of crossfading is undo-able.

1. Open the File (song) into the Source Workspace which you desire to be the first in your crossfade 
timing sequence.

2. Open the File (song) into the Destination Workspace which will be the segue (second song) in your 
crossfade timing sequence. 

3. Highlight, using the mouse drag procedure, the file to which you will be crossfading in the 
Destination Workspace.    You must highlight the file from the point of segue all the way to the end of 
the song, assuming that you desire to maintain the entire song in the sequence.

4. Click on “Copy” under the Edit Menu.    This procedure may take a bit of time as this relatively large 
file is copied onto the clipboard. 

5. Next, highlight the end of the file located in the Source Workspace.    The area which you highlight 
will determine the crossfade timing interval.    The longer you make this interval, the slower will be 
the crossfade sequence. 

6. Click on “Paste” under the Edit Menu.
7. Next, click on “Paste Crossfade” under the paste menu.
8. Set the gain controls in the dialog box as follows: (default values will work)

File 1 Levels: 
Start = -100 dB
Stop =    0.00    dB
File 2 Levels:
Start =    0.00 dB
Stop = -100 dB

9. Choose the crossfade timing which you desire.    Linear usually produces a pleasing effect. 
10. Click on “OK”
11. After the processing has been completed, you may click on the play button on the Toolbar to hear 

your results.
12. If you are not satisfied with the timing, or the gains used by the crossfade sequence, you can undo 

using the “Undo Levels” under the Edit Menu. 

Method #2: Using the Filter Menu Crossfader
Warning:    Using the Filter Menu Crossfader is not undo-able 

1. Open a Source File which you desire to be the segue song in a crossfade sequence.
2. Open a Destination File which you desire to be the first number in the crossfade sequence.
3. Highlight the Source File up to the end of the file.
4. Highlight the Destination File segment at its ending where you desire the crossfade to occur.
5. Click on the Crossfade feature under the Filter Menu.
6. Set the Gain Controls as follows: (Default settings are correct)

File # 1 Level
Start = -100 dB
Stop =      0.00 dB
File #2 Level
Start =    0.00 dB
Stop = -100 dB

7. Choose the Crossfade timing which you desire.    Linear produces a pleasing result on most 
material.

8. Click on “Do Crossfade.”



9. The final results will reside in the Destination Workspace following processing. The entire Source 
File will be appended to the Destination file following the crossfade sequence.



De-Clicking a Vinyl LP Record
Important Note: Vinyl LP mode works best on Wavefiles which have been sampled at 44.1KHz.    The 
setting examples given below are based on Wavefiles which have been recorded at a 44.1KHz 
sampling rate only. 

1. Download the Vinyl LP Wavefile into DC-Art using the "Open" command.
2. Highlight the portion of your Wavefile on which you desire to apply the Impulse Noise Filter.    (You 

may choose to highlight the entire file, or any portion thereof.)
3. Click on the Filter Menu with the left Mouse button.
4. Click on "Impulse Noise."
5. Click on "Vinyl L.P."    An "x" will appear in the box adjacent to the feature.
6. Set the Threshold Control to its minimum setting of 1.
7. Set the "Tracking" Control somewhere in the 25 to 30 range to start with.
8. Set the "Size" control to a value somewhere in the range of 10 to 15 samples.
9. Run the filter or use Preview mode, and determine if the Wavefile is being adequately de-clicked.    If

it is not, lower the tracking control.    If it is de-clicking, but producing distortion on the sibilant 
sounds, then raise the control. Continue this process until a good balance is established of minimum
sibilant distortion and minimum click feed-through.    If it is de-clicking, but leaving a bit of an artifact 
behind, increase the value of the "Size" control.

10. When you determine the best setting of the control for your particular Wavefile, click on Run filter.    
When the filter has completed its operation, the results will appear in the "Destination" workspace.

Note:    Unlike all of the other DC-Art controls, Vinyl L.P. mode can not be turned on or off “live” in 
Preview Mode. 



Deleting a Wavefile
 
Warning!    This operation can not be undone by DC-Art and the files will NOT appear in 
the recycle bin.

1. Click on File and a pop down window will appear.
2. Click on Delete File and the Delete File Dialog Box will appear.
3. Choose the Drive and the Directory from which you desire to delete a Wavefile.
4. Click on the Filename which you desire to delete in the Filename field. *
5. Another dialog box will appear, inquiring whether you are sure that you want to delete the chosen 

file.
6. If you click on "yes",    the file will be deleted.
7. If you change your mind, and click on "no", the DC-Art program will revert back to its initial window, 

and the file will not be deleted. 
* Note 1:    Multiple files which are sequential in the file listing can be deleted in one operation.    This is 
accomplished by clicking on the first item on the list, and then dragging the mouse pointer down to the 
last file you desire to delete.    The files which are about to be deleted will be highlighted.
*Note 2:    Multiple files which are not sequential in the file listing can also be deleted in one operation.  
This is accomplished by holding down the CTRL key at the same time that you click on the appropriate
item you wish to delete with the left mouse button. The files which are about to be deleted will be 
highlighted. 



Dynamic Noise Filter Operating Procedure

Important Note: Most of the parameter settings for this filter will vary considerably depending on the 
content of your particular Wavefile.    You will have to experiment to determine the values most to your 
liking.    The values used below in the Procedure Example will get you started.

1. Highlight the portion of your Wavefile on which you desire to apply the Dynamic Noise Filter.    (You 
may choose to highlight the entire file, or any portion thereof.)

2. Click on the "Filter Menu" with the left mouse button.
3. Click on "Dynamic Noise Filter."
4. Set the Noise Threshold slider all the way down; this is the minimum threshold position of the slider 

control.
5. Set the Filter Frequency to around 1.5 KHz.
6. Set the Attack Time to about 5 mSec.    (Unless you are attempting to obtain some sort of special 

effect, the Release Time should always be set to a value greater than or equal to the Attack Time.)
7. Set the Release Time to around 50 mSec. 
8. Set the Gain Control to 0 dB.    (This control should only be set to higher numbers if a “Spectral 

Enhancement” effect is desired.)    This will modify the "effective bandwidth" of your recording by 
incrementally amplifying the high end of the spectrum when there is enough highs present to trip the
detector.    This can be used to increase the "presence" of a recording, or to enhance the sound of a 
vocalist.)    If more noise reduction is desired, set the gain control to higher negative values.

9. Click on "Preview."
10. Listen to the "Previewed" version of the processing parameters which you have just set.

When the filter is operating properly, "Hiss" will be reduced, but when there is high frequency 
content on the recording, the filter should "open up" and pass through the "highs".    If the Threshold 
is set too high, the filter will never open up, and the Wavefile will sound "dull" although "Hiss" may be
reduced.    If the Threshold is set to low, the filter will always be opened up to full bandwidth, and 
there will be no noise reduction.    If the Attack time is set too long, there will be a delay heard before 
the filter changes bandwidth on musical high frequency transients such as cymbal crashes.    If the 
Release time is set too long, there will be a residual "Hiss" left behind after a high frequency musical
event, which will decay out, but too slowly.    

11. When you determine the best setting of the controls for your particular Wavefile, click Run filter.    
When the filter has completed its operation, the results will appear in the Destination Workspace.

For more information on the Dynamic Noise Filter, refer to the Dynamic Noise Filter Tutorial.



Fade-In Procedure
Note:    Fade-In runs under the edit menu, and unlike the various Filter functions, operates on the 
selected file (which can be the source file.)

1. Listen to the beginning portion of your wavefile.
2. Determine the position near the beginning of your wavefile during which you desire to produce a 

"Fade-In" effect. 
3. At the beginning of the sector of the wavefile which you desire to apply the "Fade-In" effect, click 

down on the left mouse button and keep holding it down as you drag the timing bar (using the 
mouse) towards the right of the workspace. 

4. Stop dragging the mouse when you arrive at a location just prior to the actual beginning of the signal
portion of the wavefile.

5. Release the left mouse button.    You will notice that the sector between the two timing bars will 
remain highlighted in yellow.    This is the sector during which you have chosen to apply a    "Fade-In"
effect.

6. You can click the right mouse button to hear if you have chosen the correct portion of the wavefile to 
apply the "Fade-In."

7. Click on the Edit Menu function.
8. Under the Edit menu, Click on Fade In - - -
9. Choose the type of Fade In which you prefer, either Linear or Logarithmic.
10. Set the "Start Level" slider to zero gain (all the way down.)    The default setting for this control is 

zero gain.
11. Set the "Stop Level" slider to 0 dB (unity gain.)    The default setting for this control is unity gain.
12. Click on OK.  The "Fade-In" function will be performed on the chosen portion of the wavefile.

Note: After a Fade-In function has been performed, there may be a sector of your wavefile containing 
some noise at the very beginning just prior to the start of the Fade-In.    This can be eliminated with the 
DC-Art    "Mute" function.



Fade-Out Procedure

Note:    Fade-Out runs under the edit menu, and unlike the various Filter functions, operates on the 
selected file (which can be the source file.)

1. Listen to the "end" portion of your wavefile.    You may have to go into the preferences menu to allow
the end of the wavefile to be displayed if number of MBytes have been selected for display is not 
sufficient.    Please refer to the section entitled    "Display length limit" in the "preferences" section of 
the Edit Menu for more information on this topic.    Alternatively, you can simply "Zoom-In" on the 
ending portion of the file, even if it is not showing a modulated envelope.

2. Determine the position near the end of your wavefile wherein you desire to apply the "Fade Out" 
effect.

3. At the beginning of the sector of the wavefile at which you desire to apply the "Fade-Out" effect, click
down on the left mouse button and keep holding it down as you drag the timing bar (with the mouse)
towards the right of the workspace.    

4. Stop dragging the mouse when you arrive at a location in the file where you want total silence to 
occur.    

5. Release the left mouse button.    You will notice that the sector between the two timing bars will 
remain highlighted in yellow.    This is the sector during which you have chosen to apply the "Fade-
Out" effect.

6. You can click the right mouse button to hear if you have chosen the correct portion of the wavefile to
apply the "Fade-Out."

7. Click on the Edit Menu function.
8. Under the Edit menu, Click on Fade Out - - -
9. Choose the type of "Fade Out" which you prefer, either Linear or Logarithmic.
10. Set the "Start Level" slider to 0 dB (unity gain.)    Unity gain is the default setting for this control.
11. Set the "Stop Level" slider to zero gain (all the way down). Zero gain is the default setting for this 

control.
12. Click on OK.  The "Fade-Out" function will be performed on the chosen portion of the wavefile.    

Note:  After a "Fade-Out" has been performed, there may be a sector of noise after the "fade-out" and 
the end of your wavefile.    This can be eliminated with the DC-Art "Mute" function.



File Mixing Procedure
1. Open a Source File and a Destination File

2. Highlight the sector of one of the two files which you desire to mix into the other.

3. Click on “Copy” under the Edit Menu.    The file segment will be transferred to your clipboard.
4. Next, highlight the location in your target file in which you desire to mix the file which is now on your 

clipboard. 
5. Click on “Paste Mix” which is found under the Paste Menu.
6. Set the Level 1 Gain to the desired setting.    (This will be the level of the file which is located on your

clipboard)
7. Next, Set the Level 2 Gain the desired setting.    (This will be your “target” file level)
8. Click on Copy under the Edit Menu.
9. When the processing is completed, you may hear the results by clicking on the play button on the 

DC-Art toolbar.
10. If you are not satisfied with the results, you may undo using the “Undo Levels” under the Edit Menu.

Important Note: The example above utilized a separate Source and Destination File.    The File Mixing 
procedure can be performed on only one file, using one sector of the file to be mixed into another 
sector, if desired. 



Filter and Effects Presets
DC-Art is shipped with a large number of filter and effect presets.    DC-Art also facilitates customized 
filter presets, which you can save under your own desired name for quick recall.    The following 
describes how to save, recall, and delete a filter setting.

Saving a Setting:
1. Establish the desired filter settings and states for a particular filter application.
2. Click on the “Save” button.
3. Using your mouse, place the cursor at the beginning of the data entry field, and double click the left 

mouse button.
Delete any characters in the data field with the “delete” key on your keyboard.

4. Type in a descriptive name for your setting (up to 32 characters in length).
5. Click on “OK”.    Your setting will then have been saved.

Recalling a Setting:
1. With the left mouse button, click on the down arrow located on the right hand side of the setting list 

(located at the bottom of the Filter Dialog Box).
2. With the left mouse button, single click on the filter setting preset description you desire from the 

listing.

Deleting a Setting:
1. With the left mouse button, click on the down arrow located on the right hand side of the setting list 

(located at the bottom of the Filter Dialog Box).
2. With the left mouse button, single click on the filter setting preset which you desire to delete.
3. With the left mouse button, click on the “Delete” button.
4. A question box will appear.    If you still desire to delete the particular filter preset, click on “yes.”    If 

you do not, click on “no.”



Gain Riding Procedure
1. Determine the portion of your wavefile during which you would like to "slew" (change) the gain up 

to or down to a new value.    (If this is to be done on a relatively small portion of the wavefile, it may 
be useful to Zoom-In on the sector of interest.)

2. At the beginning of the sector of the wavefile at which you desire to modify the gain, click down on 
the left mouse button and keep holding it down as you drag the timing bar (with the mouse) 
towards the right of the workspace.        

3. Stop dragging the mouse when you arrive at the location where you want the gain to have 
achieved the new level.    Release the left mouse button.    You will notice that the sector between 
the two timing bars will remain highlighted in yellow.    This is the sector during which the gain of the 
system will slew from the existing value to a new value.

4. You can use the right mouse button to hear if you have chosen the correct portion of the wavefile for
the gain slew to occur.

5. Under the Edit menu, Click on either "Fade-In" or "Fade-Out."
6. Choose the type of slew curve you prefer, either Linear or Logarithmic.
7. Set the "Start Level" slider control to unity gain.
8. Set the "Stop Level" slider control to the desired new gain for the segment of interest.    This can 

be up to + 6 dB (amplification) or up to - 96 dB (attenuation).
9. Click on OK.  The gain "slewing" will be performed during the highlighted portion of the wavefile.
10. Select the portion of the wavefile which you desire to remain at the new gain setting utilizing the 

same "mouse drag" procedure outlined above.    This will be the "dwell" sector for the gain riding 
procedure. 

11. Again, under the Edit menu, Click on either "Fade-In" or "Fade-Out."
12. Next, change the "Start Level" slider to the same value as the "Stop Level" slider.    This will be 

your new gain setting (dwell).
13. Click on OK.    The gain modification will be applied to the highlighted portion of your wavefile for its 

highlighted duration or dwell time.
14. Next, select the portion of your wavefile during which you desire the gain to slew back down to its

original value (or another new value) utilizing the "mouse drag" procedure outlined earlier.    
15. Again, under the Edit menu, click on either Fade In or Fade Out.
16. Change the "Stop Level" slider back down to unity gain (or whatever new gain you desire) leaving

the "Start Gain" setting where it had been.
17. Click on OK.    The gain will slew back to the unity gain value during the highlighted time interval.    



Graphic Equalizer Operating Procedure
1. Click on the Filter Menu.
2. Click on "Equalizer."
3. Using your Mouse, adjust the frequency band slider control up or downwards as desired.    This can 

be accomplished either by directly pointing the cursor with the mouse and depressing the left mouse
button to move the control, or by utilizing the up and down arrows associated with each of the 10 
controls.

4. When the Slider control for a particular band is in its center position, the band is neither being 
attenuated or amplified.    Moving the slider upwards produces amplification of frequencies in the 
band up to 12 dB.    Moving the slider downwards produces attenuation of frequencies in the band of
up to 12 dB.

Note:    The controls for the Graphic Equalizer are active during preview mode, and therefore can be 
adjusted "on the fly."
For more information on the Graphic Equalizer, refer to the Graphic Equalizer Tutorial.



High Pass Filter Operating Procedure

Note:    The High Pass, Low Pass, and Band Pass Filters all use similar (although not identical) 
procedures.

1. Highlight the portion of your Wavefile on which you desire to apply the High Pass filter.    (You may 
choose to highlight the entire file, or any portion thereof).

2. Click on the "Filter Menu" with the left mouse button.
3. Click on "High Pass."
4. Choose the "Frequency" below which you desire to attenuate all signals, utilizing the right mouse 

button in conjunction with the "Frequency" slider control.    When the control is all the way down, the 
setting will be 5 Hz, and when it is all the way up, the setting will be 20 KHz.    (Useful settings will 
usually fall somewhere within the 15 Hz to 500 Hz range, depending on the goals of the audio 
restoration process.)    If you desire finer frequency resolution, you may also use direct numeric entry
of the value. 

5. Choose the Filter "Slope" which you desire.    Click on either 6 dB / Octave, 12 dB / Octave, or 18 
dB / Octave.    The steeper the slope, the higher will be the degree of attenuation of all frequencies 
below the "Frequency" setting.

6. If you desire to hear the results of your filter settings before creating a new "Destination" file, click 
on "preview."

7. You will hear the effect of the settings which you have chosen, after a short delay.    (The system 
may repeat (stutter) if your computer is too slow to keep up in real time with the algorithm.    This 
repeating pattern will not appear in the final Destination    processing of the filter.)

8. As the filter is running in either preview mode or normal mode (Destination File Mode),    you will see
a dialog box which indicates the "% Done" of the filter algorithm on the selected portion of the 
Source Wavefile.    Also, at the top of the Dialog box you will see indicated the "Total Samples to 
Process:" 

9. Keep adjusting the Frequency and Slope parameters, and testing the various settings using the 
"Preview" mode until you are satisfied with the results.

10. When you are satisfied with a group of settings, you will no longer need to use the Preview mode 
button.

11. Click on Run, and the filter will process your Source Wavefile through the filter algorithm, and create
a Destination Wavefile containing the output of the filter.

12. When this process is complete, you will see the Destination File become highlighted in Yellow, at
the same time that the Source File becomes un-highlighted.

13. Click on "Close."

For more information on the High Pass filter, refer to the High Pass Filter Tutorial. 



Impulse Noise Filter Operating Procedure

1. Highlight the portion of your Wavefile on which you desire to apply the Impulse Noise Filter.    (You 
may choose to highlight the entire file, or any portion thereof.)    Sometimes, when confronted with 
extremely stubborn clicks or pops, or radio "static" it may be useful to use the Zoom-In feature first 
before running the Impulse Noise Filter on a "grouping."

2. Click on the "Filter Menu" with the left mouse button.
3. Click on "Impulse Noise."
4. Start with the "Threshold" control at a setting of approximately 1000 for 78's. 
5. Start with a "Size" setting of between 3 to 7 samples for non-Vinyl applications, and use a setting 

somewhere in the 10 to 15 sample range for Vinyl LP and 45 RPM record applications.    
6. If you are de-clicking a Vinyl LP record, click "Vinyl LP" on with the left mouse button.

(Note: This feature is also utilized for 45 RPM records)    If you are de-clicking a 78 RPM record or 
something similar, make sure "Vinyl LP" is turned-off.    (It is important to note that Vinyl LP mode works
best on Wavefiles which have been sampled at 44.1 KHz.) 

7. If you are de-clicking a Vinyl LP record, set the threshold control to its lowest value, and perform all 
of your adjustments with the tracking control, starting with a setting of 25 to 30.    If you are de-
clicking a 78-RPM record or something similar, set the tracking control to its lowest value and 
perform all of your adjustments with the threshold control.

8. Click on "Preview."
9. Listen to the "Previewed" version of the processing parameters that you have just set.    If your 

computer is too slow, it will "hick-up" or "stutter." (Do not be concerned that your final sound 
restoration will sound like this, since it will not!)    Try to listen "through" the stutter to judge what the 
Filter is doing.    If the "stutter" is too annoying to make a judgment of the performance of the filter 
settings use Run filter mode on a selected portion of the wavefile directly into the "Destination" 
workspace.    Alternately, run the filter, and then listen to the Destination Workspace in order to make
judgments regarding your settings.    Iterate until you are satisified with the results.

10. When the filter is running, you will see a display of "Clicks / Second" and "Total Clicks Processed."
Generally speaking, when the threshold is set too low, the program will begin to react to sound 
transients rather than just noise transients.    If the "Clicks / Second is greater than 30, there is a 
good chance you are catching sound transients, and creating distortion on the output of the filter.    
Most records will show less than 10 clicks per second when the settings are correct (except in 
extreme circumstances).    Keep adjusting the threshold setting until the clicks are being removed 
and distortion is not being produced on the filter output.    (The distortion which can occur will be 
most prevalent on the sibilant sounds.)    Keep in mind that lower value settings of the threshold 
control will cause the algorithm to be more sensitive to removing clicks and pops.    However, if it is 
set too low, distortion will also be produced on the sibilant sounds.

11. If the algorithm is capturing the larger impulses but not the smaller ones, try decreasing the "Size" 
adjustment, and re-evaluate the results.    (You may also have to decrease the threshold control.)    

12. When you determine the best setting of the controls for your particular Wavefile, click Run filter.    
When the filter has completed its operation, the results will appear in the "Destination" workspace.

For more information on the Impulse Noise Filter, refer to the Impulse Noise Filter Tutorial.



Keyboard Controlled Features
      The following DC-Art features are controllable via your computer keyboard:

1. Context Sensitive Help - Special Function Key, F1
2. Highlight area "Nudge" - Left and Right Arrow and Shift keys
3. Play Wavefile - Spacebar
4. OK to dialog box question - Enter key
5. Slider Control up and down movement - Up and Down Arrow keys
6. Switch between functions - Tab key
7. Keyboard Accelerators for use on the Menu Commands - Use the Alt key in conjunction with the 

Underlined (first letter of the command) to activate the function.
8. Deleting multiple Wavefiles in one operation - Use the Alt key in conjunction with the left mouse 

button and the Delete File command which is found in the File Menu. 
9. Manually interpolating a highlighted noise event of a Source Wavefile - Use the “I” key.
10. Zoom-In on a selected ares of a wavefile – Use the “Z” key.
11. Zoom-Out by a factor of 4 from a previously zoomed-in portion of a wavefile – Use the “Shift Z” key 

combination.
12. Zoom back out to the last zoomed in selection – Use the “X” key.
13. Select the displayed Waveform – Use the “A” key.
14. Select the Source Waveform – Use the “S” key
15. Select the Destination Waveform – Use the “D” key
16. Nudge the Stop Position of the selected section of the wavefile    use the right and left arrow keys.
17. Nudge the Start Position of the selected section of the wavefie – Use the Shift with the left and right

arrow keys
18. Goto Next Marker: Use the “N” key 
19. Goto Previous Marker: Use the “Shift N” key



Low Pass Filter Operating Procedure

Note:    The Low Pass, High Pass, and Band Pass Filters all use similar (although not identical) 
procedures.

1. Highlight the portion of your Wavefile on which you desire to apply the Low Pass filter.    (You may 
choose to highlight the entire file, or any portion thereof).

2. Click on the Filter Menu with the left mouse button.
3. Click on "Low Pass."
4. Choose the "Frequency" above which you desire to attenuate all signals, utilizing the right mouse 

button in conjunction with the "Frequency" slider control.    When the control is all the way down, the 
setting will be 5 Hz, and when it is all the way up, the setting will be 19.999 KHz. (Useful settings will
usually fall somewhere within the 3 KHz to 15 KHz range, depending on the source material and the 
goals of the audio restoration.)    If you desire finer frequency resolution, you may also use direct 
numeric entry of the value.

5. Choose the Filter "Slope" which you desire.    Click on either 6 dB / Octave, 12 dB / Octave, or 18 
dB / Octave.    The steeper the slope, the higher will be the degree of attenuation of all frequencies 
above the "Frequency" setting.

6. If you desire to hear the results of your filter settings before creating a new "Destination" file, click 
on "preview."

7. You will hear the effect of the settings which you have chosen, after a short delay.    (the system may
seem to stutter if your computer is too slow to keep up in real-time with the algorithm.    This 
repeating pattern will not appear in the final Destination processing of the filter.)

8. As the filter is running in either Preview mode or Run mode (Destination File Mode), you will see a 
dialog box which indicates the "% Done" of the filter algorithm on the selected portion of the 
Source Wavefile.    Also, at the top of the Dialog box you will see indicated the "Total Samples to 
Process:".

9. Keep adjusting the Frequency and Slope parameters, and testing the various settings using the 
"Preview" mode until you are satisfied with the results.

10. When you are satisfied with a group of settings, you will be done with Preview mode.
11. Click on Run, and the filter will process your Source Wavefile through the filter algorithm, and create

a Destination Wavefile containing the output of the filter.
12. When this process is complete, you will see the Destination File become highlighted in Yellow, at

the same time that the Source File becomes un-highlighted.
13. Click on "Close."

For more information on the Low Pass Filter, refer to the Low Pass Filter Tutorial.



Making the Connections
There are many methods for connecting your computer to a sound system in order to be able to use 
DC-Art as a Computer Aided tool for the restoration of old sound recordings.    Here are several 
alternatives. 

Method #1: Using a home stereo system utilizing its tape monitoring loop
1. Connect a stereophonic magnetic phono pickup system to an audio pre-amplifier with magnetic 

phono equalization inputs.
2. Connect your line level sound card input to one of the pre-amplifier's tape recording output.
3. Connect your line level sound card output to one of the pre-amplifiers tape monitoring inputs.

Method #2: Using a DAT machine with digital inputs and outputs
1. Connect a stereophonic magnetic phono pickup system to an audio pre-amplifier with magnetic 

phono equalization inputs.
2. Connect the DAT machine analog output to a tape monitoring input on the pre-amplifier.
3. Connect the DAT machine analog input to a tape output on the pre-amplifier.
4. Connect the Digital Output of the DAT machine to the Digital Input of a "Digital-Only" sound card in 

your computer.
5. Connect the Digital Input of the DAT machine to the Digital Output of the "Digital-Only" sound card.

Method #3: Using a mixing board and an Analog Sound card
1. Connect a stereophonic magnetic phono pickup system to a magnetic audio pre-amplifier (these are

available without all of the bells and whistles associated with a full-blown home audio pre-amplifier). 
2. Connect the Outputs of the magnetic pre-amplifier to two of the line level inputs on your mixing 

board (one input for each channel).
3. Connect the line level outputs of the Analog Sound card to another pair of line level inputs on your 

mixing board.
4. Connect your tape recorder (DAT or Reel to Reel or whatever) line level outputs to another pair of 

line level inputs on your mixing board.
5. Connect any other input devices you may require into the remaining inputs of your mixing board.
6. Connect the Main mixer output to your power amplification system.
7. Connect the Monitor Outputs from your mixer to the line level input of your sound card.
8. Connect the tape recorder line level input to the Stereophonic Headphones output jack on your 

mixing board.

Warning!    Method #3 is the most versatile method for setting up a small sound restoration lab.    
However, because it is so versatile, feedback loops are easily created which can produce very 
annoying and potentially dangerous signal levels (to your ears, power amplifier and loudspeaker).      So
you must be careful not to allow the output of a device to feed-back into the same device when 
operating the mixing board.    Always think twice before raising a slider control on your mixing board 
utilizing this method. 



Manual De-Clicking Process
There are five possible methods provided by DC-Art for Manual De-Clicking.    The first and best 
method is the “Paste Interpolate” method. The interpolation which is used by this method is the more 
sophisticated of the two algorithms used by the Impulse Noise filter.    The second one utilizes the 
"Copy and Paste Over" feature, and the third one utilizes the "Mute" function.    The one which provides
the second best result is the "Selective De-Clicking with the Impulse Filter and Sync Mode" method.    
Another method which is sometimes effective is the Copy and Paste Over method, but it takes more 
steps to perform. Another method which is as easy to use as method number 1 is the "Mute" method, 
which should only be used on very short impulses, since it can produce some intermodulation 
distortion on the final product. The one which is probably easiest to use is the "Cut" method, but it 
shortens the overall length of your Wavefile as a by-product.      In all cases, manual de-clicking should 
only be used when all else fails with the application of the Impulse Filter.    The Filter utilizes a 
sophisticated method for calculating and    re-inserting a signal.    It has a high probability of inserting a 
sound similar to what would have been in the location of the impulse event, and therefore sounds 
natural.

Method #1 - - - Manual De-Clicking with “Paste Interpolate”

1. From the Source Workspace, listen to your wavefile using the DC-Art play feature, and determine 
the approximate location of the click, pop, or thud which you desire to eliminate.

2. Zoom-In on the section of the wavefile containing the click using the DC-Art feature having the 
same name.

3. Continue Zooming-In, alternately listening to the wavefile until you see the troublesome artifact in 
the DC-Art workspace.    It will take some training to be able to identify transients visually, so be 
patient during your learning curve.

4. Highlight the transient event with the mouse drag procedure.
5. Depress the “I” key on your keyboard.    The transient will be replaced with new signal 

approximating the audio waveform which should have been there.

Method #2 - - - Manual De-Clicking with "Copy and Paste Over"
1. Listen to your wavefile using the DC-Art play feature, and determine the location of the click, pop, or

thud which you desire to eliminate.
2. Zoom-In on the section of the wavefile containing the click using the DC-Art feature having the 

same name.
3. Continue Zooming-In alternately listening to the wavefile until you see the troublesome artifact in the

DC-Art workspace.    It will take some training to be able to identify transients visually, so be patient 
during your learning curve.

4. Using the left mouse button, highlight a sector of the wavefile just prior or just after the transient 
event, being careful not to overlap the highlighted sector onto the actual transient.    The highlighted 
sector must be at least as long (or longer) as the transient event.

5. Click on "Edit."
6. Click on "Copy."
7. Using the left mouse button, highlight the transient event itself.
8. Click on "Edit."
9. Click on "Paste Over."
10. Zoom back out and listen to the wavefile.
11. If you are not satisfied with the results, use the DC-Art "Undo" feature to return the wavefile to its 

original state.



12. Repeat the manual De-Click procedure, only modifying your technique to try to correct for the 
deficiency you heard in "playback."

Important Note: The replacement algorithm used in the Impulse Noise Filter is much more 
sophisticated compared to one used in this manual de-clicking procedure.    Whenever possible, you 
should use the Impulse Noise Filter to de-click a record.    Only in the unusual or extreme case wherein 
the Impulse Noise Filter has been unable to automatically remove a particular artifact, should you use 
this manual process.

Method #3 - - - Manual De-Clicking with "Mute"
1. Listen to your wavefile using the DC-Art play feature, and determine the location of the click, pop, or

thud which you desire to eliminate.
2. Zoom-In on the section of the wavefile containing the click using the DC-Art feature having the 

same name. 
3. Continue Zooming-In alternately listening to the wavefile until you see the troublesome artifact in the

DC-Art workspace.    It will take some training to be able to identify transients visually, so be patient 
during your learning curve.

4. Using the left mouse button, highlight the transient event, being careful not to highlight the complete 
event, and not just a portion of it. 

5. Click on "Edit."
6. Click on "Mute."
7. Zoom back out and listen to the wavefile.
8. If you are not satisfied with the results, use the DC-Art "Undo" feature to return the wavefile to its 

original state.
9. Repeat the manual De-Click procedure, or try to use the "Copy and Paste" over technique until you 

are satisfied with the result.

Method #4 - - - Manual De-Clicking with "Cut"
Note: This feature, although very easy to use, is not recommended unless you are quite lazy, because 
it actually shortens the total program length from the original.

1. Zoom-In on the area of interest in the Wavefile.    
2. Highlight the click or pop impulse using the mouse.
3. Click on the Edit Menu.
4. Click on "Cut".

Method #5 - - - Selective De-Clicking with the Impulse Filter and "Sync Mode."
1. Place DC-Art into "Sync" Mode. This feature is found in the "View Menu".
2. Automatically De-Click the entire Wavefile in the standard manner utilizing the Impulse Filter. 
3. Listen to the result in the Destination Workspace.    Listen for locations which contain pops or clicks 

which were too severe for the algorithm to conquer.    
4. Zoom-In on the pop or click which you desire to remove.
5. Lower the setting of the Threshold Control (or the Tracking Control if you are working with Vinyl 

LP's), and run the filter.    Observe in the Destination Workspace to see if the increased sensitivity 
was able to remove the impulse.    

6. Keep repeating the above process until you are satisfied that the impulse pop or click has been 
removed and replaced with a reasonable looking and sounding replacement waveform.



Median Filter Operating Procedure
Note: The Median Filter and the Average Filter both use similar procedures.

1. Highlight the portion of your Wavefile on which you desire to apply the Median Filter.    (You may 
choose to highlight the entire file, or any portion thereof.)

2. Click on the Filter Menu with the left mouse button.
3. Click on "Median."
4. Choose the number of Samples over which you desire the median calculation to be performed.    

The higher the number of samples chosen, the greater will be the attenuation of the higher 
frequency portion of the audio spectrum.    You can choose any integer value from 3 to 20 samples. 
(The most useful values will be found in the 3 to 7 samples range.)    The higher the chosen number 
of samples, the longer will be the process time requirement for the algorithm.    Changes in value are
accomplished utilizing the slider control.

5. If you desire to hear the results of your filter settings before creating a new "Destination" file, click 
on "preview."

6. You will hear the effect of the calculation of the median value over the chosen number of "samples."
7. As the filter is running in either preview mode or normal mode (Destination File Mode), you will see a

dialog box which indicates the "% Done" of the filter algorithm on the selected portion of the 
Source Wavefile.    Also, at the top of the Dialog box you will see indicated the "Total Samples to 
Process:".

8. Keep adjusting the number of samples until you achieve your desired effect.
9. When you are satisfied with a setting, you will no longer need to use Preview mode.
10. Click on Run, and the filter will process your source Wavefile through the filter algorithm, and create 

a Destination Wavefile containing the output of the filter.
11. When this process is complete, you will see the Destination File become highlighted in Yellow, at

the same time that the Source File becomes un-highlighted.
12. Click on "Close".

For more information on the Median Filter, refer to the Median Filter Tutorial.



Muting Procedure

Note:    Mute runs under the edit menu, and unlike the various filter functions, operates on the selected 
file (which can be the source file.) 

1. Determine the position in the Source or Destination workspace in which you desire to apply the Mute
Function.    (Note: You may choose to Zoom-In on a section of your file first if you desire to do so.)

2. At the beginning of the sector of the wavefile which you desire to silence, click down on the left 
mouse button and keep holding it down as you drag the timing bar (with the mouse) towards the 
right.

3. Stop dragging the mouse when you arrive at the location where you desire the sector to cease being
silent.

4. Release the left mouse button.    You will notice that the sector between the two timing bars will 
remain highlighted in yellow.    This is the sector which you have chosen to mute.

5. If you change your mind regarding the sector which you desire to mute, merely double click the left 
mouse button anywhere in the workspace area, and the entire file will again become highlighted in 
yellow.    Then, repeat steps 1 through 4.

6. Click on the Edit Menu with the left Mouse button.
7. Next, click on "Mute", and a dialog box will appear which says "Mute will set the selected section of 

the file to silence.    Do you want to continue?"    With the left mouse button, click on either "Yes" or 
"No."

For more information on the Muting function, refer to the Mute Synopsis.



Notch Filter Procedure
1. Identify the frequency which you desire to reject from the wavefile recording.    The determination of 

the frequency of interest can be simplified by using the Bandpass filter as an Audible Spectrum 
Analyzer.

2. Highlight the portion of your Wavefile on which you desire to apply the Notch filter.    (You may 
choose to highlight the entire file, or any portion thereof).

3. Click on "Notch."
4. Choose the Center Frequency based on the "problem" frequency which you have observed and 

desire to reject.    The Center Frequency range is from 5 Hz. to 19.999 KHz.    (The highest useful 
frequency is around 15 KHz).    If you desire the finest degree of frequency resolution possible, use 
direct numeric entry rather than the use of the slider controls.

5. Choose the Bandwidth which you find to be the most effective in eliminating the desired frequency.    
The bandwidth control is calibrated in Octaves, and has a range from 0.01 Octaves to 9.99 Octaves. 
You should choose the smallest possible bandwidth which still accomplishes the job of rejecting the 
troublesome frequency.    Otherwise, you will start eliminating useful information from your recording.
Generally, useful ranges for Bandwidth will be in the 0.5 Octave to 0.1 Octave range.

6. If you desire to hear the results of your filter settings before creating a new "Destination File, click on
"preview."

7. You will hear the effect of the settings which you have chosen, after a short delay.    (The system 
may repeat (stutter) if your computer is too slow to keep up in real-time with the algorithm.    This 
repeating pattern will not appear in the final Destination processing of the filter.)

8. As the filter is running in either preview mode or normal mode (Destination File Mode), you will see a
dialog box which indicates the "% Done" of the filter algorithm on the selected portion of the Source 
Wavefile.    Also, at the top of the Dialog box you will see indicated the "Total Samples to Process:".

9. Keep adjusting the Frequency and Slope parameters, and testing the various settings using the 
"Preview" mode until you are satisfied with the results.

10. When you are satisfied with a group of settings, you will no longer need to use Preview mode.
11. Click on Run, and the filter will process your Source Wavefile through the filter algorithm, and create 

a Destination Wavefile containing the output of the filter.
12. When this process is complete, you will see the Destination File become highlighted in yellow, at the

same time that the Source File becomes un-highlighted.
13. Click on "Close."

Note:    If only a small section(s) of your Wavefile is in need of Notch filtering, as is often the case when
acoustic feedback is encountered on a live recording, you can use "sync mode" and just filter the 
sector which contains the noise which your are attempting to reduce. "Sync mode" can be selected 
under the "View Menu."



Nudging the Highlighted Portion of a Workspace
1. To Nudge the right-hand side of a highlighted portion of a DC-Art workspace, use the left and right 

arrow keys on your keyboard.
2. To Nudge the left-hand side of a highlighted portion of a DC-Art workspace, depress the Shift key 

while operating the left and right arrow keys.
3. To change the resolution of the Nudge feature (the number of samples per nudge) go the 

preferences section of the Edit Menu, and enter the desired value of samples for each nudge.
 



Playing Wavefiles via DCart

Playing a File
Important Note:    It is advisable to turn off the Screen Saver function before performing Wavefile 
Playback.    The reason for this is that the Screen Saver can cause disk activity, creating a slight 
discontinuity in the playback of your recording.    For a description of this procedure, refer to the “How 
Do I” section of this manual. 

1. Launch DC-Art
2. If you haven't already done so, you must define your Output Device. 

A. To do so, click on Edit, and then on Device I/O Selection.
B. Choose the output device which you desire, and then click on OK.

3. Next, click on File, and then on Open.
4. Now, double click on the File name you wish to play and / or edit.

Note: If steps 1 through 4 have already been performed they need not be repeated. 
5. A new window will appear which contains the name of the file that you have chosen to play.    This 

filename appears in the title bar near the top of the window. 
6. You will notice that the Amplitude Envelope vs. time will appear in black on a yellow background.    

This area of the window is the Source workspace.    If your wavefile is monophonic, you will see just 
one waveform displayed in the workspace.    If your wavefile is stereophonic, then you will see two 
waveforms displayed, with the top waveform representing the left channel and the bottom waveform 
representing the right channel.    The length of your Wavefile is displayed in Minutes : Seconds : 
Milliseconds in the upper right hand corner of the Source Workspace.

7. To play the file, click on the play button on the DC-Art toolbar which is the square key with a black 
triangle contained within its perimeter, or    depress your keyboard spacebar.    You will notice the 
playback timing marker (a black vertical line) begin to "march" across the workspace as the system 
reproduces the sound which is located at that respective location in your wavefile.

8. To terminate playback, click on the stop button on the DC-Art  toolbar.    (This is the square key with 
a black square contained within its perimeter.)                                                                                                          

9. If only a portion of the wavefile had been highlighted for playback, and now you desire to playback 
the entire file, double click on the workspace background, and the entire file will become highlighted,
and ready for playback.

Note:    DC-Art contains a set of Markers which may be useful during the playback or Wavefile editing 
process.    Refer to the section on markers for more information on the use of this feature. 



Pausing and Resuming Playback 

1. To pause playback, click on the pause button on the DC-Art toolbar (this is the square button with 
two black vertical lines contained    within its perimeter).

2. To resume playback, you can either click on the forward button on the DC-Art toolbar, or depress 
the keyboard spacebar.



Playing and Pausing Portions of Wavefiles using the Right Mouse Button               

1. To start the playback of your wavefile at a specific location, use your mouse to move the mouse 
arrow pointer to the desired location in the Source or Destination workspace.    The system will only
play provided that an output device has been selected.

2. Single click the right mouse button and you will notice a "start playback" timing marker appear in the 
Source or Destination workspace.    Also, you will see a small pop-up window appear having 4 
choices to choose from.    

3. Click on "Play" in the pop-up window.    You will hear the file begin to play, and you should notice that
the "start playback" timing marker has begun to move towards the right of the workspace.      

4. The file will continue playing until its end unless you click the right-hand mouse button again 
anywhere in the Source or Destination workspace.    Playback will terminate the moment the right-
hand mouse button is clicked.    

5. To re-start playback from another start location, repeat steps 
6. 1, 2 and 3. 



Rewinding to Beginning & Fast-Forwarding to End of File    
1. To rewind the play pointer to the beginning of the selected portion of a Wavefile, click on the rewind 

button on the DC-Art toolbar.    (This is the square button with two arrows pointing to the left 
contained within its perimeter).

2. To fast-forward the play pointer to the end of a selected portion of a Wavefile, click on the fast 
forward button on the DC-Art toolbar.    (This is the square button with two arrows pointing to the 
right contained within its perimeter.)



Playing or Editing Portions of a Source or Destination Wavefile

Playing a portion of your Wavefile 

1. Click on the workspace location at which you desire to begin a play or editing sequence.    (This 
maneuver may be applied in either the Source or Destination workspace.)    The selected portion of
the workspace will be highlighted in yellow and the non-selected region will be indicated in gray.

2. Click on the left mouse button and begin to drag the mouse pointer towards the right-hand portion of
the screen.    As you begin to drag the mouse, you will see two black timing reference markers 
appear in the workspace.

A. The first line will remain at the location from which you began to drag the mouse indicating the 
location of the "start" position of your play or edit sequence.

B. The second line will remain at the location where you release the left mouse button, indicating the 
location of the "end" position of your play or edit sequence.

3. The area in between the two lines will remain highlighted in yellow.    This is your selected play or 
edit sector of the Wavefile.    You can "nudge" the highlighted area of the Wavefile utilizing the left 
and right arrow keys on your keyboard.    This will provide you with a finer resolution for defining the 
area of the Wavefile to be played.    The resolution of the "nudge" feature can be defined in terms of 
the # of samples per "nudge" in the preferences selection dialog box of DC-Art.  To "nudge" the right
hand side of the highlighted area, merely use the left and right arrow buttons.    To "nudge" the left- 
hand side of the highlighted area, hold down the Shift key while operating the left and right arrow 
keys.    

4. To play the selected area, follow the instructions outlined in the section titled Playing Wavefiles via 
DC-Art, or hit the spacebar. 



To make a Destination File into the Source File

1. This operation assumes that you have already processed a Source File, thereby having created a 
Destination File    This would have been accomplished by utilizing one of the Filter commands.    
This command is a convenience providing a simple method for performing many serial operations 
on your original sound source with a minimum number of computer manipulations.    

2. Click on File.
3. Click on Make Destination the Source . . .
4. If a "Save As" Dialog Box appears, click on Save. provided that the Destination still has a temporary

name. 
5. A new DC-Art window will be opened, with the previous Destination File appearing in the new 

Window's Source workspace.



Playlist Feature 

DC-Art provides a Playlist feature which provides a convenient means for setting up and playing a 
sequence of wavefiles.    This is useful, because you will not have to sit in front of your computer and 
manually cue each file for transfer to your final destination recording medium.    Instead, you can go out
and mow your lawn while this process is taking place.    The playlist which you create can also be 
exported to an ASCII test file.    The text file contains a format that is easy to import into label making 
programs and spreadsheets.      What follows are the procedures for creating, editing, and reproducing 
a playlist sequence.

Creating a Playlist
1. Under the File Menu, click on the “Open Playlist” feature with your left mouse button.
2. Using the mouse, place the cursor at the beginning of the file name data entry field.
3. Depress the “Delete” key on your keyboard to clear out any characters in the field.
4. Type into the field the file name you desire to call the playlist you are about to create.
5. The play list editor window should now appear.    
6. With the left mouse button, single click on “Add Files.”
7. Search for the wavefile you desire to be the first in the sequence of your playlist.    When it has been 

located, single click on the file, and it shall become highlighted.
8. Click “OK.”    The highlighted file will appear in your playlist.
9. Goto step # 6.    Repeat this process until your list has been completed.

Note: File order can later be re-arranged by using the “arrow-up” and the “arrow-down” buttons on
the playlist editor.

Reproducing a Playlist Sequence
1. Under the File Menu, click on the “Open Playlist” feature with your left mouse button.
2. With the left mouse button, double click on the playlist which you desire to reproduce.
3. Highlight the top wavefile in the list by clicking on it with the left mouse button.    This will be the first 

song played in the list.    If you do not desire to start the sequence with the top song, you can click on
any one of the wavefile’s below it, and the playback sequence will then begin with that wavefile.    All
wavefiles above that particular one will not be reproduced.

4. Click on “Play List.”
5. The program will commence the playlist starting with the highlighted wavefile, and working its way 

down the list.    The file which is presently being reproduced will appear highlighted.
6. When the process is complete, and you do not need to reproduce the playlist again, click on “close.”



Printing Help-File Topics
Sometimes it is useful to be able to read help file topics from paper rather than from your computer 
screen.    This is accomplished in the following manner:

1. From the Help file, select the topic you are interested in printing.
2. Click on the File Menu with the left mouse button.
3. Click on Print Topic.     



Printing a DC-Art Screen
The following procedure will allow you to capture and print a DC-Art screen, including Source and 
Destination Wavefile Waveforms.    This is sometimes useful in forensics work when studying the timing
of particular signals on hardcopy. 

1. Establish the correct zoom levels for the signals which you indend to print.
2. In sequence, depress the “Alt” key (keeping it held down) and then concurrently the “Print Screen” 

key.    
3. Exit DC-Art.
4. Click on “Start.”
5. Click on “Programs.”
6. Click on “Accessories.”
7. Click on “Paint.”
8. Click on “Edit.”
9. Under the Edit Menu, click on “Paste.”
10. Under the File Menu, click on “Print.”



Recording Audio Signals onto your Hard Drive        

Recording Procedure
Important Note: DC-Art is compatible with Wavefiles which were originally created by other programs.
It is not necessary to record a Wave file using the DC-Art recording routine in order to use its 
processing features. 

1. It is advisable to turn off the Screen Saver function before performing hard disc recording.    The 
reason for this is that the Screen Saver can cause a system interrupt, creating a slight discontinuity 
in your recording.    This is accomplished by using the following procedure:

A. Click on the "Main" icon with the left mouse button.
B. Next, click on the "Control Panel" icon with the left mouse button.
C. Next, click on the "Desktop" icon with the left mouse button.
D. Disable the Screen Saver (choose "none")
E. Close out to the Main Screen
F. Launch DC-Art

2. Define the I/O pathway from your sound cards to DC-Art:
A. Click on the "Edit" Function at the top of the main window of DC-Art.
B. Click on the "Device I/O" bar    
C. Now choose which Sound card drivers will be used depending on which audio signal source you 

plan to use.
D. Please note that you must define both an Input Device and an Output Device.  They need not be

the      same in the event that you may have two sound cards, perhaps one being an analog card, 
and the other being a digital only card.

E. This process needs only to be performed once, if you only have one sound card.    Your chosen 
setting will be saved.    However, if you have multiple sound cards, this process will have to be 
repeated anytime you desire to change the input or output configuration to DC-Art.

F. Now, click on the red Record button found on the DC-Art toolbar.

3. You will now see a Dialog Box in which some parameters can be defined:    (Note - Default values 
are Stereo, 44.1 KHz and 16bit)

Channels: Choose between the following:
a. Stereo    (Two input channels)
b. Mono     (One input channel)

Sample Rate: Choose between the following:
a. 44.1 KHz  (This rate will produce a full 20 KHz recording bandwidth, however it consumes disk 

space at almost the fastest rate - - - 5.29 MBytes per minute per input channel).
b. 22.05 KHz  (This rate will produce a recording bandwidth of 10 KHz, which is adequate for the 

restoration of old acoustical recordings.    This setting consumes disk space at the rate of 2.645 
MBytes per minute per input channel).

c. 11.025 KHz  (This rate will produce a recording bandwidth of only 5 KHz, which is useful for the 
restoration of old spoken word recordings, telephone conversations, and first generation movie 
soundtracks.)    It consumes disk space at the lowest rate of only 1.3225 MBytes per minute per 
input channel). 

d. 48.000 KHz ( This rate will produce the best bandwidth, but is primarily used for pro-audio 
applications only)

e. 16.000 KHz (This rate is used primarily in the forensics field)
f. 32.000 KHz (This rate was used in the very earliest days of digital audio recording)



g. 37.500 KHz (This rate was also used in the very earliest of digital audio recording)
h.
Note 1: Using a lower value of sample rate will also reduce the required processing time for most of 
the DC-Art routines.        
Note 2: Digital Sound cards used to interface your computer directly with a DAT recorder's digital 
input and/or output will only operate at the 44.1 KHz sample rate setting. 
Note 3: If your ultimate destination will be to burn a CD ROM in red book audio, you should use a 
44.1 KHz sampling rate only.

Resolution: Choose 8, 16, 20 or 24Bit resolution. The standard CD audio bit depth is 16bits. Some new
audio cards support 20 and 24bit resolution. The higher resolution settings will give greater dynamic 
range and lower noise at the expense of larger file sizes.

4. Click on the Rec Pause (Record Pause) button on the toolbar.    (It is the square button containing 
two vertical lines within its perimeter).    If your source is analog, adjust the output level of the sound 
source until the green VU meter bar graphs are modulating vertically to the maximum degree 
possible short of activating the red overload indicators.    Please note that this adjustment will consist
of a hardware control (gain or volume) of the output signal feeding into your sound card.    Sample 
the loudest portion of the sound source to assure that no overloading will occur when the transfer is 
made to your hard drive.    Please note that digital sources are not gain adjustable.    Whatever the 
gain settings which were used initially on this type of source, is the gain that you will get when 
transferring to the hard drive via DC-Art.    If the original analog to digital transfer was either 
overloaded or under recorded, it will remain that way.

5. To commence recording, you can either click on the Play button located on the toolbar or depress 
the keyboard spacebar.    (The play button is square with a triangle contained within its perimeter, 
pointing to the right).

6. The "Record Position" is analogous to the tape counter of a conventional tape recorder, only it 
indicates in "real time"    (Minutes: Seconds: Milliseconds) with 10 mSec time resolution.    

7. To pause the recording, click on the Rec Pause button on the toolbar.    You may continue to record 
from the pause position by repeating the method outlined in step #5.

8. Recording can be terminated by clicking on the "stopped" button on the toolbar.    ("stopped" is the 
square button containing a smaller black square within its perimeter).

9. To save your recording, click on the Save button in the "Record File" dialog box.    You will notice 
that a temp.wav has already been assigned to your file.    You can either keep the assigned name for
your file, or rename it at this time.    

Note: During the recording process, you will be able to monitor the conversion levels with the two bar 
graph VU meters.    Avoid overloading, as it will cause unpleasant clipping distortion.    The top segment
will turn red when an overload occurs.    It will then turn orange and remain that way indicating that an 
overload has occurred.    Should another overload occur, it will flash red for a moment indicating the re-
occurrence of an overload condition.
      

System Requirements
1. Pentium 100 MHz. or better
2. 16 bit Stereophonic Sound card with line level inputs

(If your sound card only has mic inputs, you may have to construct an attenuator to accommodate line level signals. -30 dB 
should work with most mic inputs)

3. 16 MBytes of RAM*
4. Windows 95 or higher



5. An Audio Source
6. An Audio Reproduction System
7. Mouse, Keyboard, and Color Monitor
8. A Hard Drive with at least as much space as determined by the following formula:

                                                                                                                                                                                
Required Disk Space    = (S) x (t) x (K) x (P)    (In MBytes)

Wherein - - - 

S = Sample Rate expressed in KHz
t = Expected Total time duration of your recording                                                                                                           
K = 0.120 for a monophonic recording
        = 0.240 for a stereophonic recording
P =    Processing Factor
        =    1.0 if no processing is to be performed
        =    1.5 if processing will convert the file to monophonic
        =    2.0 if the file will be processed and maintained    as a stereo file.

Note 1: The above formula does not account for the disc space which will be utilized when you use the
undo feature.    Since it is impossible to predict the number or extensiveness of "undos" which you will 
perform, it is also impossible to calculate ahead of time how much disc space they will consume. 
Note 2: The amount of disc space calculated must be added to the 2 MBytes required on your drive to
hold the basic DC-Art application.
Note 3: The hard drive space which is available is displayed on the lower right hand portion of the 
status bar of the DC-Art program.
*Note 4: If your computer has 32 MBytes of RAM on Win95,(64MB of RAM on NT) further increases in 
the quantity of RAM will not appreciably speed up the DC-Art algorithms.
Note 5: The above formulae assumes 16 bit recording
 
Example:
 Assume that you desire to make a stereophonic recording sampling at 44.1 KHz. Your sound source is
3 minutes and 15 seconds long.    However, the recording will be processed by DC-Art monophonically.
Therefore, your hard drive capacity requirement will be 44.1 x 3.25 x 0.240 x 1.5 =    51.60 MBytes, 
which must be smaller than the hard drive space available as indicated on the status bar.
If you do not care to use the formula to figure out the required disc space, you can refer to the following
table of standard values instead:    
Digitization Disc Space Consumption as a function of Recording Mode and Sample Rate

Sample Rate & Recording 
Mode

Mbytes / 
minute 

48 KHz Monophonic
(Pro-Audio)

5.760

48 KHz Stereophonic
(Pro-Audio)

11.520

44.1 KHz Monophonic 5.292

44.1 KHz Stereophonic
(Compact Disc)

10.584



22.05 KHz Monophonic 2.646

22.05 KHz Stereophonic 5.292

16.000 KHz Monophonic
(Forensics)

1.920

 16.000 KHz Stereophonic
(Forensics)

3.840

11.025 KHz Monophonic 1.323

11.025 KHz Stereophonic 2.646

Note - Values are given for one process only (such as recording.) 

Record Transfer to Hard Drive Technical Hints
The first order of concern when transferring records to your hard drive should be your system setup.    
Your turntable, since it most likely will have a magnetic cartridge, should be kept at least three feet 
away from your monitor, because the stray electromagnetic fields created by the monitor's deflection 
circuits can be a source of noise entering your pickup.    Another important consideration is to be sure 
that your turntables chassis is grounded to your pre-amplifier chassis through an independent 
grounding wire (not the phono cartridge shielded cables) in order to minimize hum pickup.    Shielded 
cables should be used for all audio interconnections with the exception of the loudspeakers 
connections to your power amplifier.    All power supply cords should be fed from the same wall outlet.   
This is done in order to minimize any possible ground loops that could occur if this technique is not 
followed.    In other words, your computer including its monitor and printer, and your turntable, pre-
amplifier, audio power amplifier and any other system accessories should all be plugged into the same 
outlet strip.    The outlet strip is then plugged into a source of power, such that all of your equipment is 
operating off of the same wall outlet.    This is especially important when your audio equipment is of the 
three-wire variety (with a safety ground).    This will be encountered more often with professional grade 
audio equipment as opposed to consumer grade equipment.    If this technique is not followed, a 
ground loop may be created between your computer's ground connection and your audio system 
ground connection.    When this occurs, a noise current will flow in your audio cable shields with a 
consequential noise voltage drop appearing across the same.    This can induce a hum and / or buzz 
into your recording.    If it is not possible to operate all of your equipment on the same electrical outlet, 
then you should consider using an audio isolation transformer between your audio pre-amplifier output 
and your computer sound card input to break this ground loop.
When transferring records utilizing a magnetic phono cartridge, it is useful to "equalize" the frequency 
response of the pre-amp system before transferring the sound to your hard drive, unless the original 
source material was acoustically mastered.    There have been many different equalization curves 
(RIAA etc.) employed by the various record manufacturers.    The primary purpose of these various 
equalization schemes was to allow for a fuller bass response without producing an over modulation of 
the record groove wall.    The frequency below which the cutter system reverted to a "constant 
displacement" as opposed to a "constant velocity" is known as the turnover frequency.    There are pre-
amplifiers available which allow you to select an appropriate turnover (and rolloff) frequency depending
on the brand of the record that you are transferring.    The turnover frequency for most electrically 
recorded 78-rpm records generally falls in the 200 Hz to 500 Hz area. If this is not accounted for, your 
transfers will sound "thin" on the bottom end.      In addition to turnover, LP's used some pre-emphasis 
of the frequencies above around 5KHz.    If a Rolloff is not utilized during playback, these records will 
sound harsh on the top end.    The industry standard equalization, which encompasses both a turnover 
and a rolloff characteristic, is the RIAA curve.    It was used almost exclusively on all LP recordings after
1955.    Other equalization curves for LP's which were employed before 1955 include the NAB, AES, 
FFRR, and the Columbia contours.
Although you may be transferring monophonic 78-rpm recordings to your hard drive, consider making 



the transfers in stereo mode.    By capturing both groove walls of the recording, you can take 
advantage of some of the information captured in this way in order to reduce noise, and clean up the 
muddiness often found in the "bottom end" of old 78's. A very simple noise reduction technique 
involves conversion of the file to a mono file by adding the two files together and dividing the amplitude
in one-half.    This tends to cancel out rumble and low frequency noise.    More information can be found
on these functions in the section titled Filter Menu.    However, when transferring Hill and Dale 
(Vertically Cut) records such as Cylinder recordings and Edison Diamond Discs, no useful information 
can be extracted from a stereo representation, so save the disc space and transfer these 
monophonically.    However, your pre-amplifier must be placed in subtractive mode in order to derive a 
decent signal for the transfer (left channel minus right channel).    Since not all pre-amplifiers have this 
function, you may have to transfer to DC-Art in stereo, and perform an A-B file conversion in software.  
Another method for obtaining the left minus right signal for the transfer of Hill and Dale recordings 
involves a slight modification to the tone-arm shell of your turntable.    You can re-wire the stereophonic 
phono cartridge output terminal to be in series.    The phasing must be arranged such that the two 
positive (hot) signals are wired together forming a node, and the actual output should be taken from the
two negative (ground) terminals of the cartridge coils.    Only one of the tone-arm shell outputs should 
be connected to the two cartridge negative terminals.    Sometimes one of the two negative terminals is 
connected to a metal shield around the cartridge.    This is the terminal that should be connected to the 
shielded conductor of one of the tone arm co-axial cables.    It is important to note that when a stereo 
cartridge is connected in this manner, the output impedance will double and therefore the 
manufacturers recommended value of load resistance should also be doubled.      
Never transfer acoustically mastered recordings through a magnetic cartridge that is driving an 
equalized pre-amplifier.    This will only amplify the bottom end of the surface noise spectrum of the 
record.    It will do very little to enhance the bass response of the transfer, and will cause the transfer to 
sound    "muddy."    When using a magnetic cartridge to transfer such records, the pre-amplifier 
equalization circuits must be disabled.    If this is not easily accomplished, try using a mic input for the 
magnetic cartridge, rather than the equalized magnetic cartridge input.    A mic input is usually fairly 
high in gain, and flat in frequency response. However,    if the input impedance is higher than the 
recommended load resistance for your phono cartridge it will be necessary to terminate the input to the
mic pre-amplifier with an additional parallel connected    resistor.    Use the following equation to 
determine the value for this input shunt resistor (this equation assumes that the input impedance 
specification for your input is actually represented by a simple resistance in the audio frequency band, 
rather than a complex impedance, which is generally the case):
Note: If the input impedance of your mic pre-amp is less than the recommended cartridge load 
impedance, this technique will not work.
                                            
 1 / R shunt = 1 / Rl - 1 / Rin
 whereby - - 
 1 / R shunt = The value of resistance you must add in parallel with the input of your system in ohms.
 &
1 / Rl = The value of required load resistance specified by the manufacturer of your magnetic phono 
cartridge in ohms.
 &
1 /    Rin = The value of input impedance for the input which you will be using in ohms. 
Also, something worth considering (but not as important as load resistance matching) is providing the 
proper value of load capacitance for your phono cartridge.    (If capacitance loading is incorrect, ticks 
and pops on the record may produce a ringing waveform that could make it more difficult for the DC-
Art Impulse Noise Filter detector to discriminate between sound transients and noise impulses.    When
analyzing the value of load capacitance, consider the cable capacitance as part of the total. For 
example, if the cartridge manufacturer recommends a 250 pF load capacitance value, and the cables 
already have 150 pF (6 feet of cable at 25 pF per foot), then you only need to add 100 pF across the 
load resistor at the amplifier input.    
Some sound cards are supplied with a mic input. This input should work well with a magnetic cartridge 
when recording acoustical material, provided that the proper termination resistance is provided to the 



phono cartridge.    Often you will get lucky in that many phono cartridges requires between 47K to 50K 
ohms loading resistance, and many sound cards with mic inputs have 50 K input impedance. 
Remember, if the input impedance of the sound card is less than the phono cartridges recommended 
value, the above technique will not work (properly).    
Avoid the use of special effects such as reverberation, graphical equalization, notch filtering and so 
forth at this point in the sound restoration process.    The added complexity of these signals will make 
your job of sound restoration more difficult, because DC-Art will have a tougher time of separating 
signals from transients and noise.    These special effects, if desired, should be added after the signal 
restoration process has been completed.    And lastly, do not cut off the top end of the signal bandwidth 
at this early stage in the restoration process.    Some of the algorithms make use of the fast rise times 
of the transient signals in order to perform their function.    The use of analog low pass filters at this 
stage of the process can create severe distortions of the ticks and pops on the source material.    The 
"ringing" created by these filters can make it more difficult for the Impulse filter to perform its function.    
It is always easier to remove bandwidth from a signal source than it is to restore it, so this job is best 
left to the point in time where you are actually performing the sound restoration with the DC-Art tool-
set. 



Removing a Lead Vocal from a Stereophonic Recording
The following procedure will very often be effective in removing a lead vocalist’s performance from a 
stereophonic recording.    This is useful when you desire to over-dub your own rendition of the 
performance onto the original song.    The feature is particularly useful for producing parodies. If there 
is a lot of ambient sound (reverberation) associated with the original artist, it may not be removed along
with the vocal itself.    This is seldom a problem, since the ambient sound is not very distinct, and will 
not drastically deter from your own over-dub performance.    It is important to note that this technique 
will not work with a monophonic source. 

1. Using the File menu, open the desired stereophonic source Wavefile.
2. Using the Filter menu, open the File Conversions feature.
3. Click the Source File to Stereo.
4. Click the Destination File to Mono (L - R).
5. Set both amplitude slider controls to the same value of 0.00 dB.
6. Click on the Preview button. 
7. You should hear the Source Wavefile with an attenuated lead vocalist, with perhaps a little bit of 

reverberation (echo) in the background.
8. Adjust one of the two slider controls downwards first.    Observe if the lead vocalist gets louder or 

softer.    If it gets louder, readjust the control upwards, looking for a point on the slider control 
wherein the lead vocal is nulled out (minimized).

9. Click on “Run Filter.”
10. The final result will be found in the Destination Workspace after processing has been completed.



Restoring an Olde 78 RPM Recording
The following are the steps in the process which we have been using at Diamond Cut Productions for 
the restoration of early disc and cylinder recordings.    You may find it useful to learn from our 
experience before undertaking an audio restoration of an old recording on your own.    For details on 
each step, just click on it with the left mouse button.    Please note that although most of these steps 
are based on 78's, the principles can usually be applied to all types of record restoration.

Step 1. Clean the surface of the recording 
Step 2. Play the recording in a "dry run." 
Step 3. Clean the record surface once again 
Step 4. Set up your phono pre-amplifier to the proper mode for the type of record you are transferring 
Step 5. Verify your turntable speed 
Step 6. Verify and/or set up your pre-amplifiers equalization curve to match the recording 
Step 7. Choose the correct stylus for the record 
Step 8. Fix any tracking problems 
Step 9. If your record skips, use half speed re-mastering 
Step 10. Adjust the Gain and Balance of the audio signal driving your sound card 
Step 11. Choose the appropriate File Conversion Technique 
Step 12. Filter out any residual "rumble." 
Step 13. De-click the recording using the Impulse Filter 
Step 14. De-Crackle the recording using the Median Filter 
Step 15. De-hiss the recording with one of two techniques . 
Step 16. Eliminate line frequency hum with the notch filter 
Step 17. Provide a Fade-In and a Fade-Out Sequence 
Step 18. Add Your Own Personal Touch to the Transfer 



Clean the Surface of the Recording
When dealing with a one-of-a-kind or a very rare recording, it is strongly advised that you make a 
transfer of the recording before beginning any cleaning process.    The reason for this is so that you at 
least have something to work with in the event that you inadvertently damage the recording in the 
cleaning process. 
Clean the surface of the recording.    Use a machine designed for this purpose if you have one 
available. The type which deposits a "bead" of distilled water and then removes it with a stylus, string, 
and a vacuum system are probably the best for this purpose.    If a system such as this is not available, 
clean your record with a lint-free cloth and distilled water.    Avoid the use of solvents or wetting agents 
that are non-aromatic as they have the propensity to leave behind a residue.    These residues can 
attract particulate matter over time and clog the bottom of the record groove.    If you are cleaning either
wax cylinders or Edison Diamond Discs, or other records containing wood or paper cores, do not use 
water because of the potential for damage by the solvent.    Use only a lint free cloth on these items.    
Also, be very careful not to get fingerprints on wax cylinders.    The oil in your fingerprint will provide the
"seed" necessary to trigger fungus growth on the wax surface.    This will destroy the cylinder groove 
wall in time.    Blue Amberol cylinders can be cleaned with a cloth that has been moistened with distilled
water.    However, be careful not to allow any water to come into contact with the plaster core, because 
it may swell up cracking the record surface. 
Warning: Do not use solvents such as alcohol or acetone on acetate (transcription) recordings!    
These solvents will destroy the recording.    We have seen grown men cry after utilizing this method of
cleaning on acetates (and in one case the transcription was a one-of-a-kind recording.)                    



Play the record in a "dry run"
Play the record once on your turntable using one of your smaller tip stylus (approx. 2.3 mils).    
Obviously, you do not need to be able to listen to the recording during this process, and so you may 
want to consider using a separate turntable that you will use exclusively for this purpose which is not 
necessarily connected into your sound reproduction system.    The purpose for this step is to kick up 
any accumulated dirt located at the bottom of the groove before re-cleaning the record surface.



Clean the Record Surface Once Again
Clean the surface once again using the procedure outlined in step #1.    The reason for steps #2 & #3 
are that this "phantom" playback process will "kick-up" much of the dirt located at the portion of the 
groove where the stylus is riding; this dirt should be removed from your disc before transferring the 
recording in order to minimize surface noise transfer.                                                          



Set your Pre-amplifier to the Proper Mode      
Set your pre-amp to stereo mode for lateral cut 78 RPM records.    This is not done because your 78 
record was recorded in stereo, but the left and right groove walls will both be recorded independently 
utilizing this technique.    Later, using some of the file conversion options available in DC-Art, you will 
make some decisions regarding the best way to use this left and right groove wall information.    If you 
are transferring vertical cuts (hill and dale) like Edison Diamond Discs or cylinder records, you will 
either have to place your pre-amplifier in Stereo (Left - Right) mode (which may be difficult since not all
pre-amplifiers have this feature) or you will have to record in stereo, and use a file conversion feature 
to convert the signal to vertical using DC-Art.    If your pre-amplifier does not have the feature, the 
record will sound a bit noisy and weak as you listen to it.    However, often when the file conversion is 
performed, the gain will increase and the signal-to-noise ratio will improve at that point in the 
restoration process.    Make sure that your pre-amplifier is providing the full audio bandwidth to the 
digital recorder.    The DC-Art program will need as much bandwidth later to perform its magic.    Do not
concern yourself with the theory of producing aliasing as some have suggested, since this problem has
been solved by all reputable sound card or digital recorder manufacturer.    



Verify that your Turntable Speed is Correct
Verify that the speed of your turntable is correct.    Most Victor, Columbia,    and other 78's were actually
recorded at 78.26    RPM,    however, Edison laterals were recorded at 78.8 RPM.    Edison Diamond 
Discs were recorded at 80 RPM.    Use a strobe disc and a fluorescent or neon lamp operating off of 
your AC line for this purpose, provided that you live in an area where the power line frequency is 
accurate and stable.    If the speed is incorrect, use the turntable pitch control to correct the anomaly. 
The installation CD contains two stroboscope bitmaps that can be printed and placed onto your 
turntable.

Note whether or not the record groove is rotating concentrically.    If it is not, there will be a "Wow" effect on the recording.    This 
problem can be corrected if your turntable has a removable spindle.    With the spindle removed, adjust the position of the record 
with respect to the turntable platter until the stylus tracks the record concentrically. 

For a listing of some of the common speeds which were utilized in the recording industry throughout 
history, click here on RPM. 



Verify that you are utilizing the Correct Equalization Curve
Verify that you are utilizing the correct equalization curve for the particular type and brand of record 
that you are about to transfer.    Turnover and sometimes Rolloff are critical breakpoint frequencies that 
must be matched in a complementary manner to the recording process in order to preserve the "flat" 
response of the original recording session.    Rolloff frequencies for electrical recordings are between 
200 to 500 Hertz, and cutoff frequencies are in the 5 KHz region of the audio spectrum.    Acoustical 
recordings should always be transferred "flat" and    "electricals" should be transferred with an 
equalization that is the correct inverse of the recording equalization that was used in the mastering 
process.    There are tables of values available to determine the correct values for this.    Also, it is 
important to have a pre-amplifier which has the ability to adjust the turnover and rolloff frequencies.    
For more information on this topic, refer to the section entitled "Record Transfer to Hard Drive 
Technical Hints."    Below is a list of common Turnover Frequencies for some of the more common 
brands of lateral cut 78 RPM records:
200 Hz: Columbia (1925 - 1937)
                  Victor (1925 - 1937)                                                                                  
250 Hz: Decca (1935 - 1949)
                EMI
              English Columbia 
300 Hz: Columbia (1938 - End)
400 Hz: Capitol
            Mercury
500 Hz: Brunswick
        Decca (1925 - 1935)
    Edison Laterals (1929)

MGM
                    Parlophone
                Victor (1938 - 1952)



Choose the Best Stylus
Choose the best stylus for the record transfer. In most cases, truncated elliptical styli are the best for 
transferring old 78's, since the stylus tip will not be in contact with any dirt and grit at the bottom of the 
record groove.    The criteria for stylus selection should be based on two parameters.    The first is 
signal-to-noise ratio    (in more common terms it would be referred to as surface noise).    The second is
distortion.    Keep in mind that it is always possible to improve the effective signal-to-noise ratio of a 
recording, but it is much more difficult to decrease the harmonic distortion content of a recording in any 
post-transfer process.    So find the stylus which produces the lowest distortion as the first criteria, and 
listen for the stylus which produces the best signal-to-noise ratio as a secondary criteria.    Styli are 
available in different diameters specified in mils, and in geometry's such as spherical, conical, and 
truncated versions of both.    Although there are charts which call out the best stylus to use for a 
particular record brand and era, you will probably find that the best one is always determined by trial 
and error, since the charts have no way to account for the wear pattern of the particular disc which you 
desire to transfer.    However, if you prefer a more deterministic approach, you can use the following 
chart to get into the right ballpark:
A. Edison 80 RPM Diamond Discs: Use a 3.7 mil spherical or non-truncated conical stylus .                    
B. Wide Groove Acoustical 78 RPM Lateral Discs: Use a 3.8 mil truncated elliptical stylus.
C. Edison White Wax, Brown Wax, Concert, and Gold Molded: Use a 7.4 mil Spherical stylus.
D. Edison Blue Amberol Cylinders: Use a 3.7 to 4.2 mil non-truncated spherical stylus
E. Edison Wax Amberol Cylinders: Use a 4.2 mil spherical stylus.
F. Pre-1935 Lateral Cut Electrical 78's: Use a 3.3 mil truncated elliptical stylus.
G. Transcription Recordings: Use a 2.3 mil truncated elliptical stylus.
H. Late 1930's Lateral 78 RPM Discs: Use a 2.8 mil truncated elliptical stylus.
I. Narrow Groove 78's such as Polydor : Use a 2.4 mil truncated elliptical stylus.
J. Standard Groove 78 RPM Discs: Use a 3.0 mil truncated elliptical stylus.
K. Modern LP's: Use a 0.7 mil elliptical stylus.
L. Early LP's : Use a 1.5 mil truncated elliptical stylus. 
M. 1931 to 1935 RCA Pre-Grooved Home Recordings: 3.5 mil truncated elliptical stylus 
N. Pathe 78’s: Use a 3.7 mil truncated conical stylus

Note: Actual Groove widths can be measured with a 200X to 300X microscope equipped with a 
calibrated reticle.    The location of the wear pattern can also be observed, so that you can choose a 
stylus having a dimension which will either ride above or below the groove-wall wear zone.



Fix Record Tracking Problems 
If the record is severely warped and is having trouble tracking, try the coin trick which your 
grandparents used.    Neutralizing the counterweight of the tone-arm, and applying some mass in the 
form of coins on the tone arm shell works wonders for warped, skipping discs.    There is a "physics" 
basis for this technique.    Ask your grandparents, and they will explain it to you.    If they are not 
available, the technique involves the "second moment of inertia".    The rear counterweight has little 
variable effect on this parameter.    So, placing coins on the cartridge shell dramatically decreases the 
time constant of the second moment of inertia, allowing the tone-arm system to better track warped 
records without launching the tone-arm into deep space.    Pennies are used for mild cases, dimes are 
used for slightly tougher cases, nickels for more serious cases, and quarters are used for basket 
cases! Do not worry too much if a basket case causes the pickup cartridge to "bottom out" on the 
record producing severe thumps in your stereo reproduction system.    Most of these thumping artifacts 
can be removed later with the DC-Art tool-set. 



If it Still Skips, try Half Speed Re-Mastering
If your record still skips, try using the half-speed re-mastering process.    To perform half-speed 
mastering, you will need a turntable with wide-ranging speed variability (some turntables with pitch 
controls may have enough variability to hit some of the half-speed RPM values which you will require,) 
and a reel-to-reel tape deck with at least two speeds.    Set the turntable to one-half the record RPM 
rating.    For example, if your record is a 78 (78.26), set the turntable for 39.13 RPM.    Set the tape 
deck speed for the speed just under the highest speed available.    For example, if your tape deck has 
15, 7.5, and 3.25 ips settings, use 7.5 ips to transfer the record to tape (a three minute song will take 6 
minutes for the transfer.)*      To restore the original pitch of the recording, transfer the tape onto your 
hard drive at 15 ips. Another method involves the use of the DC-Art Change Speed filter.    Transfer the
record onto your hard drive with the turntable running at 45 RPM.    Then, using the Change Speed 
filter, correct the pitch according to the following table:

a. 78.2 RPM record - Use +73.7% pitch increase (flat line contour)
b. 78.8 RPM record - Use +75.1% pitch increase (flat line contour)
c. 80 RPM record - Use +77.7% pitch increase (flat line contour) 

When this procedure is utilized, equalization gets a bit messy.    For example, if the correct turnover 
frequency was supposed to be 500 Hz ,    the setting on your pre-amplifier must be re-adjusted to 250 
Hz to compensate for the fact that you are reproducing the disc at half its intended speed.    If you are 
not using exactly half speed as your re-mastering speed, then you must use ratio-proportioning to 
determine the correct turnover frequency setting for your pre-amplifier.  "Coin therapy" and/or half 
speed mastering should solve most warped record transfer problems. If these do not work, consider 
these two alternatives.    The first involves utilizing a microscope to view the stubborn portions of the 
record.    Look at the problem groove under a microscope with 50X, and with a hobby knife, clear a 
pathway for the stylus to follow during reproduction.    Minimize, but do not become overly concerned 
with groove damage because the DC-Art program can compensate for this factor to a large degree 
later.    Remember, if you are dealing with an acoustical recording, equalization speed compensation 
will not matter because you should be transferring with a flat pre-amplifier response, no matter what 
the value of re-mastering speed which you use.
* Warning!    Listening to the Blues half-speed can be very,    v e r y,      d e p    r      e    s      s      i        
n            g                .       



Adjust the Gain and Balance
Adjust the gain and balance of the audio input signal feeding your sound card.    Play a portion of the 
song which you believe has the loudest crescendo or passage, and make sure that the system does 
not overload on any of the musical transients as indicated on the DC-Art level meters.    On the other 
hand, make sure that the gain is not so low that you are recording "in the mud."    If you do, you will 
lose signal resolution and the signal-to-noise ratio will not be optimal.    Follow all of the guidelines 
outlined in the "Recording    Audio Signals onto your Hard Drive" section of the Help File. 
 Note: Occasional overloading due to severe clicks and/or pops are allowable and will not adversely 
effect the sound restoration process.    However, it is imperative to be sure that any overloading is due 
to noise transients, and not due to musical transients such as drum "rim shots," etc.



Choose the Appropriate File Conversion Technique                              

Choose the File Conversion which is most appropriate for your wavefile, if necessary.    In a few 
cases this procedure is not necessary.    For example, if you are starting with a monophonic wavefile, 
there is no need for a file conversion.    Also, if you are starting with a stereo wavefile and intend to 
maintain it as a stereo wavefile, no file conversion will be necessary.    However, in many cases, you 
will be dealing with a stereo recorded wavefile of a monophonic source which must be converted to the
cleanest format for further processing. This is the case with most 78 RPM laterals and some vertical 
(hill and dale) transfers wherein the A-B function was unable to be performed by your pre-amplifier.    
The method for determining the best file conversion for a 78 RPM lateral transfer is something you will 
have to subjectively judge for yourself.    Use the preview function in the File Conversion feature found 
under "Filter."    This will allow you to quickly hear the results of your selection. 
First, try to listen to the material in stereo.    This will be your baseline for comparison (reference).    
Next, listen to a file conversion from Stereo to Mono (Left Only).    Compare the results of this audition 
to a file conversion to Mono (Right Only).    This is essentially allowing you to compare the effects of the
wear on the inner versus the outer groove wall of your recording.    In many cases, these two will sound
the same.    However, in some cases with extremely worn recordings, one groove wall will sound much 
cleaner compared to the other.    If this is the case, make a note of which of the two sounded cleaner 
(containing the least distortion). 
The next comparison will be between the best of the two groove walls and the Mono (L+R) file 
conversion.    In most cases,    Mono (L+R) will be the cleanest version of all of the alternatives. This is 
due to the cancellation effect of the record vertical displacement component which contains record and
turntable rumble when using this file conversion.    So listen carefully to the "bottom end"    (bass) 
differences between the various conversion alternatives.    Also, very often, some of the clicks and pops
will diminish in intensity with the Mono (L+R) conversion. If you have transferred a vertical recording 
using a stereo cartridge, the only file conversion which generally makes any sense is the Mono (L-R) 
feature.    This rejects all of the lateral component of noise signal from the transfer, preserving only the 
important vertical vector.    After these decisions have been made, create a new file using the 
appropriate file conversion algorithm to be used in the next step in the restoration process.    For more 
details regarding file conversions, refer to the section entitled File Conversions (#7) under the Filter 
Menu section of the Help File.

Important Note: When using the Stereo to Mono file conversion, it is imperative to verify that both gain
controls are set to -6 dB in order to assure that you do not overload the Destination channel input.    -
6dB is the DC-Art default setting for this feature.



Filter out Residual Rumble

Filter out any residual "rumble" left on your Source File, by implementing the High Pass Filter.    Cutting
all frequencies below 30 to 50 Hz with an 18 dB / Octave slope can be useful for this purpose.    If you 
are dealing with acoustical material, you will probably want to set the frequency of the filter even higher
to around 100 Hz since very little information generally exists below that frequency.    Don't be afraid to 
experiment and use "Preview" mode to help choose the best value for your material.    For more 
information on the operation of the High-Pass filter, please refer to the Filter Menu section of the Help 
File.



De-click using the Impulse Filter

De-click the record using the Impulse Filter next.      If your record is very "hissy" (lots of top-end noise
as will be found in many early 78's) then it is sometimes useful to run a low pass filter first.    The 
reason for this is that a lot of "hiss" can fool the algorithm into thinking that there are a lot of sibilant 
sounds on the recording, which will move the algorithm's threshold too far up to capture ticks and pops 
effectively.    So, a good recommendation would be to set the low pass filter on 18 dB / Octave, with a 
corner frequency of somewhere between 11 to 13 KHz and run a pass of the mono Wavefile through it. 
See the section on Low-Pass Filtering for details on its operation.    If your record is not "hissy" or once 
your "hissy" record has been low pass filtered, it is now ready to be de-clicked by the Impulse Filter.    
Follow the instructions for its operation under the Impulse Filter section of the Help File.    For 78 rpm 
records, a good initial setting for the "Size" control is 5.    Make sure that the filter is not in "Vinyl LP" 
mode.    Set the Tracking adjustment all the way down (to a setting of 1) and do all of your adjustments 
with the threshold control.    Adjust the threshold until the clicks are removed, but the sound signal is 
not distorted by the process.      Remember to utilize the preview feature to establish the best settings 
for your particular restoration job.    Only in rare circumstances, as may be found on a very "high 
fidelity" 78 rpm record, will you have to employ the services provided by the tracking control, to move 
filter threshold out of the way on high-frequency musical transients. 

After running the Impulse Filter, listen to the entire recording noting on a piece of paper the location of 
any clicks, pops, or thumps which the Impulse Filter did not eliminate.    Try selective De-clicking 
utilizing "Sync Mode" (found in the "View Menu") and the Impulse filter or use one of the manual de-
clicking processes to eliminate these.    You can choose between the manual de-clicking process using 
copy and paste over, or you can use a much simpler process utilizing the mute feature.    Neither of 
these techniques will re-insert a signal as close to the original signal as the Impulse Filter, so manual 
de-clicking should only be performed as a last resort.    If there is a high number of impulse events 
which were not eliminated by the Impulse Filter, you should consider re-adjusting the filters parameters
and running it again before attempting to manually de-click the remaining noise artifacts.
When choosing a manual de-clicking technique consider the following tradeoffs:
A. The "Copy and Paste Over" method provides some attempt to re-insert a signal in the location of 

the transient, but it takes more operations to perform a single de-click with this method.    
B. The "Mute" method requires less steps to perform its function, but it replaces an impulse event 

with silence.    This is OK when the clicks are very short in time duration.    Your ear will integrate 
out the silence during the muted sector of the wavefile.    However, longer events, when de-clicked
with the Mute function, will produce some inter-modulation distortion which may be noticeable.    



De-Crackle the Recording

Many 78's have clean surfaces, and do not require this step in the restoration process.    However, 
some very worn records, or records which were stamped utilizing low quality resins and fillers benefit 
from this step.    So use the Median Filter to reduce "crackle" on recordings which need it. Crackle is 
essentially low amplitude clicks and which occur much more frequently.    (It sort of sounds like Rice 
Krispies.)    It is important to perform this step only after the "de-clicking" step has been performed, and 
before the de-hissing step is performed, if the best results are to be obtained.    Usually, "Sample" 
settings from 3 to 6 produce the best results.    Using too many samples will create a distortion (sort of 
an "edge") which is particularly pronounced on vocals. But experimentation is the only way to 
determine the most appropriate number of samples, since material varies widely in crackle content.    
Use the "Preview" feature to aid in the selection of the most appropriate setting.
Note: Very early cylinder recordings may benefit from the use of the "Average" filter for de-crackling. 
Start with a small number of "Samples" and work your way up until you have achieved a good result.    
If you are not sure whether to use the Median or the Average filter, try both and decide which one 
works the best based on your own specific observations. 



De-hiss the Recording

De-Hiss the recording using one of two methods.      Even if you have a relatively quiet record, there 
will still be some residual hiss which you may wish to reduce.    There are two alternatives to choose 
between.    The continuous noise filter is the most effective at eliminating wide band noise all the way 
down to the bottom-end of the audio spectrum.    However, it has the possibility of introducing some 
digital artifacts onto your wavefile if it is not set correctly, particularly with high settings of the attenuator
control.    Start with a setting around 20 dB.    If you set this control too high, it will also reduce some of 
the "ambiance" of the recording with the tradeoff of providing a great deal of noise reduction.    Your 
other option is to use the Dynamic Noise Reduction filter.    It will not produce as much noise reduction 
as the Continuous Noise filter, but it is easier to set up without introducing digital artifacts onto your 
Destination wavefile.    So the choice will have a lot to do with the condition of your Source File, and 
your own taste with regard to the tradeoffs which were just outlined.    Trial and error are a good method
for sorting this one out.    For details on the operation of these two filters, please refer to the Filter 
Menu section of the Help File.



Eliminate Line Frequency Hum

Eliminate 50 or 60 Hz hum and their harmonics from your recording utilizing the notch filter. When 
"notching" out hum, be sure to set the bandwidth control to the smallest value which is effective in 
order to minimize any effects on adjacent frequency information.    Some early recording had some 
hum induced by the amplification system used to cut the master.    Two frequencies will sometimes be 
heard.    One is often the line frequency fundamental of either 60 Hz on American made records, and 
the other is 50 Hz on an European makes.    Another frequency sometimes heard is at twice the line 
frequency and is usually due to faulty filter components in the power supply section of the master 
cutting-head amplifier.    If you hear any of these, they can be greatly attenuated with the Notch filter.    
This filter can be set to have a very narrow bandwidth, and so will have very little sonic effect on the 
adjacent frequencies.    If your recording should contain “Buzz” rather than hum, use the DC-Art 
Harmonic reject filter instead.    For more information regarding the operation of the Notch filter, please 
refer to the Filter Menu section of the Help File. 



Provide a Fade-In and a Fade-Out Sequence

Provides a smooth Fade-in and Fade-out sequence using the features with the same name.    DC-Art 
allows you to choose between a linear and a logarithmic gain vs. time curve.    Experiment to determine
which curve is the best for the material you are dealing with. After you are done setting up your fade-in 
and fade-out process, use the "mute" function to eliminate any extraneous noises or signals which 
precedes the fade-in and succeed the fade-out sequence.



Add Your Own Personal Touch to the Transfer
DC-Art provides you with a 10 band Graphic Equalizer that you can use to create a more pleasing 
tonal balance to your audio restoration.    It can be found in the Filter Menu.    Alternatively, as you 
transfer the restored wavefile back onto your audio media from the computer sound card, you can 
consider feeding the signal through various analog signal processing devices to give it your own 
personal flare. Hardware devices such as parametric equalizers allow you to bring out sounds which 
you consider to be too understated, and you can attenuate sounds that you may believe to be 
overemphasized.    For a chart of the frequency ranges which various sound sources occupy, click here
on Audio Frequency Spectrum.    Some people like to add some ambiance to the transfer with a little bit
of reverberation, which can be accomplished with DC-Art’s Reverb feature, or an external reverb.    
Devices such as Spectral Enhancers and Harmonic exciters can provide interesting effects especially 
on vocals. If your recording is missing to much of the “top-end” you can enhance it with the DC-Art 
Virtual Valve Amplifier exciter.    It will synthesize harmonics of the upper registers of the musical scale, 
and allow them to be mixed back into your original source material.    Another method for adding your 
own touch would be to use your final DC-Art wavefile as the input source into another program 
capable of performing additional audio functions.        
If you are performing a sound restoration for commercial release, it is important to provide a product 
that will sound good on most audio systems to most people.    For example, if you have a very low 
quality reproduction system, you may be providing equalization which is really compensating for the 
fact that your sound system has poor frequency response, rather than compensating for a lack of 
certain frequencies on the recording itself.    On the other hand, if your system is the state-of-the-art, 
you may want to listen to your EQ on a cheaper sound system as well, to be sure that the recording 
does not "break up" due to excessive bass.    With any reproduction system (and sound room), it is a 
good idea to "flatten it out" before making subjective decisions regarding your final EQ.    Use a pink-
noise generator and a Real Time (spectrum) Analyzer (RTA) as the stimulus / response system for the 
measurement.    Connect a graphic equalizer (preferably 1 / 3 octave, 30 band) in cascade with the 
output of your reproduction system pre-amplifier.    Flatten out the response of the system / room 
utilizing the graphic equalizer, moving the measurement microphone to various locations in your 
listening area.    Flatten out each channel independently.    Lastly, when making your final EQ decisions,
get someone else's opinion as well as your own (and include both sexes).    Since audio "quality" is a 
highly debated and subjective area of discussion, some "opinion averaging" is in order when engaging 
in commercial releases.    If you do not seek the opinions of others at this phase, you may find that your
customers will volunteer it to you, and at a point where it will cost a fortune to fix!    (If the reviews have 
already gone out, it may be too late to fix it at all!)

When you are done with the restoration process, you will have to transfer the contents out of your 
computer hard drive and into some other format.    The most obvious method simply involves the use of
the D-A converter in your sound card.    However, this method will produce a poorer transfer compared 
to direct digital, since it will introduce a small amount of distortion and noise (hum) onto the recording.   
If the audio restoration you are performing is for commercial release, or you are simply interested in 
obtaining the highest possible transfer quality back to another medium, you should consider using a 
digital to digital transfer.    There will be no generational losses if this technique is used.    Another 
alternative for achieving a loss-less transfer of your Destination wavefiles would be to use a recordable
CD-ROM drive.    These units are available, and can be mounted directly in one of your computer bays.

 



Restoring a Recorded Telephone Conversation

Recorded telephone conversations sometimes are very difficult to decipher due to gain variations,    
"out-of-spectrum noise", "in-spectrum-noise", poor frequency response and high levels of distortion. 
This is particularly true of sound transfers made from Digital Communications Recording Systems.    
The following five-step procedure is useful for restoring such recordings.    It is recommended that 
these steps be performed in the order outlined below.    The process is arranged in an order that will 
require only the poorest recordings to require all of the steps outlined. Some recordings will require 
only one or two steps for adequate intelligibility.    Keep in mind that you are not trying to tune for high 
fidelity here; improved intelligibility of the conversation is the only goal of this procedure.      

1. If there is a variation in the gain (loudness) of the recording depending on which party is talking, or 
where you are in the conversation, use the DC-Art Gain Riding Procedure first in order to even out 
the levels, or use the ALC (automatic Level control) found in the Dynamics Processor.

2. Next, apply the Bandpass filter.    There are two types of Bandpass Filters available.    Butterworth 
filters can be found under the Filter Menu.    Much steeper IIR based brick wall filters can be found 
under the Forensics Menu.    These filters are used to remove "out-of-spectrum-noise" from the 
signal.    Use one of the two Speech Filter settings indicated below, choosing the one which is most 
effective for the particular material you are dealing with:

A. Standard Speech Filter: Low Frequency - 300 Hz
High Frequency - 3,000 Hz
Slope - 12 dB / Octave

B. Steep Slope Speech Filter: Low Frequency - 250 Hz
High Frequency - 3,500 Hz
Slope - 18 dB / Octave

If none of these setting improves the signal-to-noise ratio of the signal, experiment with your own 
values for the Bandpass filter or try the Brick Wall Bandpass filter.    

3. To reduce "in-spectrum-noise" next apply the Continuous Noise Filter.    Before running the filter, 
highlight a sector of the conversation containing a slight pause between the two parties talking for 
use as the "sampled noise" baseline for the Continuous noise filter threshold setting.    This sector 
should contain only background noise.        

4. If the signal remains "muffled" or "garbled", try applying the Median filter.    Start with the Samples 
control set to around 9, and increase to as high as 19 or more until the consonant sounds and the 
sibilant sounds become more pronounced and intelligible. 

5. Lastly, try applying the Graphic Equalizer to improve the overall frequency response of the 
conversation. 



Rumble Reduction 
Rumble is a low frequency random noise found on record recordings.    Generally, the noise in the 
spectrum below 20 Hz is considered rumble.    However, with very old 78 and 80 rpm recordings, 
rumble can often be heard with higher frequency content.    DC-Art provides you with three possible 
methods for substantially reducing rumble on a recording.    But first, it is of course important to perform
your transfers with a low rumble turntable to begin with; there is no sense in making the problem worse
by using a cheap turntable (especially the types which use a thrust bearing which is of the ball race 
variety).    Turntables whose platters are thrust supported on a single ball (or point) will offer the lowest 
degree of turntable rumble.    
Method #1:    If you are transferring a lateral 78, or a lateral monophonic LP or Monophonic 45 RPM 
record, transfer it to your hard drive via a stereo cartridge.    Then, using the DC-Art File Conversions 
feature, convert the file from “Stereo” to “Mono    L+R.”    Since most of the rumble on these types of 
records are contained in the vertical vector only, the Mono L+R algorithm will cancel out this noise 
signal, and only preserve the lateral (horizontal) component, which does not contain rumble. 
Important Note: This technique will not work on Hill and Dale or Pathe (groove width modulated) or 
stereophonic recordings. 
Method #2:    Use the Continuous Noise Filter as prescribed in the section of the users guide of the 
same name.    It is only important to realize that the signals you are dealing with will be those at about 
60 Hz on down.    So when you experiment with the threshold line position, only adjust it in the lowest 
octave to eliminate rumble.    When adjusted correctly, you should be able to preserve the last octave of
the audio band in terms of actual signal, while rejecting the lower signal level rumble.
Note: This technique will work on all types of recordings, not just monophonic lateral recordings.
Method #3:    Use the High Pass Filter, with settings of 60 Hz on down, and the slope control set to 18
dB / Octave.    Experiment until you achieve the desired results using preview mode. 
Note: This technique will also work on all types of recordings, not just monophonic lateral recordings.    
However, it is not as good as method number 2 because it will also eliminate some of the low bass of 
your recording as well as its rumble content.



Selective Filtering with Sync Mode

1. Open the desired Source Wavefile.
2. From the Source Wavefile, create a Destination Wavefile utilizing one of the File Conversion 

alternatives or one of the DC-Art    Filters.    These are all found under the "Filter Menu."
3. Click the left mouse button on the "View Menu."
4. If there is no check mark indicated just to the left of "Sync Files," click on it in order to activate the 

feature.
5. If there is already a check mark next to "Sync Files," click on "View" again, and the menu will be 

turned-off, with the "Sync Files On" mode maintained.
6. Using the "mouse-drag" technique (with the left mouse button), highlight the portion of your Source 

Wavefile which needs Selective Filtering.    You can click on the play button to hear and be certain 
that you have highlighted the correct area.    If you have not, repeat this step until you are satisfied.

7. With the left mouse button, click on the "Filter Menu."
8. Next, utilizing the left mouse button again, click on the filter that you desire to run on the selected 

portion of your Source Wavefile.
9. Adjust the Filter parameters according to the procedure for the particular filter which you have 

chosen.    Utilize "preview mode" if necessary to get the parameters to sound appropriate to your 
taste.

10. When you are satisfied that the filter is set correctly, you will no longer need to invoke Preview 
Mode.

11. Click on "Run Filter."
12. The highlighted portion of the Source Wavefile will be processed and inserted into the same time-

slot in the Destination Workspace.
13. If further selective filtering is required on a different portion of the Source Wavefile, repeat steps 6 

through 13 until you are satisfied. 



Simulate Stereo from a Monophonic Source
Method 1: (Using the Reverb)
1. Open the Monophonic File to which you desire to add “Stereo Simulation.”
2. Click on “File Conversions, found under the Filter Menu.
3. In the “From Mono To” box click on “Stereo”
4. Click on “Run Filter.”
5. When the conversion process is completed, close the file conversions dialog box
6. Under the File Menu, click on “Make Destination the Source.”
7. When the “Save As dialog box appears, click on “Save” if you are satisfied with the automatically 

assigned temp file name.
8. Under the Effects Menu, click on “Reverb.”
9. Using the “Preview” mode button, listen to the effect that the reverb is having on the file.    Adjust the

various reverb parameters until you achieve the desired stereo effect.
10. When you are satisfied with the reverb settings, click on “Run.”
11. The completed Stereo Simulation will appear in the destination workspace when the processing has 

been completed.

Method 2: (Using Time offset)
Follow steps 1,2, and 3 above. Then use the “Preview” feature and adjust the “Time Offset” slider. As 
the slider is moved away from zero, a false stereo image will appear. Adjust the slider to suit your 
tastes. 
Also see the section on Time Offset .



Slider Controls Operating Procedures
All of the DC-Art Filters use slider controls to affect changes to their operating parameters.    When a 
DC-Art filter is running in “preview mode”, the slider controls will be “live.”    In other words, you will be 
able to hear almost immediately the effect of any changes you make to a particular parameter.    (Note: 
Typing values from the keyboard while in preview mode will NOT work). The slider controls can be 
used in any of the three following manners:
Method #1 - - - Using the Slider itself    (This is the quickest method for changing a filter value)

1. Point to the slider control (using your mouse) which you desire to change.
2. Click down on the left mouse button.
3. Move the mouse up or down depending on whether you desire to increase or decrease the value of 

the parameter.    Moving the control upwards will increase the value, and moving it downwards will 
decrease it.

4. You will note that the actual value for the parameter is displayed numerically in the display window 
located near the top of each filter control.

Method #2 - - - Using the Up / Down arrows    (This method provides finer control of the filter value)
1. Point to the slider control Up or Down arrow.    Up will increase the value and down will decrease it.
2. Click the left mouse button.
3. You will see the value begin to increment or decrement in the display window located at the top of 

the control.
4. Release the mouse button when you have achieved the desired value.
Method #3 - - - Direct Numeric Entry    (This method, although the most cumbersome to use, will 
provide you with the best resolution of the parametric value.)

1. With the mouse, place the cursor just to the left of the digit or digits which you desire to change.
2. With the delete key on your keyboard, erase the digit or digits which require editing.
3. With your keyboard, enter the new digit or digits.

Note: Method #3 is not effective as a “live” means of control when using DC-Art in preview mode.



Splicing Out a Section of a Wavefile

Method #1
1. Highlight and play the portion of the Wavefile you believe that you would like to splice out.
2. Play the sector (using the play button on the DC-Art toolbar) to make sure that you have identified 

the correct timing for the segment you wish to remove.    Re-highlight the correct area if necessary.
3. Click on the Edit Menu.
4. Click on "Cut."

Note 1: Your computer may number crunch for a few minutes in order to re-write the entire Wavefile 
accordingly.    Be patient.
Note 2: This operation is undoable if you are not satisfied with the timing of the splice out.    
    

Method #2
1. Highlight and play the portion of the Wavefile you believe that you would like to splice out.
2. Play the sector to confirm that you have identified the correct portion of the Wavefile.
3. When you are satisfied that you have identified the correct portion which you desire to splice out, 

note the time associated with the beginning and the ending portion of that sector of the Wavefile.
4. In the Source Workspace, highlight the ending portion of the Wavefile (located past the time where 

you desire to begin the splice out.)
5. Click on the Edit Menu.
6. Click on Copy.
7. Start highlighting the Source File at the position in the Wavefile from which you want the copied 

portion to start.      
8. Click on the Edit Menu.
9. Click on "Paste Over."



Splitting and Re-combining Stereo Wavefiles

Sometimes it may be desirable to split a stereo wavefile into its left and right components, establishing 
individual wavefiles for separate channel processing.    For example, if one of the stereo channels 
needs some equalization but not the other, using this splitting and re-combining wavefiles procedure 
can facilitate that function.    In summary, the procedure consists of creating two stereo files from the 
original stereo file, with one channel attenuated to zero signal level on each resultant file using the file 
converter feature.    Next, the processing of the individual files is performed.    Lastly, the two files are 
re-combined using the Copy and Paste Mix function.

1. Bring the desired stereo file up into the Source Workspace.
2. Under the Filter menu, select the File Conversions feature.
3. Click on the “From Stereo to Stereo” function.
4. Lower the Left Amplitude control to –96 dB (control all the way down).
5. Run the Filter
6. Make the destination the source and then rename the file.    (It may be a good idea to add an 

extension to the file name denoting that it is the right channel only)
7. Double click on the Icon just to the left of the File Menu selector to return you to the window which 

contains the original stereo wavefile located in the source workspace.
8. Double click on the Source Workspace
9. Lower the Right Amplitude control to –96 dB (control all the way down). 
10.  Run the Filter again.
11. Make the destination the source again renaming the file.    (This time you may consider adding an 

extension to the file name denoting that it is the left channel only).
12. Perform whatever independent signal processing you desire on each of the two files (channels).    If 

only one channel requires processing, just process that particular wavefile.
13. When you are done with the independent channel processing, bring up the final version of the right 

channel into the source window.
14. Under the Edit menu, click on “Copy.”
15. Bring the final form of the left channel into the source window.
16. Under the Edit menu, click on Paste and then Paste Mix.    
17. Click on OK – the resultant file in the source workspace is the re-combined stereo wavefile.
18. Done



Turning Screen-saver Off

1. Click on the “Start” button, then select “Settings”
2. Next, click on "Control Panel" 
3. Next, click on the "Display" icon.
4. Choose the Screen Saver Tab
5. Select “None” as the screen Saver. 
6. Close the Control Panel.

Note: You do not have to turn off the screen saver, it you set the delay to a time longer than the 
longest recording you want to make.    If you set it to 30minutes you can record a whole album 
side without the screen saver becoming active.



Undo Procedure
1. Click on the "Edit Menu."
2. Click on "Undo."
3. Click on the pop-up menu level of undo which you desire.    The top "undo" in the stack represents 

the state of the wavefile prior to the latest operation which you performed, and the next down in the 
stack is the one before that, and so on.    Variable levels of undo are provided, and are settable 
under the Preferences section of the "Edit Menu." 



Using DCart as an Audio Waveform Analyzer

DC-Art can be used as a waveform analyzer.    It is capable of both time and frequency domain 
analysis.    There are four possible methods provided for waveform analysis.    One method utilizes the 
"Zoom-In" feature and provides a graphical display so that you can perform frequency calculations.    
The second method utilizes the Bandpass filter, and relies on your hearing to determine the frequency 
content of a Wavefile.    The third method utilizes an Audio Spectrum Analyzer which is built into the 
DC-Art    continuous noise filter.. The forth method utilizes a real time spectrum analyzer, which can be 
connected to the output of any of the DC-Art filters or effects. This waveform information may be useful
to know when trying to determine what useful frequency range is present in a Wavefile.    It also will 
allow you to measure resonance's or acoustic feedback, and periodic noise sources such as 50 or 60 
Hz Hum (or harmonics thereof).    Once this information is known, it will be easier to set up the 
parameters for the Notch, High Pass, Low Pass or Bandpass Filters, so that you can retain useful 
portions of the spectrum, while rejecting unwanted noise signals.    This information is also useful in 
forensic applications for measuring the time between gunshots or other events of critical importance.    
The waveforms, either time or frequency domain, can be printed out using the Print Screen procedure.

Method #1
1. Under the View menu, click on the Spectrum Analyzer.
2. Set the spectrum analyzer controls to the desired settings.
3. Press Play to play the selected section, or run a “Preview” for the particular filter. The post-filter 

frequency domain signal shall be presented on the graphical display.
4. To “freeze” the display on a particular signal, click the enable button off.
5. When running a filter normally (Not in Preview Mode) the Spectrum Analyzer is not updated and 

will not slow down processing time.

Method #2
Using the time scale in the workspace to determine a signals frequency:

1. Zoom-In on the portion of the wavefile containing the suspect noise signal, to the extent that you can
make out the peaks and valleys of the waveform of interest.

2. Note the total time duration of the "frame" which you are looking at.    It is located on the bottom of 
the DC-Art window in the status bar.    (This time is the difference between the frame "end" time 
which is indicated in the upper right hand corner of the workspace and the frame "beginning" time 
which is indicated in the upper left hand corner of the workspace).    This number will be in fractions 
of a second.

3. You will notice that the X-Axis of the workspace is divided into 10 grids.    Calculate the time duration
of one grid by dividing the total frame time duration by 10.

4. Count the number of cycles (cyclic peaks, or cyclic valleys) which occur in within one of the ten X-
Axis grids.    Divide the total time duration of one grid (as determined in step #3) by the number of 
cycles which you have counted.    This is the value of the time duration for one cycle of the waveform
you are observing    (Tcycle).

5. Take the inverse of that time in seconds.    This is the value of the frequency of the waveform you are
observing    (F = 1 / Tcycle).

Method #3
Using the Bandpass Filter as an Audible Wave Analyzer:
Note:    This method only works well if your computer is fast enough to run the Bandpass Filter 
algorithms in real time in Preview Mode.    Otherwise, the system will "stutter" making it difficult to 
interpret the results.    Also, it is important to realize the subjective nature of this method of analysis.    
Your own ability to hear frequencies at the extreme ends of the audio spectrum is critical.    You need to
consider that most men begin to lose their high frequency response after the age of around 21, and 



most women begin to loose their high frequency response after the age of around 30 (although there 
are always exceptions).    You may want to engage the opinion of your kids (whose hearing is generally
exceptional, believe it or not) when performing these subjective tests. You will also need a very high 
quality sound system for these measurements.    It is very useful to have one which utilizes a sub-
woofer for making the low end measurements.

1. You will be using the Bandpass Filter in "Preview" Mode.    
2. Select a Slope value of 18 dB / Octave
3. Set the High Frequency slider control all the way up to its highest frequency.
4. Place the Low Frequency control to around 7 KHz.    
5. Listen to the Material in Preview mode through a high quality audio system. 
6. If you can make out any audio signals containing information and not just noise, increase the Low 

Frequency setting in 1 KHz increments. 
7. Repeat step 5 and step 6 until all you hear is noise.    This will be your upper cutoff frequency value 

for the material you are dealing with.    (Be careful in this evaluation because some very subtle 
sibilant sounds add a great deal of character to an audio source.    So make sure you are only 
hearing noise when you decide that the frequency control has been set appropriately)

8. Next, set the Low Frequency slider control all the way down to its lowest setting.
9. Place the High Frequency control to around 100 Hz.
10. Listen to the Material in Preview mode through your sound system.
11. If you can make out any audio signals containing information and not just noise, decrease the High 

Frequency setting in 10 Hz decrements.
12. Repeat step 10 and 11 until all you hear is noise (rumble).    This will be your lower cut-off frequency 

value for the material you are dealing with.    (Be careful in this evaluation, because some very small 
low amplitude bursts of bass in sync with the music may be very important in the overall sound 
character of the source.)

Method #4
Using the DC-Art Continuous noise filter 

1. Using the mouse, highlight the sector of the Source Wavefile you desire to analyze.    Often this will 
be a lead-in groove or lead-out groove of a record, in order to analyze the record background noise. 
However, it could be a sector of a Wavefile in which acoustic feedback occurred or Hum was 
observed, and you desire to measure its frequency, so that it can later be attenuated.

2. Click on "Filter."
3. Click on "Continuous Noise."
4. Click on "Sample Noise."
5. A status window will pop-up indicating the "% Done" as the system performs its calculations
6. When the calculations have been completed, the status box will disappear, and a graph will appear.
7. The graph of interest is shown is red.    The graph will plot the Amplitude expressed in dB versus the 

Frequency of the selected portion of the Wavefile.    (The blue graph is used for a different 
application, and is not applicable for this function.)



Using the Audio Signal Generator
                                                                      (Making Waves)

1. Click on the "Edit" Menu with the left mouse button.
2. Click on "Make Waves" with the left mouse button.
3. Choose between Sine Waves, Square Waves, Triangle, or Random by clicking on the appropriate 

box with the left mouse button.
4. Set the desired "Frequency" by clicking on the # or #'s which you desire to change with the left 

mouse button.    Use the keyboard to enter the new values with the “start frequency” slider control.    
The allowable range is from 1 to 22,000 Hz.*

5. Set the "Length" of the file which you desire to create using the mouse and direct keyboard entry.    
Data entry must be in terms of seconds.    If you desire 2 minutes, enter 120.    If you desire 10 
Milliseconds, enter 0.01.

6. Set the "Amplitude" which you desire, anywhere from 0 dB to -96 dB.    0 dB is the largest signal 
value which you can produce, with the peak value of the wave form being + / - 32,767 LSB's. 

7. Click on OK and a Temporary file will be created for you containing the signal which you have just 
defined.    This can be re-defined to any name which you would like, and can be used anytime you 
may need it in the future by recalling it from your hard-drive.

*Note: If a sweep generator function is desired, click on “linear sweep” and then adjust the “stop 
frequency” control to the desired value.    The generator will then produce a linear sweep of 
frequencies ranging from the start frequency value to the stop frequency value over the interval of time 
defined by the “length” control.        The DC-Art sweep and random generator is useful for 
characterizing the frequency response of electrical and acoustical systems.
Note 2: Pink noise can be created from the random white noise generator by using the white noise to 
pink noise converter found in the preset list under the paragraphic equalizer filter.    First, record a 
sample of random (white) noise using the DC-Art Make Waves generator.    Next, process it through the
paragraphic equalizer using the abovementioned factory preset.



Zooming-In & Zooming-Out on portion of a Wavefile
To Zoom-In and Zoom-Out on a portion of a wavefile, use the following procedure:
(This procedure assumes that a Source and / or Destination Wavefile is presently being displayed in 
either or both of the appropriate workspaces.)

1. With your mouse, click on the workspace location at which you desire to begin to zoom-in on a 
portion of your Source or Destination Wavefile.    Use the left mouse button for this purpose.

2. As you begin to drag the mouse pointer towards the right-hand portion of the screen, you will see 
two black timing reference markers appear in the workspace.

3. The first marker will remain at the location at which you began to perform the "mouse-drag" 
operation, indicating the location of the "start" position of your zoom region of the wavefile.

4. When you get to the end of the interval of the wavefile portion you wish to Zoom-In on, release the 
left mouse button, and the second line will remain at that location.    This line will have indicated the 
location of the "end" position of your selected zoom-in region of the wavefile.

5. Click the mouse on the Zoom-In icon (the icon on the toolbar with the magnification glass within its 
perimeter, - - - the right-most on in the pair).

6. DC-Art will perform some calculations, and the selected area will be re-displayed with the time axis 
expanded.    This process can be repeated as many times as necessary, but only the 5 most recent 
zoom levels will be remembered when zooming back out.

7. To zoom back out, merely click with the left mouse button on the Zoom-Out button on the toolbar. 
(The Zoom-Out key lies just to the right of the Zoom-In key)              

8. After you have clicked on the Zoom-In icon, you will notice that the Time Axis Slider control at the 
bottom of the file will move to the relative position of the wave file where you began your zoom 
operation. By using either the slider directly with your mouse, or by using the arrows at each end of 
the slider, you will be able to move through the original relative position of the entire wavefile, 
displaying the same level of time magnification which you had just established through the use of 
your Zoom-In control.



Printable Stroboscope
A stroboscope is a device which indicates the RPM speed of a turntable by creating an optical illusion 
of the slowing-down, freezing, or speeding-up of a pattern when illuminated by a pulsating light source 
operating at a known frequency.    You can print a stroboscope from either of two bitmaps provided in 
this program or you can create your own stroboscope disc by dividing a circle evenly into black and 
white segments. Use the following formulae to calculate the number of segments required per 360 
degrees (1 rotation of the disc) into which the disc must be marked:

    60 Hz power systems:    # of segments = 7,200 / RPM*

50 Hz power systems: # of segments = 6,000 / RPM*

For example, assume that you want to construct a strobe for use in the United States where the power 
system operates at 60 Hz in frequency.    We want to design it “to freeze” at 78.2 RPM.    7,200 / 78.2 =
92.07.    Round the number to 92 segments.    Divide your circle into 92 evenly spaced segments, and 
voila, you have your strobe. Because of the rounding error, the strobe you constructed will be in error 
by 0.08 %.    Your strobe will have to be used under a fluorescent or neon light connected to the power 
line in order to function.    Incandescent lamps will not work.
The following is a chart which you can use to create your own strobe using common line frequencies 
and RPM values:

RPM # of Divisions for 50 Hz # of Divisions for 60 Hz
16 375 450
33.33 180 216
45 133 160
78.26 77 92
80 75 90

*Note: Actually, two pulses of light are produced per cycle of the line.    But, for improved visibility, it is 
better to use every other pulse to light up the strobe.
Note: The DC-Art program provides two Windows Metafile images which are located in the install 
directory along with the help file, or you can print directly from these links
50Hz Strobe 
60Hz Strobe 



60Hz strobe



50Hz strobe



Copyright Information
Fifth Edition / demo version
 (DC-Art Live / Millennium Release 4.7)

Proprietary Notice:
Diamond Cut Productions, Inc. owns both this software program and its documentation.    Both the program and 
documentation are copyrighted with all rights reserved by Diamond Cut Productions, Inc.      See the License 
Agreement and Limited Warranty for complete information.
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License Agreement
This is a legal agreement between you, the end user, and Diamond Cut Productions, Inc.    The 
enclosed Diamond Cut Productions software program (the SOFTWARE) is licensed by Diamond Cut 
Productions for use only on the terms set forth herein.    Please read this license agreement.    Opening 
the diskette package indicates that you accept these terms.    If you do not agree to these terms, return 
the full product with proof of purchase to Diamond Cut Productions within 30 days for a full refund.

GRANT OF LICENSE.    Diamond Cut Productions grants to you the right to use one copy of the 
enclosed DC-Art SOFTWARE on a single terminal connected to a single computer (i.e. single CPU) or 
to a network server.    If you install the SOFTWARE on a network server, you must purchase a separate
copy of the SOFTWARE for each computer terminal that will be used to operate the SOFTWARE.

GRANT OF NETWORK LICENSE. If you are acquiring a version of the SOFTWARE specifically 
intended for network use, Diamond Cut Productions grants you the right to use the SOFTWARE on a 
LICENSED COMPUTER NETWORK as provided below.    A computer network is any combination of 
two or more terminals that are electronically linked and capable of sharing the use of a single software 
program.    A LICENSED COMPUTER NETWORK is a computer network for which you have acquired 
and dedicated at least one (1) Diamond Cut Productions standard version of the SOFTWARE (which 
can run stand-alone or as a network server).    For additional users to use the SOFTWARE on the 
network you must acquire a WRITTEN LICENSING AGREEMENT from Diamond Cut Productions 
indicating the number of users expected to be able to use the SOFTWARE.    You may have as many 
copies of the SOFTWARE in simultaneous use on the network as is specifically authorized in the 
WRITTEN LICENSING AGREEMENT. 

COPYRIGHT. The SOFTWARE is owned by Diamond Cut Productions and is protected by United 
States copyright laws and international treaty provisions. You may either (a) make two copies of the 
SOFTWARE solely for backup or archival purposes provided that you reproduce all copyright and other
proprietary notices that are on the original copy of the SOFTWARE provided to you, or (b) transfer the 
SOFTWARE to a single hard disk provided you keep the original solely for backup or archival 
purposes.    

OTHER RESTRICTIONS.    You may not rent or lease the SOFTWARE.    You may not reverse 
engineer, decompile, disassemble, or create derivative works from the SOFTWARE.

GOVERNMENT LICENSEE.    If you are acquiring the SOFTWARE on behalf of any unit or agency of 
the United States Government, the following provisions apply:

The Government acknowledges Diamond Cut Productions representation that the SOFTWARE    and 
its documentation were developed at private expense and no part of them is in the public domain.    
The Government acknowledges Diamond Cut Production's representation that the SOFTWARE is 
"Restricted Computer Software" as that term is defined in Clause 52.227-19 of the Federal Acquisition 
Regulations (FAR) and is "Commercial Computer Software" as that term is defined in Subpart 227.471 
of the Department of Defense Federal Acquisition Regulation Supplement (DFARS).    The Government
agrees that:
                          (i) if the SOFTWARE is supplied to the Department of Defense (DoD), the SOFTWARE is 
classified as "Commercial Computer Software" and the Government is acquiring only "restricted rights" 
in the SOFTWARE and its documentation as that term is defined in Clause 252.227-7013 (c) (1) of the 
DFARS, and 
                          (ii) if the SOFTWARE is supplied to any unit or agency of the United States Government 
other than DoD, the Government's rights in the SOFTWARE and its documentation will be as defined 
in Clause 52.227-19 (c) (2) of the FAR.



RESTRICTED RIGHTS LEGEND.    Use, duplication or disclosure by the Government is subject to 
restrictions as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer 
Software clause at DFARS 252.227-7013.    Diamond Cut Productions, P.O. Box 305, Hibernia, N.J. 
07842-0305.

EXPORT LAW ASSURANCES.    You acknowledge and agree that the SOFTWARE    is subject to 
restrictions and controls imposed by the United States Export Administration (the "Act") and the 
regulations thereunder.    You agree and certify that neither the SOFTWARE nor any direct product 
thereof is being or will be acquired, shipped, transferred or re-exported, directly or indirectly, into any 
country prohibited by the Act and the regulations thereunder or will be used for any purposes prohibited
by the same.    

GENERAL. This Agreement will be governed by the laws of the State of New Jersey, except for that 
body of law dealing with conflicts of law.    Should you have any questions concerning this Agreement, 
or if you desire to contact Diamond Cut Productions for any reason, please write: Diamond Cut 
Productions Customer Sales and Service, P.O. Box 305, Hibernia, N.J. 07842-0305.



LIMITED WARRANTY
LIMITED WARRANTY.    Diamond Cut Productions, Inc. warrants that the SOFTWARE will perform 
substantially in accordance with the accompanying written materials for a period of ninety (90) days 
from the date of receipt.    Any implied warranties on the SOFTWARE are limited to ninety (90) days.    
Some states do not allow limitations on duration of an implied warranty, so the above limitation may not
apply to you.

CUSTOMER REMEDIES.    Diamond Cut Productions, Inc. entire liability and your exclusive remedy 
shall be, at Diamond Cut Productions option, either (a) return of the price paid or (b) repair or 
replacement of the SOFTWARE that does not meet Diamond Cut Productions Limited Warranty and 
that is returned to Diamond Cut Productions with a copy of your receipt.    This Limited Warranty is void 
if failure of the SOFTWARE    has resulted from accident, abuse, or misapplication.    Any replacement 
SOFTWARE will be warranted for the remainder of the original warranty period or thirty (30) days, 
whichever is longer.    These remedies are not available outside of the United States of America.

NO OTHER WARRANTIES.    Diamond Cut Productions, Inc. disclaims all other warranties, either 
express or implied, including but not limited to implied warranties of merchantability and fitness for a 
particular purpose, with respect to the SOFTWARE and any accompanying written materials.    This 
limited warranty gives you specific legal rights.    You may have others, which vary from sate to state.    

NO LIABILITY FOR CONSEQUENTIAL DAMAGES.    In no event shall Diamond Cut Productions, Inc. 
or its suppliers be liable for any damages whatsoever (including, without limitation, damages for loss of
business profits, business interruption, loss of business information, or other pecuniary loss) arising out
of the use of or inability to use this Diamond Cut Productions product, even if Diamond Cut Productions
has been advised of the possibility of such damages.    Because some states do not allow the exclusion
or limitation of liability for consequential or incidental damages the above limitation may not apply to 
you.



Diamond Cut Productions Edison Lateral Series CD Releases
Diamond Cut Productions is proud to offer these releases of Edison Lateral Cut Test Pressing 
recordings available in the CD format.

The following is our current CD product offering:

1. Unreleased Edison Laterals 1  (DCP-201D)
2. The California Ramblers , Edison Laterals 2    ( DCP-301D)
3. Hot Dance of the Roaring 20's, -Edison Laterals 3 (DCP-202D)
4. Ernest V. Stoneman and his Dixie Mountaineers
5. Eva Taylor with Clarence Williams , -Edison Laterals 4 (DCP-303D)
6. Vaughn De Leath – The Original Radio Girl,    Edison Laterals 5 (DCP-304D)
7. Hot and Rare – Hot Dance tunes from Rare Jazz Recordings , (DCP-203D)
8. B.A. Rolfe and his Lucky Strike Orchestra, Edison Laterals 6, (DCP-305D)
9. Al Bowlly Sings - - - The Marvelous Melodies of Peter Mendoza, (DCP-306D)
10. Edison Diamond Disc Fox Trots (1920 – 1923)    (DCP-307D)
11. Rudy Vallee and His Connecticut Yankees (1928 – 1930)    (DCP-308D)

Digital Broadcast Systems GmbH
Feldbergstr. 19
D-61440 Oberursel
Germany

Phone: 0049-6171-582010
Fax:            0049-6171-582012

Email: info@diamondcut.de
Web: www.diamondcut.de
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Upgrade Information
For upgrades please contact

Digital Broadcast Systems GmbH
Feldbergstr. 19

D-61440 Oberursel
Germany

Phone:    0049-6171-582010
Fax:            0049-6171-582012

Email:    info@diamondcut.de
Web Page: http://www.diamondcut.de

Für Upgrades kontaktieren Sie bitte

Digital Broadcast Systems GmbH
Feldbergstr. 19

D-61440 Oberursel
Deutschland

Telefon:    06171-582010
Fax:                06171-582012

Email:    info@diamondcut.de
Webseite: http://www.diamondcut.de



A Brief History of Diamond Cut Productions, Inc.

In the spring of 1986, an R&D engineer/scientist by the name of Craig Maier read an article in The Star Ledger, a 
local newspaper, entitled "Budget Cuts Cast Shadow on Edison National Historic Site." The article, written by 
science editor Kitta McPherson, described the deteriorating condition of the Edison National Historic Site and its 
archives located in West Orange, New Jersey. Among the many artifacts which were not receiving the proper 
curatorial attention due to poor funding was a collection of test-press recordings which were made by the Edison 
company between the years of 1927 through 1929, which was their last few years in the record business. Craig told a
friend and fellow engineer named Rick Carlson about the article in hopes that it might stir up in him some interest in
the Edison site as well. Craig and Rick, after some considerable discussion, decided to offer to volunteer some of 
their spare time and technical expertise in the area of audio hardware and software engineering in order that the 
Edison Lateral collection of test pressing recordings could be transferred to digital tape so that the "sound artifacts" 
would be eternally preserved and archived in the digital domain at the site.

        Contact was made with then Supervisor Museum Curator, Dr. Edward Pershey, Ph.D.    During their first 
meeting at the site, Dr. Pershey showed the two engineers thousands of one-of-a-kind test pressing recordings which 
were piled in stacks on a long row of tables on the second floor of the Edison main laboratory building. This initial 
introduction to the collection was an earnest attempt to sober up these two individuals as to the magnitude of the 
undertaking for which they were volunteering. The total number of songs which were recorded numbered over 1200 
in anywhere from two to five takes each. This only further increased their interest in the project since the possibility 
of finding some truly important music that had previously been unheard since the late 1920’s would be quite high in 
such a large collection of test pressings. After several additional meetings with Dr. Pershey, an informal agreement 
was made such that the two engineers could proceed to seek out funding from private sources to set up an audio 
restoration laboratory in one of their own homes for the project. They contacted around 30 companies in the New 
Jersey area seeking funds to help build their laboratories. After about seven months of effort, they succeeded in 
raising enough money to fund their project. In addition to fund raising, they also designed and constructed several 
pieces of custom equipment which was needed for the project (equipment which was not readily available on the 
market at the time). 

          The next step was to become educated in the proper technique of archival audio transferring. To that end, they 
hired Mr. Tom Owens of the Rogers and Hammerstein musical library in New York City as an engineering 
consultant. Tom spent time with the two engineers at the New York City Public Library sound lab (Rogers and 
Hammerstein) teaching them some of the "tricks of the trade." Tom also visited the first sound lab which the two 
engineers set up for the restoration project located at Craig’s home in Verona, NJ. He provided constructive criticism
regarding the sound lab which the two engineers had set up, allowing them to improve upon their initial system. One
significant problem which Tom highlighted for the two engineers was that of establishing the correct turnover 
frequency for the transfer of these lateral test pressings. Documentation could not be found at the Edison site 
regarding the specifics of this important parameter. So Rick and Craig devised some experiments which were 
conducted on a "high-end" vacuum tube based Edison phonograph designed around the same time period as the test 
pressings in order to deduce the correct turnover frequency. After their experiments, modifications were made to 
their magnetic phonograph pre-amplifier to provide the most likely proper turnover frequency for the transfers.

          A seven year pro-bono contract was drawn up between the Edison National Historic Site / U.S. Department of 
the Interior, and Rick Carlson and Craig Maier for the purposes of executing the project outlined above.

          Finally, the two engineers were ready to begin the project. Nearly one full year had lapsed before the first 
record was transferred to digital tape at Craig’s home in Verona, N.J. Shortly thereafter, the sound lab was rebuilt in 
the Maier’s new home in Rockaway Township, NJ. That is the location in which the lions share of the transfer 
project took place over the next seven years. 

          After transferring around 900 of the songs (times 2 - 5 takes per song, about 2,200 transfers in total) Craig and 
Rick decided that the music was not doing much good sitting in the underground vault of a museum. Since they 
were the only two people alive who had heard almost the entire collection, they decided that it would be a good idea 
to try to release some of this previously unreleased material (only around 200 of the songs had ever been released in 
the Edison lateral format).    So they approached the Edison site in order to try to accomplish this. After about one 



year of frustration in dealing with the bureaucracy, they decided it would be a lot easier to form their own company 
and release these songs under their own record label. Thus was formed Diamond Cut Productions in 1992 with Craig
and Rick providing their own seed capital for the venture. Their first release entitled "Unreleased Edison Laterals 1 -
- - an anthology of Edison Needle type records" was such a success in the market that they were able to start another
project in 1994 entitled "The California Ramblers, Edison Laterals 2." For this project, they decided to improve on 
the audio restoration process which they had used on their previous release. Instead of analog signal processing, they
migrated to digital signal processing utilizing their own algorithms to remove crackle, ticks, pops and hiss from the 
original material. They named their process (which ran on an inexpensive pc) "Diamond Cut Audio restoration 
tools" or DC-Art for short. Their technique proved successful to the extent that the Smithsonian Institution Press 
employed Diamond Cut Productions to perform audio restoration for some of their American Songwriter Series of 
CD releases using this process. Diamond Cut’s third CD release entitled "Hot Dance of the Roaring 20’s, Edison 
Laterals 3" was processed utilizing exclusively their own audio restoration program; all analog processing 
equipment had been abandoned by this point in time. In the meantime and in parallel with the efforts to bring "Hot 
Dance . . . " to the market, Craig worked with County records to produce and release an Edison olde tyme group on 
CD called "Ernest Stoneman and his Dixie Mountaineers" using their audio restoration process. In the spring of 
1996, their program was first formally introduced into the commercial marketplace at a meeting of "Record 
Research" which was held at the Maier residence in Rockaway Township, NJ. Since then it has been sold throughout
the world for not only musical audio restoration applications, but for others such as 911 call restoration, clarification 
of police surveillance recordings, cleanup of radio broadcasts for release on CD, restoration of historic spoken word 
recordings, cockpit voice recording restoration, plus many others. 

          DC-Art has now become one of the predominant players in the international audio restoration software market. 
In the software domain, they are also planning the introduction of a product specifically designed for the 
enhancement of compressed MP3 files which will be released early in 2001.    Also, new features and improved 
performance are planned to be added into their legacy audio restoration software products.

          In the future, Diamond Cut Productions expects to continue releasing more CDs in their Edison Lateral Cut 
series.    However, they have also branched out into other musical venues from the 1920’s and 1930’s. 

          Recently, they released a CD entitled “Vintage Vallee - Rudy Vallee and his Connecticut Yankees” which 
includes 23 of the earliest recordings made by this group in the late 1920’s.    Shortly, a new CD will be released 
entitled "Early Eddy Duchin - - - 1932 to 1937.” 
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